No part of this documentation may be reproduced in any form whatsoever or be stored in any data retrieval system without prior written permission of the copyright owners.

This documentation is supplied on an as-is basis. Information contained within this documentation is subject to change at any time without notice and must not be relied upon.

All company and product names are ™ or Registered Trademarks ® of their respective owners. Dolby® Dolby Atmos, and the double-D symbol are registered trademarks of Dolby Laboratories Licensing Corporation. Confidential unpublished works. Copyright 2021 Dolby Laboratories. All rights reserved.

Windows 7, Windows 10 and Windows 11 are trademarks of Microsoft Corporation.

Merging Technologies makes no warranties express or implied regarding this software, its quality, performance, merchantability or fitness for a particular purpose. The software is supplied “as is” you, the purchaser, are assuming the entire risk of the results of using this Merging Technologies software.

In no circumstances will Merging Technologies, its owners, directors, officers, employees or agents be liable to you for any consequential, incidental or indirect loss or damages including loss of time, loss of business, loss of profits, loss of data or similar resulting from the use of or inability to use the Merging Technologies hardware and or software or for any defect in the hardware software or documentation.

© Copyright Merging Technologies Inc. 2021. All rights reserved
Welcome to Merging Technologies Ovation! 10

Introduction 10

Contacting Merging 11
  International Office: 11
  UK: 11
  USA: 11

Overview 12
  Scope 12
  Evaluation Mode 12
  Latency 12
  Audio Formats Supported 12
  Aneman 12

Ovation Documentation and Help 13
  Conventions 13

QUICKSTART 14
  A First Simple Show 14
    New Show 15
    Configure the Mixer 17
    Building the Show 19

First Run 20
  Hot Keys Mode 23
  Timed Cue List 25
  Conclusion 28

Ovation Concepts 29
  Launching Ovation 29

Ovation Media and Commands 29
  Media Management 30

Remote Control 30
  Remote Control OF Ovation 30
  Remote Control BY Ovation 30
  Remote Control of Ovation Mixer 30
  Multi-Sequencer Synchronization 30

Ovation Modes 31
  Compose Mode 31
  Show Mode 31
Show | 32
--- | ---
Cue Lists | 32
  - Multiple Cue Lists | 32
Audition | 32
Cue List Pane | 33
  - Cues in Cue Lists | 34
  - Cue Fire Buttons | 35
  - Fire Toolbar | 36
Cue List Types | 36
  - Cue List Detail | 37
  - Standard Cue List | 37
  - Timed Cue List | 38
  - Hot Keys Cue List | 38
  - Custom Keys Cue List | 40
  - Cue Browser Cue List | 42
  - Hot Browser Cue List | 43
Cues | 43
  - Cue Icons | 44
  - Selecting Cues | 44
Cue / Cue List Context Menu | 44
Consolidate Cue | 46
CD Tracks Import | 47
Cue Capabilities | 50
  - Empty Cues | 51
  - Compound Cues | 51
Scenes | 51
  - Mixer | 52
Automation | 52
  - Snapshot Automation | 52
  - Dynamic Automation | 54
Show Logging | 56
Other Modules | 56
  - Editing with Pyramix | 57
Recording | 59
  - Record | 59
  - Record Mixer | 61
Ovation User Interface | 62
  - User Interface Options | 62
    - Fire Command | 62
    - Context Menus | 62
    - Keyboard Shortcuts | 62
    - Hardware Control Surfaces | 62
Audio Control 124
  Audio Control Pane 124
  Cue Gain 125
    Cue Gain Control 125
TimeCode 126
  TimeCode Reader Panes 126
Audio Output Slots 128
  What is an Audio Output Slot? 128
  Audio Gain Matrix 129
Ovation Files 133
  File Types 133
Ovation Menus 134
  Show 134
  Cue List 135
  Cue 137
  Fire 139
  View 140
  Settings 141
  Help 141
Settings 142
  Settings Buttons 143
Show Settings 144
  General 144
  I/O Interfaces 147
  Routing 147
  Mic/Pre Remote 147
  TimeCode 147
  Mixing Console 147
Application Settings 154
  General 154
  Player Units 159
  MIDI 160
  IP 161
  Com 162
  Ethernet 163
  GPO 165
  Controller 167
  Controller Units 167
  Proprietary 169
  MIDI 172
  COM 174
  IP 179
  GPI 180
Ovation Webserver
Using Ovation Webserver
   GPI Command Mapping

Tips and Tricks
   Rules
      Fade Modifier
      <Default>
   Drag & Drop
   Changing Properties for Multiple Cues
   Starting a Show With Sysex

System Requirements For Ovation
   Computer
      Ovation MassCore Systems
      Ovation Native
      Windows 10
      Windows 11
      Hard Disk Space Requirements
      Video Hardware

Installing Ovation Software
   Installation Overview:
   Driver Signing
   Flux VS3/V3 plug-ins
   VB VS3 plug-ins
   Running the Installer
      Enabling Ovation with your Software Key

First launch
   Starting Ovation

Audio File Support
   Compressed Audio File Formats
      Codecs
      Dolby Atmos ADM Master file

Keyboard Shortcuts
   Default Keyboard Shortcuts
   Custom Keyboard Shortcuts

Advanced Features
   Multiple Ovation Sequencers for Redundancy
   Remote Players and Controllers
      OV Player
      OV Controller

Appendix I
   OVController Commands
      Media Sequencer Mode available Commands:
      Media Server Mode available Commands:
Appendix II 214
The Ovation Keyboard Controller Commands Map 214
Keyboard Layout 214
Changing Keyboard Mapping 215
Ovation Keyboard Commands mapping 216
Appendix III 217
MIDI and Midi Show Control 217
Appendix IV 225
DMX Commands 225
Appendix V 226
GPI Commands 226
Appendix VI 228
Mouse Modifier Keys 228
Show Control 228
Hot Key Mode 228
Appendix VII 229
Web Server Commands 229
Appendix IIX OSC (Open Sound Control) 234
OSC (Open Sound Control) Support 234
Configuring OSC 234
OSC Information 238
Welcome to Merging Technologies Ovation!

Introduction

Thank you!
Congratulations on your purchase of the **Ovation Media Server & Sequencer**.

Ovation is a ground-breaking Media Server and Sequencer with the tools you need to produce and run shows in many spheres of activity. For example:

- Theatres
- Theme Parks
- Museums
- TV Game Shows
- Trade Shows
- AV Presentations
- Radio stations
- Retail Outlets

are just a few of the possible applications for Ovation.

**Note:** IMPORTANT! - The first thing you need to do is register your software to acquire your security key(s) and to be included in our user support list.

Please also subscribe to the User Forum at:

http://www.merging.com/forum/

PLEASE DO NOT PRINT THIS DOCUMENT UNLESS ABSOLUTELY NECESSARY
SAVE TREES AND INK BY USING THE HYPERLINKS
Contacting Merging

International Office:
Merging Technologies S.A.
Le Verney 4
CH-1070 Puidoux
Switzerland
Phone: +41 21 946 0444

UK:
Merging UK (Emerging Ltd)
23 Campbell Court
Campbell Road
Bramley
Hampshire
RG26 5EG
UK
Phone: +44 (0) 118 402 5090
Fax: +44 (0) 870 123 1747
Email: sales@merginguk.com

USA:
Merging USA (Independent Audio)
43 Deerfield Road
Portland,
ME 04101-1805
United States of America
Phone: +1 (207) 773 2424
Fax: +1 (207) 773 2422

For all documentation inquiries or suggestions for improvement:
http://www.merging.com
Overview

Ovation enables the user to run **Cues** of many Media and Command types, either manually like a spot player / cartridge machine or automatically against Run-time, Time-of-day or external LTC or MIDI TimeCode. The Ovation Sequencer can be controlled from a hardware controller, touch screens, GPIs, Sony 9-pin (P2) Protocol commands and MIDI.

Audio recording is also possible.

**Scope**

**Ovation** can control Audio, GPOs, MIDI Commands, Sony 9-pin (P2 protocol commands over RS422 or ethernet (IP), IP commands, MMC, MTC TimeCode and HTTP Commands, Shell Commands/Scripts/batch Files and Open Sound Control, OSC, commands. The Ovation Mixer can be automated under Ovation control.

The Ovation mixer supports VS3, VST and VST3 plug-ins. For full details please see the Pyramix User Manual.

Ovation can be controlled via a dedicated Hardware Controller, Touch Screens, MIDI and GPIs. The Ovation Mixer can be remote controlled via EMC or Eucon. The Merging Technologies ISIS remote controller is not supported.

**Evaluation Mode**

If you have not entered a valid key Ovation will run in Evaluation Mode.

Everything works in the same way as the full version but only one Cue List can be saved or loaded with a Show.

**Latency**

Minimum latency will only be achieved in systems running in **Native** or **MassCore™** modes. Under **MassCore™** the fire latency will be between 45ms and 66ms, plus the time required by the triggering device (USB, GPI/O, etc…). The dedicated Ovation hardware controller typically gives rise to an additional 10ms latency.

**Note:** All automatically triggered events are sample accurate. For example when a rule fires a Cue.

**Audio Formats Supported**

For the full list of supported audio formats please see the Pyramix User Manual.

**Ambisonics**

Ambisonic Audio Cues are supported. Ovation now includes a complete hybrid Channel Based/Ambisonic workflow, allowing for encoding, mixing, rotating and decoding Ambisonic signals directly in the Pyramix mixing console.

Ambisonics up to the 7th order are fully supported. Ambisonic Decoders up to the 7th order are supported and **b<>com** Decoders are now integrated within the Ovation mixer. Details may be found in the Pyramix User Manual.

**Aneman**

If you have a Merging Technologies Network Audio Interface, e.g. a **Horus** or **Hapi** these devices use RAVENNA audio over IP to connect to the Ovation workstation.

**ANEMAN** is an application developed by Merging Technologies and will enable you to connect, monitor, and manage your networked audio devices. It can be launched from its desktop shortcut:
Ovation Documentation and Help

ToolTips
Ovation Software is equipped with 'ToolTips'. Hovering the mouse cursor over a tool icon pops-up a box with the name of the function.

Documentation
All the documentation is in the Adobe Acrobat pdf format. (.pdf file extension)

In order to read the documentation you will need to have Adobe Acrobat Reader installed on your computer.

Note: All Contents entries, Index entries and Cross-references are hyperlinks for rapid navigation.

This Ovation User Guide and the Pyramix User Manual may be opened from the Help menu. Other documentation can be found in the Windows Start menu in All Programs > Pyramix > Docs. Please check for the most recent versions at:

http://www.merging.com/downloads

Support
If you cannot find an answer to a query in the documentation, please consult the on-line support at:

http://confluence.merging.com

where you will find answers to F.A.Q.s (Frequently Asked Questions) and further support. You may also fill a support request at:

http://www.merging.com/support.tech-support-inquiries

Tutorials
Merging Technologies offers several tutorials to help you start with the Ovation Media Sequencer.

https://www.youtube.com/user/MergingTechnologies

Assumptions
This Ovation User Guide and other documentation assume you are thoroughly familiar with PCs and Windows terms and concepts. If self installing to a new PC, please ensure the machine is working correctly before attempting to install Ovation.

Conventions

Conventions used in Merging Technologies Documents:
Names found on screens and in menus are shown in bold. E.g. Information & Settings

Menu and sub-menu selections are shown like this:

Show > Recent Shows : Quickstart

Which means:

Go to the Show pull-down menu, mouse down to the Recent Shows sub-menu and choose Quickstart.

The Settings dialog Has its own hierarchical tree structure in the left hand pane with folders leading to pages.
Overview
This section provides a step-by-step guide to creating a simple new Show and configuring the mixer. It includes: adding Cues to Cue Lists, several different types of Cue List, Running the Show and Firing Cues and Cue Lists.

Note: This section is not intended as a substitute for the more detailed information to be found elsewhere in this guide.

A First Simple Show

The following prior steps are assumed:

- Ovation hardware and software installation has been completed.
- A means of monitoring has been connected to the physical I/O.
- The software has been registered, the registration key(s) entered and the initial settings entered in the VS3 Control Panel.

Launch Ovation
Double-click the Ovation icon:

Alternatively, click on Start > All Programs > Merging Technologies > Ovation : Ovation

Ovation will open with an empty main window and the New Show dialog opens.
New Show

Start with a template show  When selected you can choose a preexisting template from the list in the right-hand pane.

Start with a single Cue List  When selected the Show will open with a single Cue List ready created. The combo box shows the type of Cue List which will be created. The arrow drops down the list of types available.

- Standard Cue List
- Timed Cue List
- Hot Keys
- Custom Keys
- Cue Browser
- Hot Browser

Set up a new Show Workspace  When ticked a new Show Workspace will be created for the new Show.

Show Name  Type a suitable name for the new Show in this field.

Show & Media Location  The field shows the path to where the Show and associated files will be stored.
Clicking on the ... button opens a **Browse For Folder** dialog:

![Browse For Folder dialog](image)

The **Browse For Folder** dialog functions the same way as other Windows browsers. Navigate to the location you wish to store the new project and select the desired folder or use the **Make New Folder** button to create and name a new one. Click on **OK** to create the new folder and close the dialog. The **Cancel** button closes the dialog without selecting a new location.

For the purposes of this first simple Show select:

- **Start with a single Cue List:** Standard Cue List
- **Tick Setup a new Show Workspace** (if not already ticked (default).
- **Type a suitable name for the Show**
- **Navigate to a suitable location to store the Show** (Create a new folder if necessary.)
- **Click on OK to create the Show**

The Show opens in Compose Mode. I.e. the mode for adding Cues and designing your Show and a new Standard Cue List will appear in the otherwise empty main window.
Configure the Mixer

The default mixer will be displayed. If this does not happen check that View > View Mixer is highlighted (enabled).

On first launch the default 8 into 2 mixer will be loaded with NO output routing selected.

Note: The Pyramix Mixer has been extensively updated and revised with an extremely powerful new architecture. The legacy Mixer shown above is still available. Please consult the Pyramix User Manual for full details of the new mixer.

Important! When deciding on which types of buses to use, Legacy or the new General Mixing Buses, it is crucial to understand the limitations that are inherent in a system with two ways of employing busing. Please ensure that if you are going to use the new busing and panning that you convert ALL of your buses to the new type. Or, if you are building a new Project, please choose the new buses only.

• Legacy subgroups will not feed into new buses.
• A mix of legacy and new buses may confuse some control surfaces.
Output Routing
Click on the L: XLR icon near the bottom of the ST1 output Bus Mixer Strip to pop-up the Connect Output menu.

Click on the appropriate daughter board output for your hardware (in this case an ADAT daughter board is fitted so there are two entries, one for each physical connector.) Click on the desired output to route it for the Left side of the stereo output.

Repeat for the R: XLR icon choosing a second output channel for the Right side of the stereo output.

Set Panning
For this exercise stereo material is assumed and the panning needs to be set to suit:

Click on Strip One’s pan slider and drag to the left until Left is shown in the alphanumeric panel above the fader.

Now click and drag Strip Two’s pan slider to the right until Right shows in the display. (The display reverts to peak level a second or two after the mouse pointer moves away.) Repeat for the remaining six strips in Left Right pairs.

Note: For detailed information about the mixer please see the Pyramix User Manual.

Saving Mixer Configurations
The mixer configuration is saved with the Show. Mixer configurations can also be saved and loaded independently via the mixer Organize tab. (Please see the Pyramix User Manual for full details.)
Building the Show

Add Cues
Select **Add > Load Audio File** from the right-click context menu or select from the **Cue menu Add > Load Audio File** to open the **Open Audio Files** Browser.

Select, say, five Audio Media Files and click on **Open** to load them as **Cues** into the **Cue List** created with the Show.

Notice that the Cue names in the Browser include the UIDs (**Unique IDentifiers**)...
You should now have a **Cue List** that looks something like this:

![Cue List Pane - Compose Mode](image)

Notice that Ovation has abbreviated the **Media File** names intelligently to generate **Cue Names**. The **Cue Name** can be changed in the **Cue Properties** pane and the **Media File(s)** can be changed without changing the **Cue Name** by using the **Replace Audio Media** function.

Experiment with the **Move Up** and **Move Down** buttons (in the right-click context menu), but for the present leave everything else as it is.

**First Run**

**Initialize Show**

In the main window Click on the **Init Show** button:

![Main Window](image)
(Or select **Show > Init**) to Initialize the Show. Note that the Main Window may well contain the Cue List(s) you’ve created. Notice also that the **Cue List** pane changes to Normal Show Mode with the first Cue selected:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1 - Cue List 1</strong></td>
<td></td>
</tr>
<tr>
<td>1 steampasses</td>
<td>Asleep</td>
</tr>
<tr>
<td><strong>2 station</strong></td>
<td>Asleep</td>
</tr>
<tr>
<td><strong>3 trainwhistle</strong></td>
<td>Asleep</td>
</tr>
<tr>
<td>4 bell</td>
<td>Asleep</td>
</tr>
<tr>
<td><strong>5 steampass2</strong></td>
<td>Asleep</td>
</tr>
</tbody>
</table>

The Green bar highlighting **1 - Cue List 1** shows that this Cue List is selected and will be affected by the **Show Control** buttons. Notice that the Cue status labels all read **Asleep**.

**Play**

Click on the **Start Show** button to begin.

The selected Cue is highlighted in Purple indicating that it is selected and **Ready** is shown in below the Cue Name. I.e. prepared for Firing. (buffer loaded)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1 - Cue List 1</strong></td>
<td></td>
</tr>
<tr>
<td>1 steampasses</td>
<td>Ready</td>
</tr>
<tr>
<td><strong>2 station</strong></td>
<td>Asleep</td>
</tr>
<tr>
<td><strong>3 trainwhistle</strong></td>
<td>Asleep</td>
</tr>
<tr>
<td>4 bell</td>
<td>Asleep</td>
</tr>
<tr>
<td><strong>5 steampass2</strong></td>
<td>Asleep</td>
</tr>
</tbody>
</table>

Notice also that a red border has appeared around the Cue. This flashes slowly and indicates that this is the Cue which will be affected by the next initiation of any of the Fire, Pause and Stop Buttons, Keyboard Shortcuts and remote control.
Click on the **Fire Selected Cue** button. The selected Cue plays and its colour changes to Green with an elapsed time bar running across the Cue and two counters showing time elapsed and time remaining.

Notice that the same Cue remains selected in the Cue List. Notice also that when the Cue has finished Playing, it stops and is highlighted in grey to show that it is selected.

**Stop** the Show and re-initialize. *(Show > Stop)* and click **OK** in the **Are you sure you really want to Stop the Show?** dialog.

**Start** the Show. As before, the selected Cue is readied for playout.

Click on the **Fire Sequence** button. The selected Cue plays. Notice that this time, the next Cue in the list is now highlighted and **Ready** for Firing.
Notice also that the red border has moved to Cue 2. This is because it is now the Cue which will be affected by the next initiation of any of the Fire, Pause and Stop Buttons, Keyboard Shortcuts and remote control.

Click on the **Fire Sequence** button again. The next Cue Plays. Notice that the original Cue (if it hasn’t ended) is still playing and the next Cue is now highlighted and **Ready** for Firing.

![Cue List Pane with Two Cues Playing & Next Cue Ready - Show Mode](image1)

Notice also that the red border has now moved to Cue 3.
Play with the **Show Control** “Transport” buttons until you are familiar with their operation.
Click on **Show > Stop** and **OK** in the **Stop Show** dialog to return to **Compose Mode**.

**Hot Keys Mode**

Create a second Cue List, this time choosing **CueList > New > Hot Keys**, and add some Cues.

![Hot Keys Cue List Pane - Compose Mode - normal](image2)
**Note:** In normal Compose mode, apart from the orange header and the **(Hot Keys)** label in the title bar there is no difference between the standard Cue List and the Hot Keys Cue list until the Show is initialized.

Click on the **Init Show** button to Initialize the Show:

The original Cue List will appear as before and the new, **Hot Keys**, Cue List will appear thus:

![Hot Keys Cue List Pane - Show Mode](image)

If the new Cue List is not selected (no Orange bar) either click on the title bar to select it or click on the Show Controls **Toggle Cue Lists** button until it is selected.

Start the Show and experiment with the on screen **Hot Keys** in the **2-Cue List 2** Pane and the Show Control **Fire** and **Fire Sequence** buttons.

Experiment with the **Hot Keys**. (Number keys on the PC Keyboard, NOT the Numeric keypad) and notice that they toggle **Fire** and **Stop**. (This behavior can be changed later if you wish.)

Select the first Cue List, **1-Cue List 1**, either by clicking on its Title Bar or clicking on the Show Control **Toggle Cue Lists** button until the list is selected (Green Title bar).

Select a Cue in the first Cue List and Fire it using the Show Control **Fire Selected Cue** or **Fire Sequence** buttons. Now use the keyboard **Hotkeys** to Fire and Stop Cues in the second list.

Click on **Stop Show** and **OK** in the **Stop Show** dialog to return to **Compose Mode**.
Timed Cue List

Create a third Cue List, this time using Cue List > New > Timed Cue List and add three Cues.

Timed Cue List Pane - Compose Mode
Select the first Cue in the list right-click and select **Cue Properties** button to open the **Cue Properties** Pane for the selected Cue. Float the Pane and resize to convenient dimensions:

Click in the **Go Time** field:

A **Time** entry box appears. This takes the form of Hours Minutes Seconds and Milliseconds.

Click to position the entry cursor in the seconds section and type **10**. Click elsewhere in the **Cue Properties** pane to enter the value. Notice that the **Go Time** field value changes to **00:00:10:000**

In the third Cue List Pane select the next Cue and enter a Go Time of **00:00:20:000**

Repeat for the third Cue, entering a Go Time of **00:00:30:000**.
Notice that the Cue List 3 pane has changed to include the Go: times.

![Timed Cue List Pane with Cue Start Times - Compose Mode](image)

Select **Show > View Show Properties** and click in the **Show Time Mode** field and choose **Duration**. (If not already showing.)

Initialize the Show

Notice that Cue list 3 now has a **Time Toolbar**:

![Timed Cue List Pane - Show Mode](image)

**Chase Timed List**

Click on the **Chase Timed List** button to instruct the list to follow the Show Time.

**Note:** The **Chase Timed List** button is Latching. I.e. its state is remembered when the show is stopped and re-started.
In Show mode the **Chase Timed List** button is lit green when engaged.

**Note:** Once selected this function persists when the show is stopped and re-started until manually cancelled by clicking on the button again.

Click on **Start Show.** Cue List 3’s Time Counter follows the Show Time Counter. The Timed Cues in List 3 fire as the Show Time reaches their Go Times. (If the Cues you chose are longer than 10 seconds each then the next Cue will be Fired while the earlier one continues to play.)

Notice that the Hot Keys are still active for List 2 Cues and that List 1 Cues can still be controlled by the Show Controls once List 1 has been selected. Now **Stop** the Show.

**Start Timed List**
Initialize the Show and click on the **Chase Timed List** button in Cue List 3 to cancel the function. **Start** the Show and allow it to run beyond 10 seconds.

Click on the **Start Timed List** button. The first Timed Cue Fires when the Timed List Counter reaches its **Go** Time i.e. 10 seconds.

**Start Timed List** introduces an **Offset** between Show Time and Timed List Time. The entire list is played from the beginning including the time before the first Cue. **Stop** the Show.

**Fire/Start Timed List**
Initialize and **Start** the Show.

Click on the **Fire/Start Timed List** button. The first Timed Cue Fires **Immediately** and the others follow in their proper timed sequence.

**Fire/Start Timed List** introduces an **offset** between Show Time and Timed List Time. The entire list is played from the beginning of the first Cue disregarding any List time before the first Cue.

**Note:** If the Showtime is past the start time of the first Cue then the Cue fires immediately the button is pressed.

**Pause Timed List**
Only available when list has been initiated with **Fire/Start Timed List.**

Click to **Pause** the Timed List. A second click resumes.

**Stop Timed List**
Only available when list has been initiated with **Fire/Start Timed List.**

Click to **Stop** the Timed List. Resets list to the start.

**Conclusion**
Congratulations! You have just designed and run your first Show using examples of each of three main types of Cue List.

Ovation has many, many more possibilities including Fades and Interaction Rules. Detailed information on using these are to be found elsewhere in this Guide.
Launching Ovation

Launch Ovation

Double-click the Ovation shortcut icon:

Alternatively, click on Start > All Programs > Merging Technologies > Ovation : Ovation

Application Delay Launch
This function enables Ovation to be launched automatically at machine startup with a delay to ensure all drivers and services etc. required are available.

To enable automatic launch simply drag the Ovation icon into the Startup folder and set the required delay value (in seconds) in the Show Properties pane, Show section in the Application Delay Launch field.

Ovation Media and Commands

Audio
Ovation reproduces Audio Cues via a configurable Mixer through a Horus/Hapi or a sound card if using Native.

MIDI
Ovation outputs MIDI (MMC and MIDI Commands to other applications on the same machine or to external devices.

IP Commands
Ovation outputs IP Commands per Cue.

Sony P2 / RS422
Ovation outputs Sony P2 protocol, RS422 commands. (or over ethernet)

GPO
Ovation outputs GPO commands to COM ports.

Shell Commands/Scripts/Batch files
Ovation output Shell Commands/Scripts/Batch files.

Automation
Ovation Mixer Snapshots can be triggered and dynamic automation recorded and replayed.

DMX 512 / CMX Lighting Control
Please see: DMX Commands on page 225
Ovation uses media files on local storage, removable storage and network storage.

When a new Show is created a folder **Audio Files** is created in the same location.

When a Show is Consolidated ([please see: The Consolidation Process on page 120](#)) files on the network, files on removable storage or all files used in the show will be collected and copied to the **Audio Files** folder in the Show file location.

Whenever an audio file or files present on removable storage or in a network location are added to a Cue List (by dragging and dropping, using Load Audio File, Replace Audio etc. a dialog appears asking if the user would like the files copied to the **Audio Files** folder associated with the Show.

The Show packaging process collects all the Audio Media and other files associated with a Show (including the Show file and copies them to a new location for back-up purposes or so that a show can be moved to a different Ovation workstation. **Please see: The Packaging Process on page 121**.

### Remote Control

#### Remote Control OF Ovation

Ovation Sequencer & Media Servers can **be controlled** using:

- The Merging Technologies Hardware Controller

and, via the OVController module:

- General MIDI
- 9-pin Sony P2 (RS422 protocol) commands
- IP commands
- GPIs.

#### Remote Control BY Ovation

The Ovation Sequencer and Media Server can **control** other devices using:

- MMC
- **MIDI** Commands
- Sony P2 (RS422 protocol) commands
- **COM** Commands
- **IP** Commands
- **GPO**s
- Shell Commands/Scripts/Batch Files
- **OSC (Open Sound Control)** Commands

#### Remote Control of Ovation Mixer

The Ovation Mixer can be controlled by a hardware control surface via EMC or Oasis. The Merging Technologies ISIS controller is not supported.

#### Multi-Sequencer Synchronization

Multiple Ovations can be synchronized in a variety of ways. Cues on one Ovation can control another Ovation. One Ovation can be mirrored completely on another for full, near instant redundancy.
Creative Possibilities

If, for example an installation requires multiple Ovation sequencers to be set up, typically one for each of various zones where the audience may be moving freely between the zones then it may be desirable to have all the sequencers playing certain Cues in perfect sync. E.g. background music. To achieve the Cue(s) on one Ovation are set as the Master and the identical Cue(s) on all others as Slaves. A common source of time base must be provided to each Ovation, e.g. from GPS TimeCode generators. Any Cue that must be in sync on all machines is set as Master in the Master system and as Slave with the same token in the Slaves. All other Cues can be triggered independently in each system providing different event in each zones, but the baseline audio will be in sync across all systems.

Redundancy for Backup

To achieve redundancy with a backup Ovation running an identical show in mission critical situations, it is possible to use the Controller > Mirror all Commands to Remote Ovation Sequencers feature. However, this does not ensure sample accurate sync. If sample accurate backup is required some key Cues in both systems can be set as Master/Slave. Typically identical Shows will be running in the Main and Backup machine and any Cues which are to be manually triggered during the show are set as Master in the Main Ovation and as Slave in the Backup. All other Cues which are triggered via rules or timed events do not required to be Master/Slaved, they will be triggered automatically in both systems at the same time by the sequencer engines. However, you can ensure that Cues triggered manually will be synced in the Backup machine by this using the Multi-Sequencer Synchronization feature. If there is a problem with the Main machine and it is necessary to switch to the Backup machine, the audio outputs are simply switched manually to the Backup machine. Subsequent manual control of Cues is done on this machine. It will be in the exact same state as the Master.

Note: The Master Show should be stopped after changeover to the Backup in order to avoid contradictory commands.

Using Multi-Sequencer Synchronization

Before Multi-Sequencer Synchronization can be used IP communication must be configured in both the Master and Slave sequencers.

Please see: IP Connections on page 158

Multi-Sequencer Synchronization is switched on and global parameters set in Show Properties.

Please see: Multi-Sequencer Synchronization Section on page 96.

Parameters for individual Cues are set in Cue Properties for each Cue you wish to synchronize.

Please see: REMOTE CONTROL: Multi-Sequencer Synchronization on page 113

Ovation Modes

Compose Mode

Shows are designed and assembled in Ovation’s Compose Mode.

Show Mode

Shows are run in Ovation’s Show Mode. Clicking on the Initialize Show button puts Ovation into Show Mode.

Start Show

Clicking on Start Show or pressing the Start Show button on the Ovation Keyboard does a number of things:

- Hot Cues and Custom Cues are now available for firing
- Timed lists set to Show Time will fire their Cues at the times specified.
- Standard Cue Lists are available for firing.
Show

A **Show** is the top level of organization. Shows are saved with the file extension `.ovs`. A **Show** controls and keeps track of all the various elements you are assembling at a given time. A viable **Show** always contains one or more **Cue Lists** which contain one or more **Cues** pointing to **Media Files** or containing **MIDI**, **GPO**, **DMX** or **IP** etc. Commands.

Cue Lists

Cue List displays are Modal. I.e. when the Show is not Initialized they are in **Compose** Mode. Once the Show has been initialized Cue List displays switch to **Show** Mode.

When Ovation is in **Compose Mode** the main area of a Cue List displays a tree structure of all Cues and Child-Cues added to the list. In **Show Mode** the display will depend on the type of Cue List and on choices made in Compose Mode.

**Note:** If a Cue List is Closed without saving it separately it will be lost. If you try to close a Cue List the following dialog will appear:

![Close Cue List Dialog](image)

Multiple Cue Lists

Ovation handles multiple Cue Lists in Shows. The Main window Show Control operates on the currently selected list of whatever type. When the Main window Show Control is controlling a selected Cue list of any type a second **Hot Key** Cue List can be controlled simultaneously via keyboard shortcuts or an external hardware controller. Timed Cue Lists will follow the **Interaction Rules** set-up in Compose Mode unless otherwise affected by the Main window Show Control when a particular Timed List is selected.

Audition

Audio auditions are played via the **Output Slot(s)** chosen in **Settings > Application > General > Audition**.

**Selected Cue**

The currently selected Cue can be auditioned by clicking on the Cue List **Audition** button or **Cue > Audition/PFL**. Clicking on the small down arrow adjacent to the **Audition** button gives access to the full range of Audition transport controls which are the same as those available in the **Audition Toolbar**. Please see **Audition Toolbar** on page 68.

Any Cue can be also auditioned by double-clicking it. A second double-click stops the Audition.
Audition Jump
There are six Audition Jump commands. These commands are available only when Auditioning a Cue and via Keyboard Shortcuts or with a modifier key when clicking on the Rewind and Fast Forward buttons in any Audition Toolbar or on the Ovation Keyboard:

• Audition Jump Forward 1: Jump 1 Second later in time (Ctrl + -> Key or Fast Forward Button)
• Audition Jump Forward 2: Jump 5 Seconds later in time (Ctrl + Shift + -> Key or Fast Forward Button)
• Audition Jump Forward 3: Jump 15 Seconds later in time (Ctrl + Shift + Alt + -> Key or Fast Forward Button)
• Audition Jump Back 1: Jump 1 Second earlier in time (Ctrl + <- Key or Rewind Button)
• Audition Jump Back 2: Jump 5 Seconds earlier in time (Ctrl + Shift + <- Key or Rewind Button)
• Audition Jump Back 3: Jump 15 Seconds earlier in time (Ctrl + Shift + Alt + <- Key or Rewind Button)

Cue List Pane
To open a new, empty Cue List pane select Cue List > New > (required type) from the menu in the main Ovation window.

The Title bar is highlighted in pale green when the Cue List is selected. The Top Hat Pin Icon toggles Auto Hide mode when the pane is docked.

Edit Toolbar
For people who prefer working with Toolbars an Edit Toolbar is provided. By default it is only visible in Compose Mode and only when the Cue List > View Edit Toolbar entry is toggled to show the Toolbar.

Note: The >> button to the right of the Toolbar accesses further Toolbar buttons. If the pane is re-sized to a sufficient width, all the Toolbar buttons will be visible thus:

Cue Properties
Opens the Cue Properties pane with details of the currently selected Cue
Cue Rules
Opens the Cue Rules pane

Cue Gain
Opens the Cue Gain dialog. Enables the overall Cue Gain to be set

Add
Adds a new Empty Cue to the list. Clicking on the adjacent Down Arrow offers a choice of:

Add Short Empty Cue
Adds a 1S long empty Cue. Used for triggering.

Add Long Empty Cue
Adds a 24H long empty Cue. Used for implementing conditional rules.

Load MTinterChange XML

Load Audio File

Import CD Tracks

Add Long Empty Cue
Adds a 24H long empty Cue. Used for implementing conditional rules.

Remove
Deletes the selected Cue for the Cue List

Edit in Pyramix
Opens the selected audio Cue in Pyramix.

Replace Audio Media
Opens a browser window. Choose the Audio Media file you wish to use in place of the current one and click on Open.

Snapshot Automation
Opens the Filter Mixer Controls to Snapshot dialog for the selected Cue.

Paste Automation
Pastes the Automation Snapshot from the last Cue Copied to the selected Cue.

Audition
Plays the selected Cue via the Output Slot chosen in Settings > Application Settings > Audition. The drop down gives the standard audition options.

Move Down
Moves the selected Cue Down one position in the Cue List

Move Up
Moves the selected Cue Up one position in the Cue List

Nest
Makes the selected Cue a Child-Cue of the one above it in the list. Cues can be nested as deep as you might reasonably wish. I.e Child-Child Cues etc.

Un-Nest
Moves the selected Cue up a nesting level. If it is a simple Child-Cue then restores this to the top, Cue level.

Cues in Cue Lists

1 - Cue List 1

1 steampasses
Paused
00:00:21 - 00:00:33 A1

2 station
Playing
00:00:34 - 00:00:11 A1

3 trainwhistle
Ready
00:00:36 A1

4 bell
Asleep
00:00:42 A1

5 steampass2
Asleep
00:00:31 A1

Cue Colours - Show Mode

Cue Status
When in Show Mode a Cue in a Standard Cue List can be in one of four states.

Asleep

Ready
Playing
Paused

Cue Status is indicated by a label and the highlight color.

<table>
<thead>
<tr>
<th>Status</th>
<th>Label</th>
<th>Highlight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asleep</td>
<td>Asleep</td>
<td>No highlight</td>
</tr>
<tr>
<td>Ready</td>
<td>Ready</td>
<td>Purple highlight</td>
</tr>
<tr>
<td>Playing</td>
<td>Playing</td>
<td>Green highlight</td>
</tr>
<tr>
<td>Paused</td>
<td>Paused</td>
<td>Yellow highlight</td>
</tr>
</tbody>
</table>

Red Border
The Cue which has the focus has a flashing red border. I.e. this is the Cue which will be affected by the next initiation of any of the Fire, Pause and Stop Buttons, Keyboard Shortcuts and remote control.

Cue Progress
When a Cue is Fired its list entry or (Hot Key Button) displays its progress in three ways.

The left-hand counter shows elapsed time from the start of the Cue.
The right-hand counter shows time remaining to the end of the Cue.
A black progress bar moves from left to right as the Cue plays.

When a Cue has been paused and then resumed the progress bar shows progress since the last pause. (As shown above)

**Cue Fire Buttons**

Cues can each display **Fire/Pause** and **Stop** buttons when in Show Mode:

![Cue List with Fire Buttons - Show Mode](image)

Cue Fire Buttons are shown in Show Mode when the **Cue Fire Buttons** field is set to **Yes** in the **Show Time Options** section of **Show Properties**.
Fire Toolbar

If the **Fire Toolbar** is selected for a Standard Cue List (View > View Fire Toolbar) the Cue List Pane will appear like this in Show Mode when the Show is Ready and Started:

![Cue List with Fire Toolbar - Show Mode](image)

Select **Previous Child-Cue** in Cue List

Select **Next Child-Cue** in Cue List

**Fire Selected Cue** in currently selected Cue List and select next Cue and make **Ready** to **Fire**

Select **Previous Cue** in Cue List

Select **Next Cue** in Cue List

**Fire Selected Cue** in Cue List. Cue remains **Ready** to be **Fired Again**

**Pause Selected Cue** in Cue List

**Stop Selected Cue** in Cue List

---

Cue List Types

**Standard Cue Lists:**
Lists with sequential events manually triggered

**Timed Cue Lists:**
Lists with Cues that can be automatically triggered at a given time or manually.

**Hot Keys Cue Lists:**
Lists with Cues that can be triggered anytime with a given Hot Key mode.

**Custom Keys Cue Lists:**
Lists acting like Hot Keys Lists but where Cues buttons can be customized.

**Cue Browser Lists:**
Lists showing only Cues reflecting the content of a folder in the file system or network.

**Hot Browser Cue Lists:**
Lists acting like Browser Lists but Cues are fired with a single click and Cues cannot be dragged out to other Cue Lists. Typically to be used as an Audio file player.

**Cue List Detail**

**Selecting Cue Lists**
Cue Lists can be selected by:

- Clicking on them
- Using the Tab key to cycle through all available Cue Lists (Or the Select Cue List button on the Ovation keyboard.
- In Show Mode by holding down a Ctrl key and pressing a Hot Key trigger button. (1-48 on the Ovation Keyboard, 1-0 on the PC Keyboard with standard mapping.)

**Standard Cue List**

This can be thought of as the “basic” mode. Cues can be Fired and Paused or Stopped from the main panel Show Control buttons when the Cue List is selected, from the Active Cue panel buttons and from the Toolbar buttons in the Cue List pane itself.
**Timed Cue List**

Once started, Cues with **Go Times** defined will follow a pre-determined time sequence. Cues can still be manually Fired or started from the **Show Controls**.

**Hot Keys Cue List**

This Cue List presents each Cue as a Fire button when in Show Mode. Used for spot effects this mode is commonly used with keyboard short-cuts or an external hardware controller. Cues in a Hot Key Cue List can also be fired from the Show Controls.

**Stopping Hot Cues**

To Stop a **Hot Cue** while playing **Alt + Click** it. Double-Click would be too dangerous!

**Hot Keys Cue List Design Mode**

Hot Keys Cue Lists have a Hot/Custom Keys Design Mode to enable Cues to be arranged in the Hot Keys View (see details below). To enter this mode either right-click on the Cue List to open the context menu and choose **Hot/Custom Keys > Hot/Custom Keys Design Mode** or, if you prefer, select it on the **Cue List** menu.
The Hot Keys slots are always displayed on a grid whether they contain a Cue or not:

![Hot Keys Cue List Pane - Design Mode](image)

### Note:
Slots are kept square automatically whenever possible.

- Hot Keys Numbers follow the Hot/Custom Keys Design Mode setting:
- If the Cue List is in Automatic Cue Numbering Mode then all Cues are displayed in the Hot Key view one after another reflecting their standard Cue List ordering. In this mode the Cues arrangement is automatically computed and cannot be manually changed in Hot/Custom Keys Design Mode.
- If the Cue List is **NOT** in Automatic Cue Numbering mode then the Cues are displayed in the Hot Key slot corresponding to their Cue Number. The Cue Number can be changed in the Cue Properties pane or by drag and dropping Cues directly in the Hot Keys view when in Hot/Custom Keys Design Mode.

### Hot Keys Columns
The Number of Columns displayed in the Hot Key View can be set manually:

This setting is available in the **Cue List Properties** pane in the **Hot Keys** section.

When the Number of Columns is set to **Auto** then the system automatically adjusts the number of columns depending on the size of the Cue List pane, but still follows the Automatic Cues Numbering setting and leaves empty slots if necessary.

### Hot Keys Column to Audio Slot Mapping
Hot Keys Columns can be Mapped to Audio Slots Mapping in the Cue List Properties Hot keys section:

- If set to **No** all Cues are played back in the Audio Output Slot defined in their Cue Properties.
- If set to a number (1, 2 or 6) then the Cues are played back in an Audio Slot corresponding to the Hot Keys Column. In this way Hot Keys Cues can be assigned to Audio Output by the Column in which they are placed.

**Note:** In this mode the actual Audio Output Slot(s) is computed as Cue Column Number multiplied by the number selected in the **Hot Keys Column to Audio Slot Mapping** field. This enables Mono (1), Stereo (2), Surround (6) Cues to be handled.
Triggering Hot Keys
The Hot Keys that can be triggered either by the Ovation dedicated Keyboard, any installed Controllers or the Keyboard ShortCuts (Hot Key 01 to 48)

Note: If the Ctrl key is pressed with the trigger button then the Cue is selected rather than fired. If Ctrl + Shift is pressed with the trigger button then the Cue List with this number is selected.

Only Selects the given Cue (no Fire) if Ctrl is pressed
Selects the Cue List having this number if the Ctrl + SHIFT key is pressed when called.

Custom Keys Cue List

Functionally identical to the Hot Keys Cue List but you can custom design the fire buttons in terms of shape, color, text color, font and font size as well as position. Like Hot Keys Cue Lists when in Show Edit Mode the Custom Keys Cue Lists are still displayed as standard Cue lists for simple Cue management. However, there is the further option of Custom Keys Design Mode:

Custom Keys Design Mode
To enter this mode either right-click on the Cue List to open the context menu and choose Hot/Custom Keys > Hot/Custom Keys Design Mode or, if you prefer, select it on the Cue List menu.

Click on a button to modify it. Click and drag the black boxes to re-size the button and click and drag anywhere on the button to move it to a new location. The dots on the background represent a grid and all re-sizes and moves snap to the grid. On the Custom Keys sub-menu you will find commands to Snap all Keys on Grid, Reset all Keys Position and Reset all Keys Size and Position. (Snap all Keys on Grid is provided for quick alignment if the grid size is changed.)

Note: Cues in standard Cue Lists can have the font and label background customized.

Grid Size
To adjust the grid size open the Cue List Properties pane and change the value in the Custom Keys Grid Size field in the Custom Keys section.

Color and Font
To change colors or the font for the selected button open the Cue Properties pane. Locate the Custom Key section. In the Custom Color field Colors can be changed directly by entering RGB color values numerically. Or click on the ... button on the right of the field to open a color picker. Standard and custom colors are provided. Similarly,
to change the font color use the **Custom Font Color** field. Click in the **Custom Font** field to change the font attributes. Clicking on the ... button opens a standard font dialog where any font installed on the system can be selected, the font style, Regular, Italic, Bold or Bold Italic can be set and the font size selected.

**Justification**

When no **Custom Font** is defined the button text is Left justified as with all other Cues. When a **Custom Font** is set, then there is a high probability that the button will have a “graphical meaning”. Therefore the text is automatically centered and multiple lines are allowed to attempt to fit as much text as possible in a large button.

Typically this is used for Cues such as:

![Custom Keys Cue List - Show Mode Custom text](image)

**Note:** If the Cue List is set to non-**Automatic Cue Numbering** Mode (**Cue List Properties : Automatic Cue Numbering** field set to No) then the Numbers of all Cues in the Custom Keys Cue List can be set to nothing if irrelevant as in the example above. This is the default condition for Custom Cue Lists.
**Cue Browser Cue List**

This special type of Cue List enables Media Files to be browsed, auditioned, copied and pasted as Cues into other Cue Lists from within the main Ovation interface. The chunky scroll bars are to facilitate touch-screen use.

- **Parent** moves up one level in the folder hierarchy.
- **Refresh** refreshes the list as with a normal Windows Browser.

Double-clicking a Media File in the list plays the file.

Cues are always played in Audition mode regardless of whether the Show is running. All other Toolbars are disabled for this type of Cue List.

The Cue Browser is very useful for searching Cues then copying/pasting them into other (standard) Cue Lists. The right-click context menu enables copy and paste.

**Search Cues Function**

The Browser and Hot Browser Cue Lists have a `<Search>` text box on the right side of the path name to search/filter files. This operates in the same fashion as search in Vista Explorer:

- If nothing is typed in, the content of the current folder is displayed, including sub-folder names.
- If something is typed in, all files containing this text in their names are displayed, INCLUDING those in sub-folders recursively, but the sub-folder names are not displayed.
- When searching for files, the Comment field is automatically populated with the Path Name where the files have been found.
Hot Browser Cue List

The Hot Browser Cue List is very similar to the Browser Cue List with these important differences:

- A SINGLE click fires the Cue.
- A single click on a Playing Cue Pauses the Cue
- A single click on a Paused Cue Restarts the Cue from the point at which it was paused
- Double-clicking a Playing Cue Stops the Cue
- Cues cannot be dragged to other lists or be copied and pasted.
- The Parent and Refresh buttons are bigger to facilitate touch screen operation.

**Parent** moves up one level in the folder hierarchy.

**Refresh** refreshes the list as with a normal Windows Browser.

**Note:** The Hot Browser Cue List type will typically be used as an Audio file player.

Cues

A **Cue** is a set of instructions to perform actions. These actions can be on a Media file (or files if multi-channel/multi-media, Pyramix Compositions etc.) or can send instructions to external or internal devices. For example to turn mic inputs on and off or to change a Mixer Snapshot. A **Cue** does not have to play an entire Media File. Via the **Cue Properties** Pane the **Length** can be set to anything up to the entire Cue and the starting point can be **Offset** to any point within the Media File.

The **Cue Trimmer** option in the **Active Cue** window provides a quick and easy method of adjusting In point, Out point and In and Out fades. **Please see: Cue Trimmer on page 80**
### Cue Icons

Cues have dedicated icons when each of the Audio, Microphone Input, TimeCode Generator, MMC, MIDI Command, Sony P2/RS422, GPO, Shell Command and Mixer Snapshot options are enabled for the Cue.

### Selecting Cues

Cues are selected by clicking on them. Multiple Cues are selecting in the usual Windows fashion. `Ctrl + Click` toggles selection of individual Cues while retaining previous selections. To select a contiguous range `Click` on the first Cue then `Shift + Click` on the last to select a contiguous block.

Cues can also be selected by holding down the `Ctrl` key and pressing one of the Hot Key buttons on the Ovation Keyboard or the PC keyboard.

### Moving and Copying Cues

Once selected Cues can be moved or copied using the standard Windows shortcuts. e.g. `Ctrl + C` copies, `Ctrl + V` pastes etc. Cues can also be moved between Cue Lists by simple ‘drag and drop’. Drag and drop with `Ctrl` copies. Drag and drop with `Alt` replaces the audio in the target Cue with the audio in the source Cue. Audio files can be dragged and dropped from Windows Explorer for easy Cue insertion.

### Cue / Cue List Context Menu

Right-clicking on a Cue or blank area in a Cue List opens a context menu with the following options:

- **Undo** (last undoable action)
- **Cut**
- **Copy**
- **Paste**

#### Add Cue

- **Add Short Empty Cue**
- **Add Long Empty Cue**
- **Add Cue Shortcut**

  Adds a new Cue having the same Name, Comment and Color as a currently selected Cue with a Rule Firing the parent Cue when the Shortcut is started.

#### Load MTInterChange XML

- **Load Audio File**
  - Opens a File Browser to select an Audio File.

#### Import CD Tracks

- **Import CD Tracks**
  - Opens the Import CD dialog. **Please see: CD Tracks Import on page 47**

#### Record Audio as New Cue

- **Record Audio as New Cue**
  - Opens the Record Audio dialog. **Please see: Recording on page 59**

#### Remove

- **Remove**
  - Removes the selected Cue from the Cuelist.

#### Edit in Pyramix

- **Edit in Pyramix**
  - Opens the Cue in Pyramix ready for editing.

#### Consolidate

- **Consolidate**
  - If the selected Cue does not reside in the Show Audio Files Folder or the sampling rate is different to the Show rate opens the Consolidate Cues dialog. Otherwise, shows a message: **Nothing to do, all files already properly consolidated.**

#### Record Audio

- **Record Audio**
  - Opens the Record Audio dialog. **Please see: Recording on page 59**

#### Replace Audio Media

- **Replace Audio Media**
  - (Only present for a Cue containing Audio.) Opens a Browser window to select an alternative Audio Media file to replace the current one for the selected Cue.

#### Snapshot Automation

- **Snapshot Automation**
  - Takes a snapshot of the mixer state. This will be recalled by the Cue.

#### Paste Automation

- **Paste Automation**
  - Applies the automation snapshot on the Clipboard to the selected Cue.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Audio Gain</td>
<td>Opens the <strong>Cue Gain</strong> fader window</td>
</tr>
<tr>
<td>Edit Rules</td>
<td>Opens the Cue <strong>Interaction Rules</strong> dialog</td>
</tr>
<tr>
<td>Add Rule &gt;</td>
<td>Drops down a list of Rules which can be applied to the Cue directly</td>
</tr>
<tr>
<td><strong>Fire Next Cue when Ending</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Fire Next Cue when Stopping</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Fire All Child Cues when Starting</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Stop Previous Cue when Starting</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Loop (Fire Itself when Ending</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Loop between Markers (Fire Itself between Markers</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Dim All Cues when Starting</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Select Next Cue when Starting</strong></td>
<td></td>
</tr>
<tr>
<td>Copy Rules</td>
<td>Copy the selected Cue Rules to the Clipboard</td>
</tr>
<tr>
<td>Paste And Replace Rules</td>
<td>Replaces current Rules of all selected Cues with previously copied Rules.</td>
</tr>
<tr>
<td>Paste and Add Rules</td>
<td>Appends previously copied Rules to all selected Cues current Rules.</td>
</tr>
<tr>
<td>Audition/PFL</td>
<td>Plays Cue through selected Audition output(s) For non media Cues behavior varies.</td>
</tr>
<tr>
<td>Audition &gt;</td>
<td></td>
</tr>
<tr>
<td>Start</td>
<td></td>
</tr>
<tr>
<td>Rewind</td>
<td></td>
</tr>
<tr>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td>Play/Pause</td>
<td></td>
</tr>
<tr>
<td>Fast-Forward</td>
<td></td>
</tr>
<tr>
<td>End</td>
<td></td>
</tr>
<tr>
<td>Jump Forward 1</td>
<td></td>
</tr>
<tr>
<td>Jump Forward 2</td>
<td></td>
</tr>
<tr>
<td>Jump Forward 3</td>
<td></td>
</tr>
<tr>
<td>Jump Back 1</td>
<td></td>
</tr>
<tr>
<td>Jump Back 2</td>
<td></td>
</tr>
<tr>
<td>Jump Back 3</td>
<td></td>
</tr>
<tr>
<td><strong>Pin/Unpin to Active Cue Window</strong></td>
<td>Sets the Cue <strong>Pinned</strong> or <strong>Unpinned</strong>. With Pin active in the Active Cue Window- when Pinned the Cue will appear in the Active Cue Window when selected. When unpinned it won’t.</td>
</tr>
<tr>
<td><strong>Lock in Active Cue Window</strong></td>
<td>When Lock is active in the Active Cue Window selecting this will substitute the selected Cue for the locked Cue in the Active Cue Window. (<em>Alt + Click</em> on a Cue has the same effect.)</td>
</tr>
<tr>
<td>Move Down</td>
<td></td>
</tr>
<tr>
<td>Move Up</td>
<td></td>
</tr>
<tr>
<td>Nest</td>
<td></td>
</tr>
<tr>
<td>Unnest</td>
<td></td>
</tr>
<tr>
<td><strong>Hot/Custom Keys</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Hot/Custom Keys Design Mode</strong></td>
<td></td>
</tr>
</tbody>
</table>
Consolidate Cue

For maximum security, accuracy and stability it is desirable that all Audio Cues are at the same sampling rate as the Show. If on adding a Cue by loading an Audio File the sampling rate does not match the Show the Consolidate Cues dialog opens. This can also be invoked for an existing selected Cue by choosing Consolidate from the Cue menu or the right-click context Cue menu.

If you choose No the Cue will remain in its current location and will be played through the Ovation Sampling Rate Conversion Engine. If you choose Yes the process of copying the Audio File(s) and converting the sampling rate (if necessary) begins:

If the Consolidate Cue function is selected and the Audio Files are already in the Show Audio Files folder and at the same sampling rate as the Show this message appears:

Consolidate Cues dialog

Consolidating Cues... dialog

Consolidate Cues message
CD Tracks Import

Ovation has comprehensive CD import functions.

Selecting **Cue > Add Cue > Import CD Tracks** from the **Cue** Menu or the **Cue / Cue List** context menu opens the **Import CD** dialog.

### Device Settings

The combo box drop-down list shows all suitable drives on the machine.

### Import CD dialog

**Device Settings**

- **CD: SONY DVD RW DDU-670S 1.60**
- **Settings:**
- **Ready**

**Disc Content**

<table>
<thead>
<tr>
<th>Track</th>
<th>Start</th>
<th>Length</th>
<th>ISRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Fantasy, Beaming Down</td>
<td>36:54:40</td>
<td>00:21:60</td>
<td></td>
</tr>
<tr>
<td>Space Fantasy, Cedric The CD Robot</td>
<td>36:18:25</td>
<td>00:54:67</td>
<td></td>
</tr>
<tr>
<td>Space Fantasy, Space Battle</td>
<td>37:11:17</td>
<td>01:41:55</td>
<td></td>
</tr>
<tr>
<td>Horror, Stretched On The Rack</td>
<td>36:52:72</td>
<td>00:43:23</td>
<td></td>
</tr>
<tr>
<td>Horror, Branding Iron</td>
<td>39:36:20</td>
<td>00:37:42</td>
<td></td>
</tr>
<tr>
<td>Horror, Whiplashes (A)</td>
<td>40:13:62</td>
<td>00:13:05</td>
<td></td>
</tr>
<tr>
<td>Horror, Cackling Hags</td>
<td>40:26:67</td>
<td>00:48:55</td>
<td></td>
</tr>
<tr>
<td>Horror, Pendulum Torture Machine</td>
<td>41:15:47</td>
<td>00:54:38</td>
<td></td>
</tr>
<tr>
<td>Legends, Thunderball And Thunderclap</td>
<td>42:10:10</td>
<td>00:12:15</td>
<td></td>
</tr>
<tr>
<td>Legends, Unicorn</td>
<td>42:22:25</td>
<td>00:19:40</td>
<td></td>
</tr>
</tbody>
</table>

- **Import All Tracks**
- **Import Selected Track(s)**

**Target File**

- **Destination drive:** G:\Ovation Projects\Audio Files
- **Format:** BWF
- **Waveform:** Generate WHILE recording
- **Sampling Rate:** 48000
- **Freex:** BBC Sound Effects Library - disc 08

**Keep window open after Import:**

### Device Settings

The combo box drop-down list shows all suitable drives on the machine.
Settings

The Settings button opens a dialog box with specific drive settings. These settings may be altered if required by clicking on an entry and typing a new value in the box.

Status

The field to the right of the Settings button shows pertinent information about the CD import process.

Disc Content

- **Read TOC...** Click the Read TOC to read the Table Of Contents on the CD. The tracks are listed in the pane below.
- **Read ISRC, UPCEAN & CDtext** When checked this information will also be read, if present.
Query Database

Click to use an online database to obtain track names and other data about commercial CDs. Results are shown in a dialog:

![CD Import Query Database results dialog](image)

If multiple disc titles are shown, click on the appropriate one to select it then click on OK to import the data. The disc name is automatically entered in the Clip Prefix field.

Database Settings

Click to access a dialog where the database address and other settings can be changed:

![CD Import Database Settings dialog](image)

Default settings are shown above. To change a setting, click on the entry and type. Click OK to save the edited settings. Defaults restores the default settings and Cancel closes the dialog without making changes.

Import All Tracks

When active all tracks on the CD will be imported regardless of individual selections in the track list check boxes.

Import Selected Track(s)

When active only the tracks selected (ticked in the track list) will be imported.

Select All

Click the button to select all tracks in the list.

Deselect All

Click the button to deselect all tracks in the list.

Target File

Destination Drive: Information only. Shows the folder where the resulting files will be placed.

Format: Shows the format selected and offers the choice of:

- PMF, SD2, AIFF, FLAC, Ogg Vorbis, MP3/MPEG-1/2 Audio, MP4/AAC, DSDIFF, DSDIFF Edited Master, Virtual Tape, Wave, BWF, CD Image, MTFF, Digital Release, OMF.
Waveform: Offers the choice of **Generate WHILE recording**, **Generate AFTER recording** or **None**.

Sampling Rate Offers an extensive choice of sampling rates for the imported tracks. CD tracks are sample rate converted automatically on import if anything other than 44.1kHz is selected.

Prefix When checked a prefix will be added to each imported track. This defaults to the CD title but any desired prefix may be typed in the field when the box is checked.

Track Bar illustrates progress bar for each imported track

Disc Bar illustrates import progress of all selected tracks or the entire disc.

Import Tracks Click to initiate the import process.

Cancel Click to abort an import in progress or to close the dialog without importing.

**Keep window open after Import** When checked the CD Import window remains open, e.g. for further imports, after the import is completed. The Prefix label field will be grayed out when this option is selected.

**Keep open** keeps the CD Import window open after the import is completed and grays out the Prefix field.

---

**Cue Capabilities**

A Cue is a container object for commands to initiate or respond to actions, e.g. Play a Media file or run a Batch File etc. Cues can have single or multiple functions. There is only one Cue type covering all capabilities.

**Audio**

A Cue can trigger playback of mono, stereo or multi-channel audio media files. It can also trigger playback of Pyramid Compositions which may contain many elements.

**TimeCode Generator**

A Cue can output LTC to any suitably equipped device.

Choose a suitable Port in the TimeCode generator section of the Properties panes.

Tip: The Mixer Generator plugin can also output LTC on a dedicated strip or bus. This TimeCode is based on the Show time setting.

**MTC**

A Cue can send MTC (MIDI TimeCode) to any suitably equipped hardware or software device.

Choose a suitable MIDI Port in the TimeCode generator section of the Properties panes. (Remember, the Cue setting overrides the Cuelist setting which, in turn, overrides the Show setting.)

**MMC**

A Cue can send MMC (MIDI Machine Control) commands to any suitably equipped hardware or software device.

Choose a suitable MIDI Port in the MMC section of the Cue Properties pane and enter the start time.

**Fire** sends an MMC **Play** command, **Pause** an MMC **Pause** command and **Stop** an MMC **Stop** command.

**MIDI Command**

A Cue can send General MIDI Commands to any suitably equipped hardware or software device.

**Sony P2 / RS422**

A Cue can send Sony P2 / RS422 commands to any suitably equipped hardware device. This includes a VCube either running in the same machine as Ovation or on a remote machine. Please see: **Sony P2 over IP** on page 163

**Fire** sends a Sony P2 **Play** command, **Pause** sends a Sony P2 **Jog(0)** command and **Stop** sends a Sony P2 **Stop** command.
**IP Command**
Data to be output can be added in the filled in the **Cue Properties** pane (unique to every Cue). IP command format can be ASCII, HEXA (Hexadecimal) or OSC. The IP Output port can be selected.

**GPO**
A Cue can send GPO commands via a serial port and adaptor to any suitably equipped hardware device.

*Please see: GPO on page 165 and GPO Section on page 110*

**Shell Commands/Scripts/Batch files**
*Please see: Shell Command / Script / Batch Section on page 110*

**Microphone Switch**
A Cue can switch mixer inputs from replay to mic for the duration of the Cue. This operates within a 24 hour window. *Please see: Microphone Switch Section on page 106*

**Mixer Automation**
A Cue can trigger an automation snapshot which is applied to the Ovation mixer. A Cue can also trigger dynamic automation of the Ovation Mixer. *Please see: Snapshot Automation on page 52 and Dynamic Automation on page 54*

**REMOTE CONTROL: General MIDI Command**
Individual Cues can be remote controlled from General MIDI Commands. *Please see: REMOTE CONTROL: General MIDI Command on page 111.*

**REMOTE CONTROL: IP Command**
Individual Cues can be remote controlled from IP Commands

**REMOTE CONTROL: Multi-Sequencer Synchronization**
Individual Cues can be synchronized on secondary Slave or Master machines. *Please see: Multi-Sequencer Synchronization on page 30*

**REMOTE CONTROL: Dataton Synchronization**
Individual Cues can be synchronized with Dataton video player timelines.

**Empty Cues**
Empty Cues can be created by clicking on the **Add** button or from the menu **Cue > Add > Add** or from the right-click Cue context menu. Empty Cues can have Media or Commands added subsequently so that Cue Lists can be constructed before the media is available. Empty Cues can also be used in conjunction with Cue Rules to construct complex interactions.

**Compound Cues**
A single Cue can contain instructions to do many things at once. For example, play an Audio Media file and dim the lights. To add functions to a Cue simply set the required options in the various sections of the Cue Properties pane.

**Scenes**
Cues can be nested, many layers deep if required. For operational convenience the top level is referred to as a **Scene**. In, for example, theatre work, if all the Cues and Child-Cues associated with scenes are nested under single top-level Cues then the Scene buttons enable quick changes between these Scenes whereas the Cue navigation buttons will step through each Child-Cue.
Mixer

Each Show on each Ovation has an Audio Mixer associated with it. This is configurable to suit local requirements.

Cue based Snapshot Automation and Dynamic Automation is available. Please see: Snapshot Automation on page 52 and Dynamic Automation on page 54

Please see the Mixer Chapter in the Pyramix User Manual for details of all the manifold configuration options.

**Note:** For the present, before you can add Strips and effects etc. you may have to **Initialize** the current Show, **Start** it and **Stop** it before the mixer can be rebuilt to reflect the required configuration.

Automation

**Snapshot Automation**

Any Cue can store a Mixer Snapshot and recall it when the Cue is fired. The snapshot changes to the mixer can be implemented when the Cue is fired instantly, over the entire length of the Cue linearly or over a user-defined time period linearly.

**Store a Snapshot**

- Select the Cue to which you wish to add a Snapshot.
- Set the mixer control(s) to be affected by the Snapshot to the required values.
- Open the **Cue Properties** pane (if not already visible)
  - In the **Mixer Automation** > **Type** field click in the ComboBox and select **Snapshot**, or
  - **Cue > Snapshot Automation**, or
  - In the right mouse button Cue context menu choose **Snapshot Automation**.
Any of these actions will open the **Filter Mixer Controls to Snapshot** dialog:

![Filter Mixer Controls to Snapshot dialog](image)

This dialog is similar to the Pyramix dialog. The **By Strips** and **By Types** buttons switch between the two views.

**Note:** Switching between views restores selections to the default. I.e. All selected.

**By Strips**

In this view every automatable control in the current mixer is displayed in a tree structure. Ticked boxes include the control or group of controls in the snapshot.

- **All** button ticks every box.
- **Nothing** button unticks every box.
- Select the mixer controls to be included in the snapshot.
- Click on **OK** to record the snapshot and close the dialog.
**Current Snapshot** Shows the items already automated in a Cue.

- Modify the mixer controls if required.
- Click on **OK** to store the modified snapshot and close the dialog.

**Erase a Snapshot**

- Select the Cue from which you wish to remove a Snapshot.
- Open the **Cue Properties** pane (if not already visible)
- In the Snapshot field click in the **Type** ComboBox and select **None**

**Glide**

When a Cue containing a Snapshot is Fired any changes are applied instantaneously by default. This behaviour can be modified. Options are: over a user-defined time period linearly or over the entire length of the Cue linearly.

To modify the default behaviour:

- Open the **Cue Properties** pane.
- In the **Mixer Automation** Section
- Click in the **Glide** field.
- For a user defined glide time type a suitable value in the _:_:_:_ time entry area or:
- For a glide over the entire length of the Cue choose **Cue Length** from the drop-down list.

**Note:** If a value longer than the Cue length is entered the Glide will occur over the Cue length.

**Apply Snapshot**

To apply a Mixer Automation Snapshot simply Fire the Cue

**Note:** Two snapshots controlling the same Mixing Console controls at the same time will "conflict". Please avoid this situation.
Snapshots can be **Auditioned**, however FF/REW and Scrubbing is not possible.

**Copy and Paste Snapshot**

To Copy a snapshot simply Copy the Cue containing the snapshot.

To Paste a snapshot select the target Cue and choose **Paste Automation** from the Cue right-click context menu.
Alternatively, select **Cue > Paste Automation**. The automation snapshot is added to the target Cue without affecting the Media file or any other parameters.

**Dynamic Automation**

**Direct in Ovation**

- Mixing Console Automation can be recorded directly into Ovation
- Right-click on a Cue and select the **Start Recording Automation**.
- **Fire** or **Audition** the Cue. Any Mixing Console movements/changes will be recorded in the Cue while the Cue is playing.
- Multiple Automation record passes can be performed on the same Cue, one after another. Just stop the **Cue** and **Fire** or **Audition** it again. The last recorded Automation pass can be undone at any time using the **Cue > Undo** command.
- When done, Right-click on the **Cue** and select **Stop Recording Automation**.

**In Pyramix**

Mixing Console Automation can also be recorded and edited in Pyramix and sent to Ovation using the **File > Publish to Ovation** command.
Dynamic Automation can be created in Pyramix. Simply record (and edit) some automation in Pyramix, on top of some audio Clips, or without any audio on the Timeline, place **Mark In** and **Mark Out** to set the beginning and end of the automation region to send to Ovation and call **Project > Publish to Ovation as New Cue**.

In Ovation a Cue will be created and when fired it will automate the Ovation mixer console in the same way it did in Pyramix.

The mixing console in Pyramix and Ovation need not be the same, however the automated elements have to be present in both cases. In the case of plug-ins, they must be in the same order and position.

The automation must be recorded in Pyramix on the first Track/First strip, however it can be multi-track

When played back in Ovation the automation can be shifted to other strips than the first one (and following) by using the **Cue Properties > Audio > Audio Output Slot** parameter, exactly like audio cues.

If the Pyramix Timeline contained audio Clips along with automation during the preparation/recording, the Ovation Cue will also contain audio along with its automation.

The following mixing console components of the mixing console supported by Ovation dynamic automation are:

- Faders
- Panning Control
- VS3 plug-ins
- VST plug-ins

The following mixing console components are **NOT** supported by Ovation dynamic automation:

- General Mixing Busses controls
- Legacy busses controls and panners
- Masters

A Cue containing mixing console automation displays **Console Automation** in the **Cue Properties > Mixer Automation > Type** field.

In this case the **Glide** parameter by default shows **Cue Length**, meaning that reducing the cue length will stop the automation earlier.

If Glide is set to **Automation Length**, the automation will continue playing even if the Cue ends before the end of the automation track. In this case the automation cannot be stopped until its end

**Known limitations:**

- Only one Panning Control is supported, there must be only one Panning Control in the mixing console.
- **Edit In Pyramix** of a cue does not currently carry the automation back to Pyramix for editing.
- Pausing a Cue doesn’t pause the automation.
- Automation of **Bus sends** is not supported currently.
Show Logging

Show Logging creates Log Files listing every Audio file played. This is useful for broadcasters. Logging is enabled and set up in the Show Properties pane. Please see: Show Logging Section on page 95

New Log Files are created Every Show, Every Week or Every Month and may be saved in any Folder accessible to Ovation. Log Files are never deleted, new files are created with the date and time in the filename.

The filename can include:

- Station Name
- Station Name + Date
- Station Name + Show Name
- Station Name + Show Name + Date

Log Files are created in any of the following formats:

- ASCII Text (.log)
- XML (.xml)
- Enco DAD log file (.exp)

Examples

ASCII Text (.log)
2013-04-03 16:07:40 00:00:02 I Love Rock N Roll.wav

XML (.xml)

<Cue>

<Name>I Love Rock N Roll</Name>

<Date>2013-04-03</Date>

<PlayedAt>16:32:21</PlayedAt>

<Duration>00:00:07</Duration>

<FileName>I Love Rock N Roll.wav</FileName>

<PathName>E:\Media\Music\I Love Rock N Roll.wav</PathName>

</Cue>

Enco DAD log file (.exp)
16:09:0100:00:0104/03/1300000I Love Rock N Roll Love Rock N Roll.wav

Other Modules

It is possible to call other applications such as audio editors from within Ovation and exchange data with them. For example, the Merging Technologies Pyramix audio editor. Third-party applications will also be supported.
Editing with Pyramix

Note: The Secondary Audio Device is not recommended for Native systems, only for MassCore systems.

In a MassCore™ system an audio Cue, Mono, Stereo, multi-channel or a multi track composition may be opened for comprehensive editing by invoking Edit from either the right-click context menu while hovering over a Cue or for the selected Cue from Cue > Edit. However, before Pyramix editing can be used, Pyramix must be open and both applications set up in a specific way.

For example, to set up for editing stereo Cues:

1. Close Ovation if open.
2. Open the VS3 Control Panel.

   ![VS3 Control Panel](image)

3. Check that the Application drop-down list is displaying Ovation and, if it isn’t, choose it from the list.
4. Check that the Platform drop-down list is displaying MassCore™ and, if it isn’t, choose it from the list.
5. In the Audio Bridge section choose ASIO device Mode and, if it isn’t, choose it from the list.
6. Set the Number of channels (I/O) drop-down list to 8.
7. Now select Pyramix Virtual Studio from the Application drop-down list
8. Also select Native - ASIO from the Platform list.
9. Select **MT ASIO Bridge** from the **I/O Selection Driver name** drop-down list if not already selected.

10. Start Ovation go to **Settings > Show Settings > Mixing Console > Slots Allocation**.

11. In the **Slots Allocation** drop-down list set the value to **6**

12. Now open the **Ovation Mixing Console** (***View > View Mixer***) and for Strips 7 and 8, set the Live INPUTS to **MT ASIO Bridge 1 and 2** respectively.

13. Start Pyramix

14. Create a new Pyramix Project and name it “Ovation Edit” or similar. A simple 8:2 mixer will do nicely.

15. Open the Mixer Monitoring Section, select the **Configure** Tab and create a new **Speaker Set**. Name this as something you will remember such as “Ovation Edit” and patch the **L and R Speaker OUTPUTS** to MT ASIO Bridge 1 and 2. Now activate the Speaker Set. (Alternatively you can simply patch the Pyramix Mixer Stereo output strip outputs to MT ASIO Bridge 1 & 2)

16. Now save the Pyramix Project with a memorable name such as “Ovation Editor”.

Now you can right-click on a stereo Cue in Ovation and choose **Edit**.

17. The selected Cue will open in Pyramix.

18. Edit in Pyramix until you are happy with the results.

19. In Pyramix select **Project > Ovation > Publish to Ovation** and the edited Cue will appear in the same place in Ovation.

(Alternatively, choose **Project > Ovation > Publish to Ovation as a New Cue**. The edited Cue will then appear in the Ovation Cue List directly below the original with the same name and the suffix **(New)** E.g. if the original Cue is named **steampass2** then the new one will be named **steampass2 (New)**)

**Note:** Pyramix must be opened AFTER Ovation and with an empty project loaded before invoking **Edit**

**Note:** If you rather wish to use the extended capabilities of the Merging Audio Device driver, at step **9**, set the Pyramix Native driver to **Merging Audio Device** instead of MT ASIO Bridge.

Start the **Merging Audio Device panel**, and set it in **MassCore mode**.

The Merging Audio Device must be installed separately.

**Note:** If you wish to edit Multi-channel Cues then simply follow the above set-up procedure increasing the number of slots and changing speaker/output mappings as appropriate.

**Note:** When **Edit** is invoked from an Ovation Cue the existing Pyramix Project will be overwritten with the new Cue. I.e. all existing tracks will be deleted and new tracks created to accommodate the new Cue for editing.

**Note:** Clip Gain and Envelope ARE supported and published to Ovation.

- When a Cue edited in Pyramix contains Envelope information this is published to Ovation.
- Clip Gain set in a Cue edited in Pyramix is published to Ovation. (Gain value applied is not visible in Ovation)
Recording

Overview
Ovation is able to record up to 8 channels of audio at a time using a mixer which is independent of the Ovation output mixer.

Operationally, recordings are made into Cues in Cue Lists. The new recording can replace the Audio media file or files referenced by the Cue currently or recordings can be made into a new, empty Cue. Recordings may be made in Compose Mode or Show Mode whether the Show is running or not. (Provided that Forbid Editing is set to No in Show Properties > Show Time Properties.) When recording in Show Mode all features of the Ovation user interface operate just as they do when no recording is taking place.

Recordings are made in 24 bit Broadcast Wav format (.bwf) at the sampling rate of the current Show.

Record

Initiating Recording
There are two methods of initiating a recording.

• To replace the Audio Media in an existing Cue with a new recording:
  • Select a Cue in a Cue List.
  • Choose Record Audio from the right-click context menu or Cue > Record Audio
• To record Audio to a new, empty Cue:
  • Choose Add Cue > Record Audio as New Cue from the right-click context menu or Cue > Add Cue > Record Audio as New Cue.
  (Alternatively you could create a new empty Cue then proceed as for replacing the Audio Media in an existing Cue.)

Either method of initiating a recording will open the Record Audio dialog:

Record Audio Dialog

Name
When the dialog is opened to replace the Audio Media in an existing Cue the field will contain the existing Cue’s name.
When the dialog is opened to record a new Cue the field defaults to Recording Audio Cue… In either case a new name for the recording can be typed in the field.

Input Slot
The combo box enables the choice of the first Mixer Input which will be used as the record source.

Nb Channels
The combo box sets the number of channels to be recorded. (Maximum 8)

Reset Mixer to Factory
Restores the mixer to the default 8 mono inputs, one stereo output.
Show/Hide Mixer: Toggles the Record Mixer visible/hidden. (Default is hidden.)
Progress: The counter shows elapsed time from the beginning of recording.
Record: Click the button to start recording.
Cancel: Click the button to cancel recording and close the dialog.

Note: The Record and Cancel buttons are modal. When recording they offer the following options:

Stop & Accept: Click the button to stop the recording, close the dialog and link the recording to the selected Cue.
Abort & Try Again: Click the button to cancel the recording, delete the file and leave the dialog open for another recording.

Note: If the Cue being recorded is deleted or the list containing the Cue is closed the recording will be terminated correctly and the file will be created properly but no Cue will be created or changed to point to the recording.
If a Record Audio operation is Undone then the Cue returns to its previous state or is removed but the Audio Media file is retained.

Recording File location
Files created by recording will be located in the Audio Files sub-folder of the folder containing the Show file.
Record Mixer

A dedicated Record Mixer is created when the Record Audio dialog is opened:

![Default Record Mixer](image)

The Mixer can be displayed using the Show/Hide button in the Record Audio dialog.

By default, the Record Mixer is created with 8 mono inputs strips and one stereo output bus.

Inputs are connected to Channels 1 to 8.

The mixer is configurable as desired and will be recalled in the same state when the Record Audio dialog is opened subsequently.

Note: VERY IMPORTANT

If you wish to use Record Mixer outputs for monitoring etc. then please ensure the physical outputs selected are NOT already assigned to the Ovation output Mixer. If outputs already in use in the OV output Mixer are assigned to the Record Mixer they will be reassigned and the relevant outputs from the OV output Mixer will be disconnected.

Note: For detailed information about mixer configuration please see the Pyramix User Manual.

Note: The Pyramix Mixer has been extensively updated and revised with an extremely powerful new architecture. The legacy Mixer shown above is still available. Please consult the Pyramix User Manual for full details of the new mixer.
Overview
The Ovation user interface has been designed from the ground up for composing and running shows. A show can contain Media and Trigger Cues of many types and these can be fired manually or automatically to suit the application.

Commands and functions can be accessed from buttons, pull-down menus, contextual pop-up menus and keyboard shortcuts.

There are generally several ways of accessing any given function in Ovation. Sub-sections of the interface are separate, dockable, nestable panes that can be shown or hidden and arranged automatically or by the user. This is intended to enable users to work in the manner they find most comfortable for the type of task they are undertaking. It also means ‘Power Users’ can develop highly efficient operating procedures.

It is perfectly possible to use Ovation casually, or as an operator, without discovering all of the many available possibilities. However, for Show designers, a far more rewarding experience awaits.

User Interface Options

Apart from conventional menus Ovation offers many other UI options:

Fire Command
The Fire Command acts like Double-Click when in Show Compose Mode and is mapped by default to the Space key. So:

• In Edit Mode, Space Bar toggles Audition / Stop.
• In Show Mode, Space always Fires the Cue.

In Show Mode, Enter initiates Fire Sequenced Cue (Fire and Select Next Cue).

Context Menus
Right-clicking pop-ups menus with commands and options relevant to the current cursor location.

Keyboard Shortcuts
In particular we would encourage users to use keyboard shortcuts and preferably the standard Ovation mapping. Keyboard shortcuts can be fully customized.

Hardware Control Surfaces
For many applications a hardware control surface and or touch-screen will be desirable if not essential. Merging Technologies offer a versatile, dedicated controller for Ovation and our Sales Partners can help with bespoke solutions.

For a full list of compatible controllers and their capabilities please see here:
https://confluence.merging.com/pages/viewpage.action?pageId=17203276

Mouse Modifier Keys
The range of possible actions resulting from a mouse click are extended by the use of Keyboard Modifiers. These aid productivity and are well worth learning. Please see: Appendix VI on page 228
Main Window

If Ovation is launched without any Cue Lists present it opens as a blank canvas with no panes present. You will see the main Ovation window with its Menus at the top and the Show Controls with Time Display at the bottom.

Fixed Buttons

At top right the standard buttons are standard Windows items.

Minimize Minimizes the Main Ovation Window to the Taskbar.

Maximize / Restore Toggles between Maximizing the Main Ovation Window and Restoring it to the size and position it occupied prior to being minimized / maximized

Close Opens the Exit Ovation dialog
Click on **OK** to close **Ovation** or **Cancel** to exit the dialog without closing **Ovation**.

**Main Window, Panes and Toolbars**

The Ovation user Interface is based around a Main Window with sub-windows or Panes. These Panes (and Toolbars) can be positioned anywhere on the Windows Desktop, they do not have to remain inside the Main Ovation Window. Panes and Toolbars are ‘magnetized’ to each other and to the edges of the Main window when in close proximity. Panes and Toolbars will also resize automatically when close to the Main window edges. The new size is shown as a semi-transparent grey box. Resizing only takes place when the mouse button is released. Blue “Landing Lights” show where a Pane will dock.

Double-clicking in the Pane title bar toggles its size and position between current and last or docks the Pane in the Main window.

**Nested and Combined Panes**

**Nested Panes**

Panes, e.g. Cue lists or Properties can be nested by simply dragging, say Cue List 2 over Cue List 1 Until the blue “ghost” pane covers most of the existing pane and the centre blue landing light is lit.

![Cue List Pane with Cue List ready to dock - Compose Mode](image)
Here is the result:

The large buttons at the top enable the focus to be switched between the nested Panes, in this case:

1 - **Cue List 1**, 2 - **Cue List 2**.

Panes can be Un-Nested by clicking and dragging on the large Cue List label buttons.
Combined Panes

If a Pane is dragged over another near the edges a Combined Window can be formed. This can be Closed or Auto-hidden as a single entity. Depending on where the Pane is dragged Panes can be combined vertically or horizontally. In the following image you can see a pair of Properties Panes Combined with two nested Cue List Panes.

Here you can see that **Cue List 1** has the focus. Properties are displayed for the selected **Cue**, highlighted in dark gray, in the selected **Cue List**, highlighted in pale green.

Cue List Properties are pale green, Show Properties are blue and Cue Properties are gray.
Ovation is equipped with a number of standard Toolbars. These can be shown in the user interface or hidden as required. It is also possible to show Toolbars in Compose Mode and hide them in Show mode by setting the *Hide Toolbars* field in *Show Properties* to *Yes*.

All Main Window toolbars including the Menu toolbar can be made floating by clicking to the left of the first entry until the cursor changes to Move and dragging to a new location. If a floating Toolbar is dragged close to the edge of the Main Window it will snap to a docked configuration.

**Toolbar Context Menu**

Right-clicking on a blank part of the Main window header or footer opens the **Toolbars** menu:

```
Show
Cue List
Create Cue List
Cue
Fire
Settings
Show Control
Audition
Customize...
```

Checked entries in the list will be present in the Main Ovation window.
Audition Toolbar

Selecting **Show > View Audition Toolbar** adds the **Audition Toolbar** to the bottom of the main Show Window.

The buttons should be self-explanatory but, just in case, from left to right we have:

Start of Cue or Previous Cue if cursor is at Start of Cue - Rewind - Stop - Start / Pause - Fast Forward - Next Cue

These controls act on the currently selected Cue.

**Audition Jump**

There are six **Audition Jump** commands. These commands are available only when Auditioning a Cue and via Keyboard Shortcuts or with a modifier key when clicking on the Rewind and Fast Forward buttons in any Audition Toolbar or on the Ovation Keyboard:

- **Audition Jump Forward 1**: Jump 1 Second later in time (Ctrl + -> Key or Fast Forward Button)
- **Audition Jump Forward 2**: Jump 5 Seconds later in time (Ctrl + Shift + -> Key or Fast Forward Button)
- **Audition Jump Forward 3**: Jump 15 Seconds later in time (Ctrl + Shift + Alt + -> Key or Fast Forward Button)
- **Audition Jump Back 1**: Jump 1 Second earlier in time (Ctrl + <- Key or Rewind Button)
- **Audition Jump Back 2**: Jump 5 Seconds earlier in time (Ctrl + Shift + <- Key or Rewind Button)
- **Audition Jump Back 3**: Jump 15 Seconds earlier in time (Ctrl + Shift + Alt + <- Key or Rewind Button)
**Audition Drop-down**

In a Cue List pane, clicking on the down arrow immediately to the right of the Audition button drops down the Audition transport controls. These are identical in function to the Audition Toolbar.

---

**Modifiers Toolbar**

Selecting Show > View Modifiers Toolbar adds the **Modifiers Toolbar** to the bottom of the main Show Window.

The **Modifiers Toolbar** is intended for users controlling Ovation from a touch-screen. The functions are the same as those found on the physical controller. **Please see: The Ovation Keyboard Controller Commands Map on page 214**
Show Controls

The **Show Control** bar at the bottom of the main screen can be made floating in the same manner as the **Menus**. I.e. click and drag at the left-hand edge when the cursor changes to a cross.

If the **Show Control** bar is dragged near to an edge of the Main Screen it will re-dock, horizontally or vertically. Otherwise it can be placed anywhere on the Desktop.

- Select **Previous Child-Cue** in currently selected Cue List
- Select **Next Child-Cue** in currently selected Cue List
- **Fire Selected Cue** in currently selected Cue List and select next Cue and make **Ready to Fire**
- Select **Previous Cue** in currently selected Cue List
- Select **Next Cue** in currently selected Cue List
- Toggle through **Cue Lists** in ascending order (with **Shift** in descending order)
- **Fire Selected Cue** in currently selected Cue List. Cue remains **Ready to be Fired Again**
- **Pause Selected Cue** in currently selected Cue List
- **Stop Selected Cue** in currently selected Cue List
- **Show Time Counter** Displays selected Time format when Show is running
- **Initialize Show** Prepares Show for Running. **Cue Lists** displays change to **Show Mode**
**Start Show** Timed Cues fire at appropriate times. **Hot Key** Cues can be Fired at will.

**Pause Show** Opens the **Pause Show** dialog:

![Pause Show Dialog](image)

**OK Pauses** the Show, **Cancel** closes the dialog without affecting the Show.

![Pause Show button](image)

Clicking on **Pause Show** when the Show is Paused, Re-starts the Show from the point at which it was Paused.

**Stop Show** Opens the **Stop Show** dialog

![Stop Show Dialog](image)

**OK Stops** the Show. **Cue List** displays return to Compose Mode and the Time is reset if Time Mode is **Duration**. **Cancel** closes the dialog without affecting the Show.

**Note:** The **Pause Show** and **Stop Show** dialogs can be suppressed in the **Show Properties** pane. Useful for rehearsals and when constructing a Show.

**Other Toolbars**

The other Toolbars are accessed by right-clicking on a blank area of the main Ovation Window header or footer and selecting them from the context menu. All the extra Toolbars are user configurable. The down arrow next to the far right icon gives access to the current Toolbar’s buttons plus **Customize...** Buttons visible currently in the Toolbar are highlighted in blue. Clicking on an entry in the list toggles it shown/hidden. The last entry in the list is **Reset Toolbar** this does what it says and resets the Toolbar to the default condition. I.e. all buttons present.
Show

- New Show
- Open Show
- Save Show
- Initialize Show
- Start the Show
- Pause the Show
- Stop the Show
- Consolidate the Show
- Package the Show
- Toggle Show Properties pane show/hide
- Toggle Show Validator pane show/hide
- Toggle Show Log pane show/hide
- Toggle Show Control Toolbar show/hide
- Toggle Audition Toolbar show/hide
- Toggle Active Cue Window show/hide
- Toggle Audio Gain Matrix show/hide
Cue List

New - drops down the list of possible Cue List types. Selection opens new list.

Open Cue List

Save Cue List

Toggle Cue List Properties pane show/hide

Fire /Start Timed List

Start Timed List

Pause Timed List

Stop Timed List

Chase Timed List

Fire Toolbar - Toggles Fire Toolbar show/hide in selected Cue List in Show Mode for selected window

Edit Toolbar - Toggles Edit Toolbar show/hide in selected Cue List in Compose Mode for selected window

Toggle/Select Cue List - Cycles the selection through open Cue Lists

Toggle/Select Hot Key List
Create Cue List

New Standard Cue List
New Timed Cue List
New Hot Keys Cue List
New Custom Keys Cue List
New Cue Browser
New Hot Browser

Cue

Undo
Cut
Copy
Paste
Toggle Cue Properties pane show/hide
Open Cue Rules window
Open Cue gain fader dialog
Add - drops down the list of Cue add options
Remove - selected Cue
Edit - Cue in Pyramix (if already open)

Replace Audio Media - Opens a browser to select an alternative Audio Media file/Composition.

Snapshot Automation

Paste Automation

Audition - Click on the button to Audition the selected Cue or the down arrow to drop-down the Audition transport controls.

Pin/Unpin Cue to the Active Cue Window

Places and Locks selected Cue in the Active Cue Window (Only available when Lock is active in the Active Cue Window)

Move Down

Move Up

Nest

Un-nest

Link Offsets / Start Times

Fire

Fire Selected Cue

Select Previous Scene

Select Next Scene

Select Previous Cue
Select Next Cue

Fire Selected Cue

Pause selected Cue

Stop Selected Cue

Stop All Cues

Settings

Open Settings Window

Open Keyboard Shortcuts Window

Show Menus and Toolbars in Emergency

The Hotkey combination Ctrl + Alt + Home brings back the menus and all selected Toolbars when in Show Mode to give access to all commands in case of emergency.
Features & Functions

The **Active Cue** Window displays information about, and enables various operations to be performed on, the **Cue** selected currently in both Compose and Show modes.

Cursor Position, Position in Audio File and Zoom Level is remembered when switching between Cues.

Further Edit operations can be performed using the **Active Cue Window Edit Toolbar**. This is toggled from either the **Show** or **View** Menus.

**Compose Mode**

![Active Cue Window - Compose Mode](image)

**Cue List and Cue**

Below the Upper Toolbar the first bar shows the **Cue List** where the Active Cue is located. The second bar shows the **Active Cue**. The two buttons to the right activate **Pinned** mode or **Locked** mode.

**Lock and Pin**

**Pinned Mode**

**Pinned Mode** enables only Cues with “interesting” content to be displayed in the Active Cue Window.

When the Pinned button is inactive all types of Cue are shown in the Active Cue Window as they are fired.
When the Pinned button is active only Cues with the **Pinned to the Active Cue Window** parameter set to **Yes** in **Cue Properties** will be shown as they are selected. Audio Cues are Pinned by default. Other types of Control Cue are unpinned by default.

**Override**

*Alt + Click* on an Unpinned Cue overrides the Pin function temporarily and substitutes this Cue for the current Cue.

**Note:** The Pinned icon is only shown in Cues in Cue Lists when Pinned is active in the Active Cue Window.
Locked Mode

Locked Mode when active locks the Cue displayed currently to the Active Cue Window. No other Cues will be displayed until Lock is deactivated.

Override

Alt + Click on another Cue overrides the Lock temporarily and substitutes this Cue for the current Cue.

Unlocked. Cues are displayed as they are selected or fired.

Locked. The Cue currently displayed is locked to the Active Cue Window.

In a Cue List the Cue locked to the active Cue Window is shown with a Lock symbol to the left of the name.
**Cue Trimmer**

![Active Cue Window - Trimmer](image)

**Navigation**

**Marker Button**

The Marker button gives access to the Marker management functions. **Please see: Markers on page 87.**

**Scroll Bar**

The **Scroll bar** and **Nudge** buttons, **Zoom In / Zoom Out / Zoom-To-Fit** buttons control the view of the Cue in the Trimmer.

The size of the Scroller handle changes according to how much of the Cue is visible in the Timeline.

- The **Nudge** buttons scroll the view of the Cue left or right in one second increments.
- **Zoom In**
- **Zoom Out**
- **Zoom-to-fit**

**Timescale Ruler**

The Cue selected currently is shown in the Active Cue Timeline starting at **00:00:00:000**.

Double-clicking in the Ruler auditions the Cue from the mouse cursor position within the active area.

Clicking and dragging in the Ruler moves the Timeline.

**Audition Cursor/Trimmer Scale Ruler**

- **In Stop** mode, with the **Alt** key pressed and held, placing the mouse cursor on the Audition Cursor in the Trimmer Scale Ruler and clicking auditions the Cue while the left mouse button is held down. (Mouse Cursor changes to I-beam) Audition Cursor flies back to Mouse Cursor position when button released.
- **In Stop** mode the I-beam mouse Cursor moves the Audition Cursor without playing.
- When Stopped or Paused and calling Audition or Fire from the Active Cue Window playback starts from the current Audition Cursor position, i.e. from where previous playback stopped. This allows for, when for example rehearsing a show, the rehearsal to be resumed from the middle of a Cue and not from its beginning.
• After pressing the Audition Stop button twice the next Audition or Fire will start from the beginning of the Cue.

• Clicking in the Trimmer Scale:
  • If Cue Playing then jumps to the Click point and continues to Play.
  • If Cue Auditioning then jumps to the click point and continues to Audition.

• Click in a Marker selects the Marker.

• Click in a Marker with ALT pressed:
  • If Cue is Playing Cursor jumps to the Marker and continues Playing.
  • If Cue Auditioning Cursor jumps to the Marker and continues to Audition.

  **Note:** In order for the Markers playback to be accurate the Cue Sampling Rate must be the same as the Ovation Show. Otherwise the Cursor might start from the wrong location.

• Double-clicking in the Trimmer Scale starts Auditioning the Cue from the click point.

• Double-clicking in a Marker opens the Marker rules for editing.

• Double-click in a Marker with ALT pressed starts Auditioning from the Marker. Cursor returns to the Marker when Cue ends.

When calling Fire or Audition from outside the Active Cue Window (Menu, Keyboard, Show Control Toolbar, etc…) the Active Cue is Fired from its current **IN** point.

**Trimmer Waveform Display**

The visible portion of the selected Cue is displayed and the active portion of it is highlighted in lighter gray. The four boxes at the corners of the shaded area are handles. These handles can be dragged to adjust the Start, End, Fade In and Fade Out points graphically. The bottom handles set the **In** and **Out** points and the top handles adjust the **Fade In** and **Fade Out**. Double-clicking a handle restores the default value. I.e. the Cue boundary for the In and Out handles and No Fade for the Fade Handles.

  **Note:** The Start and End points can be dragged out beyond the boundaries of the Media to provide a Start Offset / Preroll and or an End Offset / Postroll.

**Zoom and Move**

Clicking and dragging horizontally anywhere in the Timeline and Ruler while the cursor is a cross moves the entire Timeline.

Clicking and dragging vertically anywhere in the Timeline and Ruler while the cursor is a cross zooms into or out of the Timeline.

**Trim with the Mouse**

The Cue can also be modified with the mouse.

• **SHIFT+Click** moves the **Cue IN** to the current mouse position.

• **Ctrl+Click** moves the **Cue OUT** to the current mouse position.

**Review while trimming:**

• To review the Cue while trimming the in point, simply audition it (either by using **Audition Play/Pause** or **Review Start**): Each time the Cue **IN** is modified with one of the above methods, the Cue is restarted from its new **IN** point.

• To review the Cue while trimming the **OUT** point, simply press **Ctrl + Review End**: When the audition gets to the current Cue **OUT** point, it loops the last second of the Cue.

  **Note:** The Preroll and Cue Out Loop durations are set in **Settings > Application Settings > General > Audition**. While the Cue loops, you can trim the Cue out precisely with quick and interactive feedback of the current result. Once the Loop Out mode is
enabled by Ctrl + Clicking the Review End icon button all the subsequent keyboard-shortcut calls to Audition Review End (Ctrl + Alt + Space) will play in Loop out mode, until the “Review end” icon button gets mouse-clicked without the Ctrl key. When working with the mouse, you can choose to press Ctrl or not, each time you review the end of the Cue.

**Toolbar Audition Mode**

![Active Cue Window - Audition](image)

From left to right the buttons are:

- **Fire**
  - Grayed out in Audition mode.

- **Pause**
  - Pauses Playback of the Active Cue

- **Stop**
  - Stops Playback of the Active Cue and returns the Cursor to the Start Point.

- **PFL**
  - Initiates PFL Playback of the Active Cue, toggles with Pause.

- **Time Counter**
  - Shows the elapsed time from the Cue In Point. I.e. not the beginning of the Cue. Clicking in the counter and typing a time value moves the Playback cursor to this position.

- **1,2,3,4**
  - Rehearsal Preset buttons.

- **CLEAR PRESETS**
  - Clears all the Rehearsal Presets set for the current Cue.

- **ENABLE PRESETS**
  - When lit Clicking on Enable Presets disables any active Presets for the current Cue.

Please see also: Rehearsal Preset Points on page 85

**Show Mode**

**Note:** The Active Cue Window displays the Cue selected currently in the Cue List selected currently. I.e. NOT the Cue playing unless this is also selected.
In **Show Mode**, if the **Forbid Editing** field in **Show Properties** is set to **Yes**, the Active Cue Window is simplified by the removal of the top Edit Toolbar (if present).

**Auditioning or Firing a Cue**
Cues can be auditioned or Fired while the show is running by selecting them and using the Active Cue window buttons.

**Cue Fired**
When the selected Cue is Playing in Show Mode the **PFL** button is unavailable. (Grayed out.)

**Active Cue Window Edit Toolbar**
Hidden by default, the Edit Toolbar can be shown by selecting **View > View Active Cue Window Edit Toolbar**.

- **Cue Properties** Opens the **Cue Properties** pane with details of the Active Cue
- **Cue Rules** Opens the **Cue Rules** window
- **Cue Gain** Opens the **Cue Gain** Window
- **Edit** Opens the Active Cue ready for editing in Pyramix (Pyramix editing must be set up and Pyramix launched before Ovation if this function is required.)
- **Replace Audio Media**
- **Snapshot Automation**
- **Snapshot Automation Paste**
  - **Audition** clicking on **Audition** auditions the Cue. Clicking on the small arrow gives access to the Audition transport controls. (Same as those at the bottom of the Window plus the **Jump** options. Please see: Audition Toolbar on page 68)
  - **Link Offsets/Start Times** Links all Audio, TCGen, MMC and 9-pin (Sony P2) Offsets and Start Times in a Cue with these properties. The button toggles on/off and it’s state is not saved when a different Cue is Active. When enabled all related field names in the **Cue Properties** pane turn red for clarity.
- **Nudge**
The **Nudge** button functions affect the Cue in the increments set in the drop-down list. Increments range from 1 sample to 100 seconds.
  - **Nudge Cue In Less** (earlier)
  - **Nudge Cue In More** (later)
  - **Nudge Cue Out Less** (earlier)
Nudge Cue Out More (later)
Nudge Fade In Less (earlier)
Nudge Fade In More (later)
Nudge Fade Out Less (earlier)
Nudge Fade Out More (later)
Nudge Cursor Less (earlier)
Nudge Cursor More (later)
Snap Cue In to Cursor
Snap Cue Out to Cursor
1 sample Nudge Value
Review Start
Review End
Rehearsal Preset Points

Overview
Up to 4 Rehearsal Point Presets can be stored and recalled within each Cue in an Ovation show. These are intended to be used as Firing points for the Cue during rehearsals when sections of a piece of audio are required to support the performance rehearsal.

Functionality
• When one or more Rehearsal Points is/are active you will see an icon in the Cue itself in the Cue List showing as a small green box with a black triangle in it. This indicates that a Rehearsal Preset Point or points is/are active.

  ![Rehearsal Preset Set icon](image)

  ![Rehearsal Preset Not Set dialog](image)

  ![Active Cue Window: Rehearsal Preset Points](image)

  ![Rehearsal Preset Not Set dialog](image)

  ![Active Cue Window: Rehearsal Preset Points](image)

• When the Show is run and the Cue Fired as normal, it will use the Rehearsal Point as the starting point for playback.

• All rules which are assigned to When Starting will apply at the Rehearsal Point.

• Fire Itself when Ending (loop) uses the Rehearsal Point as the loop In point.

• All nested or linked Cues that are set to Fire when a Cue with a Rehearsal Preset Point is Fired will Fire with a relative offset to enable them to maintain sync with the Cue being rehearsed.

Setting and Using Rehearsal Presets
• Hold SHIFT and Click on one of the 4 Rehearsal Preset buttons in the Active Cue Window when the Play cursor is in the position where you would like the Cue to begin.
  • This can be done during Playback
  • The Play Cursor can be positioned manually clicking on the Ruler Bar at the desired position.
  • This position can also be set by typing the desired time location in the Active Cue Window time counter box.
  • This position can also be set by typing the desired time into the Rehearsal Presets field in the Cue Properties window and then Clicking on Set Preset 1, 2, 3 or 4 from the drop-down list.

• To set more than one Preset, repeat as above for the other locations.

• To select which Preset is to be used, Click on the relevant Preset button in the Active Cue Window without any modifier key. The Playback Cursor will move to the Preset selected. If a button is selected which does not have a Rehearsal Preset set a dialog appears:

  ![Rehearsal Preset Not Set dialog](image)

• Alternatively, select the desired Preset from the drop-down list in the Cue Properties window by clicking on Recall Preset 1, 2, 3 or 4.

• The Rehearsal Preset Marker turns blue when active.
Disabling and Clearing Rehearsal Presets

Disable/Enable

- To Disable, but retain the Rehearsal Preset Points for a selected Cue, Click on the lit Enable button.
- To Enable Click on the unlit Enable button.
- To Disable ALL the Cues, **SHIFT + Click** on the Disable/Enable button to perform the function on all Cues. A confirmation dialog will pop-up:

![Rehearsal Preset Enable/Disable Confirmation dialog](image)

Click on **OK** to confirm or **Cancel** to abort.

Clear

- Click on the **Clear Presets** button in the Active Cue Window, or in the Cue Properties window Click on **Clear Presets** in the Rehearsal Preset field drop-down list to remove all the Rehearsal Preset Points for the selected Cue
- To clear ALL Rehearsal Presets for ALL cues in the Show **Shift + Click** on the Clear Presets button in the Active Cue Window, or in the Cue Properties window **SHIFT + Click** on Clear Presets in the Rehearsal Preset field drop-down list. A confirmation dialog will pop-up with the options of **OK** and **Cancel**.

![Rehearsal Preset Clear Confirmation dialog](image)

Limitations

Keyboard shortcuts for rehearsal preset points usage are not active and will not work if applied to keys.
Markers

Markers, in combination with Interaction Rules are a very powerful Ovation tool.

Clicking on the Markers button drops down the Markers Menu. When a Cue has no Markers only the Add Marker entry is active.

Markers Menu

Add Marker

Add a new Marker at the current Audition Cursor position. Note: existing Markers subsequent to the new Marker are renumbered.

Edit Selected Marker Interaction Rules

Opens the Interaction Rules dialog.

Remove Selected Marker

Deletes the Marker selected currently. Note: existing markers subsequent to the deleted Marker are renumbered.

Goto Marker 1

Locates the Audition Cursor to Marker 1.

Goto Marker 2

Every Marker added will show up here as a Goto Marker x entry.

Markers in the Timeline Ruler

• Clicking on a Marker in the Ruler selects it. Selected Markers are highlighted.
• Click and drag a Marker in the Ruler to move it.
• Double-clicking on a Marker in the Ruler opens the Interaction Rules dialog.

Note: Markers are always numbered in the chronological order they appear in the Timeline. So, if Marker 4 is moved before Marker 1 it is renumbered as Marker 1 and all subsequent markers are renumbered accordingly. The same applies when Markers are added or deleted. The left-most Marker will always be 1 and Markers are always numbered sequentially. Note also that Markers with Interaction Rules have an exclamation point.
Markers in Cue Properties

Markers Section

Markers

Clicking in the **Selected Marker: x** field or on the down arrow drops-down the Marker Menu.

Add Marker

Adds a new Marker at the current Audition Cursor position. **Note:** Subsequent existing Markers will be renumbered.

Remove Selected Marker

The selected Marker is deleted. **Note:** Subsequent Markers will be renumbered.

Marker Name

Click in the field and type to add a Name to the Marker. This name will be shown in the **Active Cue** window Timeline.

Select Marker 1

Selects Marker 1.

Select Marker 2

Every marker added will show up here and a **Select Marker x** entry.

etc.

Marker Offset

Shows the **Marker Offset** from the beginning of the Cue. (Does not include any Start (Preroll) Offset applied to the Cue.) Clicking in the field enables a new value to be typed. Clicking the down arrow drops-down a list with the option of **Reset**. This resets the Marker position to the current Audition Cursor position in the **Active Cue** Window Timeline. (A negative offset is shown if the Cursor position is before the start of the Cue.)

Marker Interaction Rules

Shows a list of all **Interaction Rules** applied to the Selected Marker. Clicking in the field shows a ... button. Clicking on this opens the **Marker Interaction Rules** dialog. Please see below.

**Note:** When a Cue has a Marker with a Marker Interaction Rule or rules applied this icon is shown on the Cue in the Cue List:
Markers Interaction Rules

The **Markers Interaction Rules** dialog is very similar to the general **Interaction Rules** dialog with one exception: **Reaching Marker** is a fixed property and therefore grayed out.

Simple or highly complex interactions can be set up. For example:

- Fire Cue XXX at Marker YYY to allow a Cue to be fired anywhere within a Cue automatically, at a Marker position.
- Looping within a Cue (see full description below.)
- Conditional and Multiple Looping within a Cue i.e. Setting multiple rules for the same Marker enables looping to different locations in the Cue from the same Loop Out point based on different conditions.

**Looping**

Just one of the Marker possibilities is Looping within a Cue.

To set up a simple loop:

1. Place two Markers, one at the Loop In point and one at the Loop Out point.
2. Either double-click the second, Out Marker or select it and choose **Edit Selected Marker Interaction Rules** from the Markers button drop-down Menu.
3. Set up the following:
   - **Fire**
   - **Itself**
   - **When**
   - **Reaching Marker** (Fixed, not changeable)
4. Click on **Add Rule** to add the Rule to the list.
5. Click on **OK** to save the rule and close the dialog.

And that’s it! When the Cue is fired it will play through the first Marker until it hits the second. It will then loop back to the first Marker and continue playing around the loop ad infinitum until stopped manually. This is obviously
only a very simple example and careful use of multiple Interaction Rules enable many other possibilities. For example stopping the Loop Cue when another Cue is fired.

For full details of the Interaction Rules Please see: Interaction Rules on page 115

**Note:** For a rule to be functional the system requires a period of 1 second before its triggering time to prepare for triggering the rule. Therefore Markers set before 1 second after the beginning of a Cue or 1 second before the Fade Out of a Cue will not trigger their Rules. They will be colored Red in the Active Cue Window!
The **Playing Cues** window is opened with **View > Playing Cues Window**:

This window displays a copy of all currently playing, paused and dimmed Cues in the system.

They appear in the order of their Fire Time and they disappear when stopped.

If the **Cue Fire** Buttons are enabled in the **Show Properties**, Cues playing can be Paused and Stopped directly from this window.

**Note:** Auditioning Cues do not appear in the Playing Cues window.
Types

Ovation has three types of Properties Pane, Show, Cue List and Cue.

These Panes present information about the currently loaded Show, selected Cue List and selected Cue.

- The small Minus and Plus buttons on the left Collapse each main section of the Pane to a single line and Expand it back to full respectively:

Appearance

The text in Properties Panes is displayed in the font size set in View > Properties Font Size.

Properties Fields

Some fields are for ‘information only’ many others can accept text, numeric values or provide a choice of options.

Clicking in fields other than ‘free text’ or ‘information only’ pops up a down arrow. This gives access to the options for the field.

Numeric Fields

Many numeric fields offer a choice of likely values in a drop-down list. If you wish to enter your own value simply click in the number field to produce a cursor and edit the value directly.

Precedence

In general settings made in Show Properties, Cue List Properties and Cue Properties have the following precedence:

- Cue Properties settings override Cue List Properties settings and Show Properties settings.
- Cue List Properties override Show Properties settings.
- Show Properties settings apply when not overridden by either Cue List Properties Settings or Cue Properties settings.

Where exceptions exist to these rules they are noted.
### Show Properties

<table>
<thead>
<tr>
<th>Show</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td></td>
</tr>
<tr>
<td>Default Stop Fade Out</td>
<td>100 [ms]</td>
</tr>
<tr>
<td>Modified Fade In</td>
<td>1.0 [s]</td>
</tr>
<tr>
<td>Modified Fade Out</td>
<td>1.0 [s]</td>
</tr>
</tbody>
</table>

| Default Interaction Rules |  |
| Default Output Player |  |
| Application Delay Launch | 0 [s] |
| Show Auto Start | No |
| Show Edit Password |  |

| Show Time Mode |  |
| Show Time Mode | Duration |
| Show Start Time | 00:00:00:000 |
| Chase Offset | +00:00:00:000 |

| Show Time Options |  |
| Hide Menus | No |
| Hide Toolbars | No |
| Freeze Panes | No |
| Show Validation | No |
| Forbid Editing | No |
| Hide Properties | No |
| Cue Fire Buttons | No |
| Focused Cue Flashing Mode | All Cue Lists except Hot Keys and Custom Keys |
| Show Mode Confirmations | Yes |
| Saving Confirmations | Yes |
| Popups Confirmations | Yes |
| Video Ref. to Internal on Chase Lock | No |

| Show Logging |  |

| TimeCode Generator |  |
| TC Gen Output Port | None |
| TC Gen Pause Mode | Freeze |
| TC Gen Stop Mode | Off |
| TC Gen Goto on Ready | Yes |

| Multi-Sequencer Synchronization |  |
| Synchronization Mode | Off |
| Resynchronize Drift/Jumps | No |
| Resynchronize Difference Threshold | 1.0 [s] |
Show Section

Comments
Free text field where you can add comments to the Show.

Default Stop Fade Out
Clicking in the field accesses a drop-down list with a range of fade lengths from 0ms to 20s plus <Default>. If the value is set to <Default> then the Cue Fade Out value is used when a Cue is Stopped (interrupted).

Modified Fade In
Clicking in the field accesses a drop-down list with a range of fade lengths from 0ms to 20s plus

Modified Fade Out
Clicking in the field accesses a drop-down list with a range of fade lengths from 0ms to 20s

Default Interaction Rules
Field contains a list of all Interaction Rules defined for the current Show. Note: Rules shown in this field are all in force at the same time.

Default Interaction Rules Field - Show Properties Pane

Modified Fade Out

Default Output Player
Clicking in the field reveals a drop-down list with all OV Players installed on networked PCs plus <Default Player> and <Local Player>.

Application Delay Launch
The drop-down list offers the choice of 0 [s] to 60[s].

Show Auto Start
Clicking in the field reveals a drop-down list with the options Yes or No. When set to Yes the Show loaded when Ovation was last exited starts automatically when Ovation is next launched.

Show Edit Password
Click in the field to drop-down the choice of New Password or Reset Password. The former enables the show to be password protected for editing while the latter resets the password to off.

Show Time Mode Section

Show Time Mode:
Clicking in the field drops down the Time Mode sub-menu with the choice of:

- Duration: Choose this option to fire timed events in relation to elapsed Show Time
- Time of Day: Fires timed events in relation to system clock Time of Day
- TimeCode chase: Fires timed events in relation to an external (to Ovation) source of Time-Code

Note: The current TC source is taken from LTC Horus (MassCore only) or the USBSync LTC.

Show Start Time
Applicable only in Duration mode defines the starting time of the show. E.g. if the field is set to 00:00:10:000 then, when the Show is started the counter will start at 00:00:10 i.e. 10 seconds into the duration.

Show Time Options Section

Hide Menus: When set to Yes Menus are hidden during Show Time.

Hide Toolbars: When set to Yes Toolbars are hidden during Show Time.

Freeze Panes: When set to Yes All Panes and Windows are frozen during Show Time. They cannot be resized, moved, docked, undocked, etc…

Note: This includes the Mixer!
Show Validation: Clicking in the field reveals a drop-down list with Yes and No options. When set to Yes a Show Validation (see below) is performed when Initializing the Show.

Forbid Editing: When set to Yes Editing and recording will be forbidden during Show Time. If this option is set to No then Cues can be Copied, Pasted, Deleted, Dragged, etc… and Audio recordings made during Show Time, allowing for more interactive performances to be achieved. Cues being modified during Show Time are immediately updated. If they are currently playing at that time then the changes will be available for the next playback only. Cues being deleted while playing will continue playing until they end or are manually stopped.

Hide Properties: Clicking in the field reveals a drop-down list with Yes and No options. When set to Yes Show Properties, Cue List Properties and Cue Properties will be hidden during Show Time. This option is typically used with the previous one.

Cue Fire Buttons Clicking in the field reveals a drop-down list with Yes and No options. Default is No. When set to Yes, in Show Mode all Cues have Play/Pause and Stop buttons on the left-hand side.

Focused Cue Flashing Mode For clarity, especially in Shows with many Cue Lists, the Cue with the focus is given a flashing red border in Show Mode. This setting determines which Cue List types flashing mode is applied to. Clicking in the field accesses a drop-down list with the following options:

- None
- All Cue Lists
- All Cue Lists except Hot Keys and Custom Keys

Show Mode Confirmations Clicking in the field reveals a drop-down list with Yes and No options. When set to No all “Show stopping” and “Show Pausing” dialogs will be disabled during Show Time. Typically disabled for Remote Controlled Shows and during rehearsals. When set to Yes cautionary dialogs will be displayed when performing actions which would Stop, Pause, End or Change the Show.

Saving Confirmations Clicking in the field reveals a drop-down list with Yes and No options. When set to No, no "Do you want to save..." confirmations will be shown when exiting Ovation.

Popups Confirmations Clicking in the field reveals a drop-down list with Yes and No options. When set to No, no confirmation pop-ups for actions such as closing Cue Lists will be shown.

Video Ref. to Internal on Chase Lock When Chase is locked to a Timecode and on a Video reference this option makes the Reference switch to internal if this setting is set to Yes.

Show Logging Section

Enable Logging Clicking in the field reveals a drop-down list with Yes and No options. When Logging is enabled by setting to Yes the following settings will apply:

- New Log File
- Log File Name Structure
- Log File Format
- Log File Folder

New Log File Clicking in the field reveals a drop-down list with Every Show, Every Day, Every Week and Every Month options. Choose the option appropriate to your needs.

Log File Name Structure Clicking in the field reveals a drop-down list with Station Name, Station Name / Show Name, Station Name / Date and Station Name / Show Name / Date options. This option determines how the generated Log File will be labelled.

Log File Format Clicking in the field reveals a drop-down list with ASCII Text (.log), XML (.xml) and Enco DAD log file (.exp) options.

Log File Folder Clicking in the field reveals a drop-down list with a Browse option. Clicking on Browse opens a File Browser to navigate to the required Log output Folder.

TimeCode Generator Section

The Show TimeCode can be output to any available TimeCode Output Port. This can be a MIDI MTC port enabled in Settings > Application Settings > Player Units > MIDI.

TC Gen Output Port Currently selected Output Port is shown. The drop-down list shows all available TC outputs.

TC Gen Pause Mode The drop-down list offers a choice of:
**Off**
TC output ceases when the Show is paused

**Freeze**
TC freezes at current value when Show is paused

**Free Roll**
TC continues to run when Show is paused

**TC Gen Stop Mode**
The drop-down list offers a choice of:

- **Off**: TC output ceases when the Show is paused
- **Freeze**: TC continues to generate current value when Show is paused
- **Free Roll**: TC continues to generate and increment value when Show is paused

**TC Gen Goto on Ready**
Clicking in the field reveals a drop-down list with **Yes** and **No** options. If **Yes** (enabled) the Start Time is generated continuously on the output port when the Cue is made Ready, to allow a Slave device to commence locating to the Start Time in advance of the Cue being fired.

---

**Multi-Sequencer Synchronization Section**

**Synchronization Mode**
The drop-down list offers the choice of **Master**, **Slave**, or **Off**.

**Resynchronize Drifts/Jumps**
Determines whether or not re-synchronization will take place when a sync drift or jump is detected. The drop-down list offer the choice of **Yes** or **No**.

**Resynchronize Difference threshold**
Determines how far out of sync a sequencer must be before re-synchronization takes place. Type the desired threshold in the field. Default is **1.0[s]**.

**Note**: Synchronization is sample accurate provided Master and Slave TIME is in sync. I.e. TimeCode Chase. A pre-roll of up to two seconds is required before output begins from a slave Ovation.
If this is critical in your application add two seconds of silence to Cues which start at the very beginning of the Show. Or use a TC/IP Command.
One method of achieving Time synchronization across several Ovations is to use a GPS source.

**Note**: For more information about Multi-Sequencer Synchronization configuration please see:

https://confluence.merging.com/display/PUBLICDOC/Ovation+redundancy++MultiSequencer+Synchronization
Cue List Properties

**Note:** Some fields will be grayed out and sections collapsed depending on the Cue List selected currently.

### Cue List Section

**Number**

Position in the list of **Cue Lists** of the currently selected **Cue List**. The Drop-down list enables the position to be changed. The rest of the list is re-ordered to suit. I.e. the other Cue Lists are automatically re-numbered as necessary. For example, if the selected Cue List is currently no.2 of five then changing its **Number** to 1 places it at the beginning of the list. The previous no.1 becomes 2 and everything else stays put. If Cue List 2 is re**Numbered** 4, then 1 stays where it is, 3 moves up to the empty 2 slot, 4 moves up to 3 and 5 stays where it is.

**Name**

Name (can be changed here)

**Comments**

Free text field where you can add comments to the Cue List
Automatic Cue Numbering
Default is On for Standard and Timed CueLists. Default is Off for Hot Key and Custom Key CueLists. Click in the field to toggle On/Off. When Off new Cues added will still be numbered consecutively but these numbers can be removed in the Cue Properties pane. Cue number is then determined by position in the Cue List.

Hidden
When checked the Cue List will not be visible in Show Mode. This is useful for management CueLists which contain logical instructions which are not relevant to the operator running the show.

Default Stop Fade Out
Clicking in the field accesses a drop-down list with fade times from 0ms to 20s plus <default>. If the value is set to <Default> then the Cue Fade Out value is used when a Cue is Stopped (interrupted).

Default Interaction Rules
Field contains a list of all Interaction Rules defined for the current Cue List. Note: Rules shown in this field are all in force at the same time. Clicking in the field reveals a button which leads to the Interaction Rules dialog.

Default Output Player
Clicking in the field reveals a drop-down list with all OV Players installed on networked PCs plus the currently defined Show <Default Player> and <Local Player>. When <Default Player> is selected nothing is shown in the box and the player used will depend on the parent choices. i.e. in the Show.

Timed Cue List Section
Timed Mode Chasing
Yes or No When Yes (enabled) the Cue List is fired in relation to the TimeCode source values. When No (disabled) events are fired in relation to Show elapsed time. Timed Mode Start Time introduces an offset.

Timed Mode TC Chase Source
When Timed Mode Chase is enabled sets the TC source to be chased. Options in the drop-down list are Show Time or any available TC input.

Timed Mode Chase Mode
Two modes are available in the drop-down list.
Cue Fire then Freewheel: TimeCode is used to Fire the Cues, then the Cues run independently. Backwards TimeCode or stopping TimeCode stops the Cue.
Cue follow TimeCode: Cues follow TimeCode. This mode is useful in rehearsal. Some advanced configuration options are available in Windows Registry to customize behavior. Contact: support@merging.com

For more details.

Timed Mode Chase Stop Counter
Number of frames of non-increasing TimeCode Before Cue playback Stops.

Timed Mode Chase Run Counter
Number of frames of increasing TC before starting playback and discriminating TC stops or jumps. (Default: 5 frames).

Timed Mode Chase Jump Counter Threshold
Number of frames above Jump Threshold (below) to be considered as a TC jump. (Default: 5 frames).

Timed Mode Chase Jump Threshold
Minimum duration for drop in TC to be considered as a jump (to discriminate signal quality issue vs TC jump). (Default: 1000 milliseconds).

Timed Mode Start Time
Offsets the Cue List start time values. Only available when Timed Mode Chasing is not enabled.

Timed Mode Pauses Cues
Determines the Cues behavior if the Cue List is Paused (manually).

Timed Mode Stops Cues
Determines the Cues behavior if the Cue List is Stopped (manually or if no further TC is received). Not applicable when Timed Mode Chase Mode is set to Cue follow TimeCode.

Timed Mode Stop Fade Out
Clicking in the field accesses a drop-down list with fade times from 0ms to 20s plus <default>. If the value is set to <Default> then the Cue Stop Fade value is used when a Cue is Stopped (interrupted).

Timed Mode Stop Fade In
Clicking in the field accesses a drop-down list with fade times from 0ms to 20s plus <default>. If the value is set to <Default> then the Cue Stop Fade value is used when a Cue is Stopped (interrupted).

TimeCode Generator Section
The Cue List TimeCode can be output to any available TimeCode Output Port. This can be a MIDI MTC port enabled in Settings > Application Settings > Player Units > MIDI.

TC Gen Output Port
Currently selected Output Port is shown. The drop-down list shows all available TC outputs. This can be a MIDI MTC port.

TC Gen Pause Mode
Off
TC output ceases when the Cue List is paused.
**Freeze**  
TC freezes at current value when Cue List is paused

**Free Roll**  
TC continues to run when Cue List is paused

**TC Gen Stop Mode**  
The drop-down list offers a choice of:

- **Off**  
TC output ceases when the Cue List is paused
- **Freeze**  
TC continues to generate current value when Cue List is paused
- **Free Roll**  
TC continues to generate and increment value when Cue List is paused

**TC Gen Goto on Ready**  
Yes or No. If Yes (enabled) the Start Time is generated continuously on the output port when the Cue is made Ready, to allow a Slave device to commence locating to the Start Time in advance of the Cue being fired.

**Hot Keys Section**

**Hot Keys number of Columns**  
Clicking in the field drops down a list with the choices of Auto (default) or 1 - 8.

**Note:** When the Number of Columns is set to Auto then the system automatically adjusts the number of columns, but still follows the Automatic Cues Numbering setting and leaves empty slots if necessary.

**Hot Keys Column to Audio Slot Mapping**

- If set to No all Cues are played back in the Audio Output Slot defined in their Cue Properties.
- If set to a number (1, 2, etc…) then the Cues are played back in an Audio Slot corresponding to the Hot Keys Column. In this way Hot Keys Cues can be assigned to Audio Output by the Column in which they are placed.

**Note:** In this mode the actual Audio Output Slot(s) is computed as Cue Column Number multiplied by the Hot Keys Column to Audio Slot Mapping. This allows handling Mono (1), Stereo (2), Surround (6), etc… Cues.

The order of precedence is:

- The **Cue List** Audio Output Slot is used first if not set to <Use Cue Slot>
- The **Hot Keys Column to Audio Slot Mapping** is then used if not set to “No”
- The **Cue** individual Audio Output Slot is then used if none of the above applies.

**Custom Keys Section**

**Custom Keys Grid Size**  
Click in the field to reveal the down arrow. You can either pick a value from the drop-down menu or type directly in the left-hand side of the field.

**Note:** The **Timed Cue List** and **TimeCode Generator** sections are collapsed and fields are greyed out for non Timed Cue Lists and the **Custom Keys** section is collapsed and fields grayed out for non Custom Keys Cue Lists.
Audio Section

Audio Output Slot

Click in the field to reveal the down arrow. You can either pick a value from the drop-down menu or type directly in the left-hand side of the field.

Note: This setting applies to every Cue in the list. This value takes precedence over the individual Cue Output Slot, if set, for the Cue list. The default value is <use Cue Slot>.
### Cue Properties Pane

#### Cue

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>Name</td>
<td>Steampasses</td>
</tr>
<tr>
<td>Comments</td>
<td></td>
</tr>
<tr>
<td>Pinned to Active Cue Window</td>
<td>Yes</td>
</tr>
<tr>
<td>Length</td>
<td>00:00:16:921</td>
</tr>
<tr>
<td>Rehearsal Preset</td>
<td>00:00:17:972 (Preset 3)</td>
</tr>
<tr>
<td>Fade In</td>
<td>3.4 [s]</td>
</tr>
<tr>
<td>Fade In Curve</td>
<td>Linear</td>
</tr>
<tr>
<td>Fade Out</td>
<td>0 [ms]</td>
</tr>
<tr>
<td>Fade Out Curve</td>
<td>Linear</td>
</tr>
<tr>
<td>Stop Fade Out</td>
<td>&lt;Default&gt;</td>
</tr>
<tr>
<td>Interaction Rules</td>
<td></td>
</tr>
<tr>
<td>Ignore Parent Rules</td>
<td>No</td>
</tr>
<tr>
<td>Fire at Show Start</td>
<td>No</td>
</tr>
<tr>
<td>Output Player</td>
<td></td>
</tr>
</tbody>
</table>

#### Markers

- None listed

#### Hot Key

- None listed

#### Audio

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offset</td>
<td>+00:00:08:118</td>
</tr>
<tr>
<td>Gain</td>
<td>-6.00 dB</td>
</tr>
<tr>
<td>Audio Output Slot</td>
<td>1</td>
</tr>
<tr>
<td>Audio Media</td>
<td>H:\Source Audio\Merging from Dark Materials\Wav files imported from old machine\Sound Effects\steampasses-5536-40D5-A817-D2F6F4388CC6).pmf</td>
</tr>
<tr>
<td>Sampling Rate</td>
<td>44100 Hz</td>
</tr>
</tbody>
</table>

#### Microphone / Input Switch

- None listed

#### TimeCode Generator

- None listed

#### MMC

- None listed

#### MIDI Command

- None listed

#### Sony P2 / RS422

- None listed

#### COM Command

- None listed

#### IP Command

- None listed

#### HTTP Command

- None listed

#### GPO

- None listed

#### Shell Command / Script / Batch

- None listed

#### Mixer Automation

- None listed

#### On-Air

- None listed

#### REMOTE CONTROL: General MIDI Command

- None listed

#### REMOTE CONTROL: IP Command

- None listed

#### REMOTE CONTROL: Multi-Sequencer Synchronization

- None listed

#### REMOTE CONTROL: Dataton Synchronization

- None listed
Cue Section

Number
Number of the currently selected Cue. (Information only)

Name
Name (can be changed here)

Comments
Free text field where you can add comments to the Cue List

Pinned to Active Cue Window
When set to Yes (default) the Cue will be displayed in the Active Cue Window when playing in Show Mode with the Pinned button active.

Length
Length of Cue is shown and can be defined here.

Rehearsal Preset
The drop-down gives options to:

- Recall Preset 1
- Recall Preset 2
- Recall Preset 3
- Recall Preset 4
- Set Preset 1
- Set Preset 2
- Set Preset 3
- Set Preset 4
- Clear Presets

For detailed information please see: Rehearsal Preset Points on page 85

Fade In
Clicking in the field accesses a drop-down list with fade times from 0ms to 20s

Fade In Curve
Clicking in the field accesses a drop-down list with a choice of fade characteristics.

- Power
- Linear
- dB
- Cosine
- Root-Cosine

Fade Out
Clicking in the field accesses a drop-down list with fade times from 0ms to 20s

Fade Out Curve
Clicking in the field accesses a drop-down list with a choice of fade characteristics.

- Power
- Linear
- dB
- Cosine
- Root-Cosine

Interaction Rules
Field contains a list of all Interaction Rules defined for the current Cue List. Note: Rules shown in this field are all in force at the same time.

Clicking in the field reveals a button which leads to the Interaction Rules dialog.

Ignore Parent Rules
Determines whether child (nested) Cues follow the rules defined for the parent.

Clicking in the field reveals a Drop-down list with a choice of Yes or No.

Fire at Show Start
Clicking in the field offers the choice of Yes or No. When set to Yes Cue Fires when the Show Starts.

Output Player
Shows the currently defined OV Player for this Cue. Clicking in the field reveals a drop-down list with all OV Players installed on networked PCs plus the currently defined Show <Default Player> and <Local Player> When <Default Player> is selected nothing is shown in the box and the player used will depend on the parent choices. I.e. in the Cue List or Show.
Markers Section

Clicking in the **Selected Marker: x** field or on the down arrow drops-down the Marker Menu.

- **Add Marker**
  - Adds a new Marker at the current Audition Cursor position. **Note:** Subsequent existing Markers will be renumbered.

- **Remove Selected Marker**
  - The selected Marker is deleted. **Note:** Subsequent Markers will be renumbered.

- **Marker Name**
  - Click in the field and type to add a Name to the Marker. This name will be shown in the **Active Cue** window Timeline.

- **Select Marker 1**
  - Selects Marker 1.

- **Select Marker 2**
  - Every marker added will show up here and a **Select Marker x** entry.

**Marker Offset**

Shows the **Marker Offset** from the beginning of the Cue. (Does not include any Start (Preroll) Offset applied to the Cue.) Clicking in the field enables a new value to be typed. Clicking the down arrow drops-down a list with the option of **Reset**. This resets the Marker position to the current Audition Cursor position in the **Active Cue** Window Timeline. (A negative offset is shown if the Cursor position is before the start of the Cue.)

**Marker Interaction Rules**

Shows a list of all **Interaction Rules** applied to the Selected Marker. Clicking in the field shows a *...* button. Clicking on this opens the **Marker Interaction Rules** dialog. Please see below.

Timed Cue Section

Cue Fire Time shown and can be defined here or set to **Manual**. Only applies to Cues in Timed Cue Lists.

**Go Time**

**Note:** The **Timed Cue** section is collapsed and **Go Time** field is greyed out in non Timed Lists.
Hot Key Section

Only applicable to **Hot Key** and **Custom Key** Cue Lists. Shows current **Hot key Mode** for the selected Cue. Clicking in the field reveals a Drop-down list with a choice of Hot Key behaviors.

**Hotkey Mode**

- Play from Start
- Toggle Play / Stop
- Toggle Play / Pause
- Press Play / Pause
- Press Play / Release Stop
- Press Play / Release Pause

Custom Key Section

**Note:** The **Custom Color** field in the **Custom Key Section** is also available for **Hotkeys**, however the **Custom Font** and **Custom Font Color** fields are not.

In a **Standard** or **Timed** Cuelist **Custom Color** affects the label background only and **Custom Font** is also available.

- **Custom Color**
  
  Click in the field to reveal the ... and drop-down arrow buttons. Clicking on ... opens a standard Color Picker. The drop-down accesses the default.

- **Custom Font**
  
  Click in the field to reveal the ... button. Clicking on this opens a standard Font dialog with a list of all installed fonts. You can also choose the font style and size. The drop-down accesses the default.

- **Custom Font Color**
  
  Click in the field to reveal the ... button. Clicking on this opens a standard Color Picker. The drop-down accesses the default.
Audio Section

Offset
- Determines the starting point of the Cue within the Media File. Offsets must be positive only.

Gain
- Clicking in the field enables values to be typed directly. The value entered here determines the gain offset the Cue will be played with. Negative values attenuate, positive amplify. Clicking on the down arrow accesses a drop-down list of Gain values. Clicking on the ... button opens the Cue Gain fader dialog. Please see: Cue Gain on page 125

Audio Output Slot
- Shows the Output Slot number. Clicking in the field enables a new number to be typed. Please see: Audio Output Slots on page 128

Audio Media
- Shows the full path to the Audio Media of the Cue whether single file or Multiple Files. When the right-hand down arrow is clicked a drop-down list appears with the choice of Replace and Remove the current Audio Media Files.

Sampling Rate
- Information only - shows the Cue sampling rate.

Note: The Length and Audio Offset fields in the Cue Properties have a Reset option accessed by clicking on the button on the right side of the field. The Go Time field in Cue Properties has a Manual option accessed by clicking on the button on the right side of the field to reset it to Manual Fire.

Note: Cue > Link Offsets/StartTimes and the Link Offsets/StartTimes icon in the Active Cue pane Links all Audio, TCGen, MMC and 9-pin (Sony P2) Offsets and Start Times in a Cue with these properties. The button toggles on/off and it’s state is not saved when a different Cue is Active. When enabled all related fields in the Cue Properties pane turn red for clarity.

Microphone Switch Section
- This section allows a range of Mixing Console Inputs to be defined. All Inputs in the range will be switched to Input when the Cue is Fired and returned to Repro when the Cue ends.

First Mic / Input Slot
- Click in the field and type the number of the first Mic Input Slot to be switched automatically.

Last Mic / Input Slot
- Click in the field and type in the number of the last Mic Input to be switched automatically.
TimeCode Generator Section
The Cue TimeCode can be output to any available TimeCode Output Port. This can be a MIDI MTC port enabled in Settings > Application Settings > Player Units > MIDI.

**TC Gen Output Port**
Currently selected Output Port is shown. The drop-down list shows all available TC outputs. This can be a MIDI MTC port.

**TC Gen Start Time**
The First TimeCode value that will be output when the Cue is Fired.

**TC Gen Pause Mode**
The drop-down list offers a choice of:
- **Off**: TC output ceases when the Cue is paused
- **Freeze**: TC freezes at current value when Cue is paused
- **Free Roll**: TC continues to run when Cue is paused

**TC Gen Stop Mode**
The drop-down list offers a choice of:
- **Off**: TC output ceases when the Cue is paused
- **Freeze**: TC continues to generate current value when Cue is paused
- **Free Roll**: TC continues to generate and increment value when Cue is paused

**TC Gen Goto on Ready**
*Yes* or *No*. If *Yes* (enabled) the Start Time is generated continuously on the output port when the Cue is made Ready, to allow a Slave device to commence locating to the Start Time in advance of the Cue being fired.

**Note:** The TimeCode Generator section is collapsed and fields are greyed out for non timed Cues.

MMC Section

**MMC Output Port**
Clicking in the field reveals a down arrow to access a drop-down list of all available MIDI ports

**MMC Start Time**
When a valid output port is selected in the previous field a start time may be entered here.

**Note:** When the Cue is fired, an MMC Play command is sent; when the Cue is paused, a MMC Pause command is sent; when the Cue is stopped a MMC Stop command is sent.

MIDI Command Section

**MID Command Output Port**
Clicking in the field reveals a down arrow to access a drop-down list of all available MIDI ports

**MIDI Fire Command**
Click in the field to reveal the ... box. Click on this to open the Edit MIDI Command dialog.

**MIDI Pause Command**
Click in the field to reveal the ... box. Click on this to open the Edit MIDI Command dialog.

**MIDI Stop Command**
Click in the field to reveal the ... box. Click on this to open the Edit MIDI Command dialog.
Examples of the Edit MIDI Command Dialog

- Available predefined General Midi Commands drop-down list

- An example of a MSC Sysex (Go command of the Cue 235.6, Cue list 36.6, path 59)

- An example of a General Midi command
Note: when you use the Custom Midi Message edit line, the drop-down menus above are updated if the message is recognized.

Sony P2 / RS422 Section
Sony P2 / RS422 COM Port  Shows the current Com Port or None. The drop down shows a list of all Com ports.
Sony P2 / RS422 Start Time
   Note: When the Cue is fired, a P2 Play command is sent; when the Cue is paused, a P2 Jog [0] command is sent; when the Cue is stopped a P2 Stop command is sent.

Please see also: Sony P2 over IP on page 163

COM Command Section
COM Command Output Port  Shows the current Com Port or None. The drop down shows a list of all Com ports.
Command Format  Click in the field to drop-down the choice of Hexadecimal or ASCII.
COM Fire Command  Click in the field to type a command.
COM Pause Command  Click in the field to type a command.
COM Stop Command  Click in the field to type a command.
   Note: COM Commands can be used to control suitably equipped external devices via serial control. For example you could send a POWER ON command to fire up a projector, or you could send a command line like Command=Cue_Fire &CueList=2 &Cue=1. Each device manufacturer should provide a list of available commands.

IP / OSC Command Section
IP Command Output Port  Shows the current IP Port or None. The drop down shows a list of all available IP ports.
Command Format  Click in the field to drop-down the choice of Hexadecimal, ASCII or OSC.
IP Fire Command  Click in the field to type a command.
IP Pause Command  Click in the field to type a command.
IP Stop Command  Click in the field to type a command.
   Note: IP Commands can be used to control suitably equipped external devices via ethernet. For example you could send a POWER ON command to fire up a projector. Each device manufacturer should provide a list of available commands.

HTTP Command Section
HTTP Address  A valid IP address or Host Name.
HTTP Port  A valid IP Port number.
HTTP Fire Command  A Command that will be sent to the above IP address and Port when the cue fires
HTTP Pause Command  A Command that will be sent to the above IP address and Port when the cue pauses.
HTTP Stop Command  A Command that will be sent to the above IP address and Port when the cue ends or stops.
### GPO Section

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPO Output Port</td>
<td>GPO 1</td>
</tr>
<tr>
<td>GPO Output Pin</td>
<td>6</td>
</tr>
<tr>
<td>GPO Ready State</td>
<td>Down</td>
</tr>
<tr>
<td>GPO Fire State</td>
<td>Up</td>
</tr>
<tr>
<td>GPO Pause State</td>
<td>Down</td>
</tr>
<tr>
<td>GPO Stop State</td>
<td>Down</td>
</tr>
<tr>
<td>GPO Duration</td>
<td>50 ms</td>
</tr>
</tbody>
</table>

**Note:** Up and Down means:
- **Up** the circuit between Common and the Pin# is closed
- **Down** the circuit between Common and the Pin# is open

### Shell Command / Script / Batch Section

- Fire Command
- Fire Command Parameters
- Fire Command Default Directory
- Pause Command
- Pause Command Parameters
- Pause Command Default Directory
- Stop Command
- Stop Command Parameters
- Stop Command Default Directory
A Shell Command requires three parameters:

- The Application name or command (acrobat.exe, myscript.bat, etc…)
- The Parameters modifying this command (optional) (-filename, -load, -verbose, etc… or whatever required by the command itself)
- The Default Directory (optional) (some commands or applications need to run from a given folder where required files are present)

**Note:** There is a separate set of parameters for each Fire, Pause and Stop event.

**Mixer Automation**

**Type**

Please see: **Snapshot Automation** on page 52 and **Dynamic Automation** on page 54 for details.

The field shows **Console Automation** when dynamic automation is present and offers the choice of **<None>** or **<Console Snapshot>**.

**Note:** Selecting **<None>** or **<Console Snapshot>** when dynamic automation is present will erase the dynamic automation.

**Glide**

Click in the field to drop-down a list of choices.

Type a time value in the field to set a specific glide length.

**Instant**

**Cue Length**

**REMOTE CONTROL: General MIDI Command**

**MIDI Command Input Port**

Click in the field to drop-down a list of available ports.

**Fire Command**

Click in the field to reveal the down arrow.

**Pause Command**

Click in the field to reveal the down arrow.

**Stop Command**

Click in the field to reveal the down arrow.

For each of the commands clicking on the down arrow opens the **MIDI Command Learn** dialog. Clicking on the down arrow offers the choice of **<None>** or **<Clear last incoming messages>** or a list of the last 10 commands.
received on the port specified, enabling the required command to be selected. <None> removes the existing mapping and <Clear last incoming messages> clears the command list.

**Note:** Before attempting remote control of Cues in this way check the Controller Settings in Settings > Application Settings > Controller Units > MIDI.

In order for direct MIDI Command mapping to work for the given physical or logical MIDI port the option **Enable direct Cue mapping of MIDI messages from the selected Virtual MIDI Port** in the General Midi (GM) section must be checked. Commands coming from the given physical or logical MIDI Port will be seen in the MIDI Command Learn dialog as coming from the selected Virtual MIDI Port at the top of the MIDI settings page. This enables the physical MIDI port to be changed easily without having to redo the entire mapping.

**Note:** A useful possibility is to be able to map **Note On** to the **Fire** Command and **Note Off** to the **Stop** Command to emulate the Hot Keys Press Play/Release Stop mode.

**REMOTE CONTROL : IP / OSC Command**

![REMOTE CONTROL: IP / OSC Command section - Cue Properties Pane](image)

**IP Command Input Port** Click in the field to drop-down a list of available ports.

**Command Format** Click in the field to drop-down the choice of Hexadecimal, ASCII or OSC.

**Fire Command** Click in the field to reveal the down arrow.

**Pause Command** Click in the field to reveal the down arrow.

**Stop Command** Click in the field to reveal the down arrow.

For each of the commands clicking on the down arrow opens the IP Control Fire/Pause/Stop Learn dialog. Clicking on the down arrow offers the choice of <None>, <Clear last incoming message> or a list of the last 10 commands received on the port specified, enabling the required command to be selected. <None> removes the existing mapping and <Clear last incoming messages> clears the command list.

**Note:** OSC remote control commands for Cues must begin with /CueMapping/

**Note:** Before attempting remote control of Cues in this way check the Controller Settings in Settings > Application Settings > Controller Units > IP.
REMOTE CONTROL: Multi-Sequencer Synchronization

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronization Mode</td>
<td>Click in the field for the choice of <strong>Master</strong>, <strong>Slave</strong> or <strong>Off</strong>.</td>
</tr>
<tr>
<td>Synchronization Token</td>
<td>Ovation generates the Synchronization Token automatically from the Cue Name</td>
</tr>
<tr>
<td></td>
<td>and CueList Name, Master and Slave Tokens MUST match. (case sensitive).</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If for some reason automatic Token generation is unsuitable. E.g. because</td>
</tr>
<tr>
<td></td>
<td>the Cue on the Master Ovation is named <strong>Bach</strong> and the Cue on the Slave is</td>
</tr>
<tr>
<td></td>
<td>named <strong>Bach back</strong> then a Token value may be typed in the field. (The same</td>
</tr>
<tr>
<td></td>
<td>Token Value MUST be used on Master and Slave Ovations.</td>
</tr>
<tr>
<td>Resynchronize Drifts/Jumps</td>
<td>Determines whether or not re-synchronization will take place when a sync</td>
</tr>
<tr>
<td></td>
<td>drift or jump is detected. The drop-down list offer the choice of <strong>Yes</strong></td>
</tr>
<tr>
<td></td>
<td>or <strong>No</strong>.</td>
</tr>
<tr>
<td>Synchronize Pause</td>
<td>Click in the field for the choice of <strong>Yes</strong> or <strong>No</strong>. When set to <strong>Yes</strong></td>
</tr>
<tr>
<td></td>
<td>if the Master Cue is Paused the Slave Cue also Pauses.</td>
</tr>
<tr>
<td>Synchronize Stop</td>
<td>Click in the field for the choice of <strong>Yes</strong> or <strong>No</strong>. When set to <strong>Yes</strong></td>
</tr>
<tr>
<td></td>
<td>if the Master Cue is Stopped the Slave Cue also Stops.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Before attempting to synchronize Cues in this way an IP connection must be</td>
</tr>
<tr>
<td></td>
<td>established between the Master and Slave machines in <strong>Settings &gt; Application Settings &gt; General &gt; TCP/IP Connections</strong> and Multi-Sequencer Synchronization must be switched on and configured as Master or Slave in <strong>Show Properties</strong>.</td>
</tr>
</tbody>
</table>

**Please see: IP Connections on page 158**
REMOTE CONTROL: Dataton Synchronization

Synchronization IP Port  Click in the field to drop-down a list of available ports. The Port selected MUST be the port associated with the target machine running the Dataton video player.

Synchronization Token  The name typed here determines which Dataton Timeline is linked to the Cue.

Note: If for some reason automatic Token generation is unsuitable, e.g. because the Cue on the Master Ovation is named **Score** and the Timeline on the remote Dataton is named **Movie** then a Token value may be typed in the field. (The Token Value MUST match the name of the Dataton Timeline you wish to synchronize.)

Resynchronize Drifts/Jumps  Determines whether or not re-synchronization will take place when a sync drift or jump is detected. The drop-down list offer the choice of **Yes** or **No**.

Synchronize Pause  Click in the field for the choice of **Yes** or **No**. When set to **Yes** if the Master Cue is Paused the Slave Dataton Timeline also Pauses.

Synchronize Stop  Click in the field for the choice of **Yes** or **No**. When set to **Yes** if the Master Cue is Stopped the Slave Dataton also Stops.

Note: Before attempting to synchronize Cues in this way an IP connection must be established between the Master Ovation and Slave Dataton machines in **Settings > Application Settings > General > TCP/IP Connections**.

Please see: **IP Connections** on page 158
Interaction Rules

Overview
Interaction Rules are one of the most powerful features of Ovation.

Interaction rules affect what happens to other Cues and Cue Lists when a Cue is Fired or Stopped. All selected Rules apply together so it is possible to arrive at a situation where nothing will play at all!

Rules set in **Show Properties** are global. I.e. they apply to every Cue List and Every Cue unless overridden by Rules set in **Cue List Properties** or **Cue Properties**.

Rules set in **Cue List Properties** apply to all Cues in the Cue List unless they are overridden by Rules set in **Cue Properties**.

Rules include an optional offset

Rules can be conditional. A rule can be triggered based on the state of another Cue (Fired, Paused or Stopped).

A Cue can fire itself through a Rule. This is how to make a Cue Loop.

When an Interaction Rule points to a Cue List as Target, then:

- If the Cue List is a Timed Cue List, then the Cue List Time is Started, Paused or Stopped (equivalent to the Cue List Start, Pause or Stop buttons).
- If the Cue List is **NOT** a Timed Cue List then the **FIRST** Cue in the list is Fired, or **ALL** Cues are Paused, Stopped or Dimmed.

Adding Rules

There are several ways of adding rules. You can use **Cue > Add rule** or the right-click context menu to add simple rules to a Cue directly. For more complex compound interactive rules the **Interaction Rules** dialog is used.

Adding Simple Rules
Select a Cue and either go to **Cue > Add Rule** or right-click on a Cue and go to **Add > Rule** in the context menu.

The list of available Rules is the same whichever method you choose:

- **Fire Next Cue when Ending**
- **Fire Next Cue when Stopping**
- **Fire All Child Cues when Stopping**
- **Stop Previous Cue when Starting**
- **Stop All Cues in Cue List when Starting**
- **Loop (Fires Itself when Ending)**
- **Loop between Markers (Fire Itself between Markers)**
- **Dim All Cues when Starting**
- **Select Next Cue when Starting**

**Note:** Choosing **Loop between Markers** creates two new Markers one at the beginning and end of the Cue. The Markers can be moved subsequently.
Opening the Interaction Rules Dialog
Clicking in an Interaction Rules field in a Properties pane and clicking on the ... button opens the Interaction Rules dialog. When rules are already set double-clicking on the icon(s) in the Cue in the Cue List also opens the dialog.

The dialog enables Interaction Rules to be Added, Modified or Removed from the active list.

Interaction Rules applied at the Show level affect all Cue Lists and Cues. These are overridden by Rules applied to a List and these in turn are overridden by Rules applied to individual Cues. However, some rules will affect Cues regardless. E.g. If an individual Cue is set to Stop All Cues at Start then all Cues in all Cue Lists playing when it is Fired will Stop. Subsequent Cues in Timed Lists will Fire as expected.

The options available under each of the drop-down lists will vary depending on the choices already made and other rules in force.

Adding a Rule
Make choices using the drop-down lists and click on Add Rule >>

Removing a Rule
Click on the Rule you wish to remove in the list to highlight it and click on Remove Rule <<

Update a Rule
Click on the Rule you wish to update in the list to highlight it. Its parameters will be reflected in the controls. Change parameters as required and click on Update Rule VV to accept the changes.

Change Order of Rules
Click on the Rule you wish to re-order and click on the Move Rule Up or Move Rule Down buttons to change the Rule order.

Rules Form
Interaction Rules take the form:

Stop / Pause / Dim / Fire / Select the:
Properties Panes : Interaction Rules

Next Cue
Next Sibling Cue
Previous Cue
Previous Sibling Cue
a Specific Cue or Group of Cues
Cue List or
Itself

When or After the selected Cue(s)

Starting
Ending or
Stopping

with a

Fade In
Fade Out and/or
Dim Gain applied if required and as determined by the other choices.

If After is selected then the ms box becomes active. Enter a value here to delay the rule's action after the triggering event has occurred.

For Stop the dialog presents Starting as the default choice.

For Fire the dialog presents Ending as the default choice.

For Pause and Dim the Start / Stop choice is grayed out since the only logical use is to Pause or Dim another Cue or Cues whilst the current one is playing.

Sibling means a Cue on the same level. Thus using e.g. Next Sibling bypasses any Child Cues.

Note: Rules which act when a Cue is started occur at the Start time. Rules which act when a Cue Ends or Stops occur at the START of the Fade out. This produces a cross-fade. If you require a fade out but do not want the next action to occur until the End of the Cue then simply use the After rule with an delay equivalent to the fade out length.

at Marker
Only valid when first action is set to Fire. If the Cue has a Marker or Markers set then the Cue will be be Fired at the Marker number in the at Marker field.

Loops
To produce a loop simply use the form, Fire : Itself : When : Ending. More complex loops within a Cue can be achieved using Markers. Please see: Markers Interaction Rules on page 89

Cue List Target
When an Interaction Rules points to a Cue List as Target, then two additional options are available:

First Cue / Timed Cue List Timer
• If the Cue List is a Timed Cue List, then the Cue List Time is Started, Paused or Stopped (equivalent to the Cue List Start, Pause or Stop buttons). Timed Cue Lists run their internal timer when started.
• If the Cue List is NOT a Timed Cue List then the FIRST Cue in the list is Fired, or ALL Cues are Paused, Stopped or Dimmed.

Selected Cue
Standard and Timed Cue Lists run the currently Selected Cue. Timed Cue Lists will NOT run their internal timer.
Conditional Rules
If the Only if box is checked then a further layer of control comes into play. A rule set up using the controls described above will only apply when the conditions are met. I.e when the item chosen in the drop down list from a choice of Next Cue, Previous Cue a Specific Cue or Group of Cues or a Timed Cue List - is either Fired, Paused or Stopped as selected via the radio buttons.

Interaction Rules is an extremely powerful tool and experimentation is strongly encouraged!

Rules Icons
When Interaction Rules are applied an Icon or Icons is/are shown in the Cue in the Cue List.

- When present there is a Rule or Rules applied in Cue Properties.
- When present there is a Rule or Rules applied in Cue List Properties
- When present there is a Rule or Rules applied in Show Properties
- When present there is a Rule or Rules applied to a Marker in the Cue

Double clicking the Cue Properties, Cue List or Show Icons opens the Interaction Rules dialog.
Show Validation Tool

Show Validator

The Show Validation Tool is available via **Show > Show Validator**.

It enables the following aspects of the Show to be validated:

- Interaction Rules validity. For instance, Rules pointing to a non existing Cue or Cue List.
- Offline Clips Players
- Invalid Audio Output Slots

More checks will be added in subsequent versions.

**Note:** Double-clicking on reported errors in the Validation Tool pane selects the incriminated Cue or Cue List.
Show Consolidation and Packaging

**Show Consolidation** collects all Audio, MIDI and other files associated with and referenced by a Show and copies them to the Audio Files folder in the same location as the Show file. The Show file is modified to point to the new file locations of the copied files. The Show remains active in the Ovation Sequencer for further editing.

**Show Packaging** collects all Audio, MIDI and other files associated with and referenced by a Show and copies them to a new Audio Files folder created automatically in the packing location selected along with copy of the Show file. At the end of the process the option of Show Validation is offered to verify that all is well with the packaged version. The resultant packaged Show file is modified to point to the new file locations of the copied files. The original Show is not affected by the process and, when Consolidation is complete the original Show remains active in the Ovation Sequencer.

The Consolidation Process

To initiate the Packaging Process choose **Show > Consolidate Show** to open the **Consolidate Show** dialog:

![Consolidate Show Dialog](image1)

The options are self-explanatory.

If you are happy to continue click on **Yes** to initiate the process.

![Consolidating Cues Dialog](image2)
The process begins and the **Consolidating Cues** dialog appears. Click on **Cancel** to abort the process otherwise an info box appears when the process is complete.

![Consolidate Cues Info Box](image)

### The Packaging Process

To initiate the Packaging Process choose **Show > Package Show** to open the **Package Show** dialog:

![Package Show Dialog](image)

The options are self-explanatory.
If you are happy to continue click on **Yes** to continue the process by opening the Package Show **Browse For Folder** dialog.

Navigate to a suitable existing folder or to a suitable location to create a new one. When you have opened the destination folder (or created it) click on **OK** to initiate the process.

A dialog will show details of progress:

![Package Show Browser](image)

![Package Show Progress Dialog](image)
And a further dialog will show progress of copying individual files.

![Copying Files Dialog]

When the process completes you will be invited to validate the new Show:

![Package Show Validation Dialog]

We suggest you accept the option. The result will be displayed at the end of the process.

**Recursive Packaging**

The Packaging process can be incremental. I.e. the process can be called many times one after another and only newly referenced files will be copied to the Packaged location.

**Backup/Archive**

The **Package Show** function offers a simple method of backing-up/archiving a Show to a different location.
Audio Control Pane

The **Audio Control** pane is accessed from the **Show** Toolbar, the **Show** menu or the **View** menu. It controls attenuation of the right-most Bus fader from the 0dB position on the Ovation Mixer. It is only active when it is open and a Show is running or a Cue is being Auditioned.

Controls are chunky to facilitate Touch Screen operation.

The top Slider button increases level in 2dB per click increments from -146dB to -40dB and 1dB increments from -40dB to a maximum of 0dB.

The slider can be clicked and dragged. The degree of attenuation is shown numerically on the Slider knob. Double-clicking the knob restores the default, 0dB value.

The bottom Slider button decreases level in 1dB per click increments down to -40dB and 2dB per click increments down to -146dB.

The bottom button **MUTE**s the Ovation mixer Main Output.

The **Audio Control** pane retains its current settings when closed and opened (and from load / unload of the application) however, the output is only updated with its values when the **Audio Control** pane is open.
Cue Gain

Cue Gain Control

**Cue Gain** sets the overall Cue Level in real time.

The **Cue Gain** dialog is accessed from the **Cue List Edit** Toolbar, **Change Cue Gain** in the **Cue** menu and in the right-click Cue context menu.

The box shows the amount of boost or cut applied in dB. You can click in the box and type a numeric value.

The Slider can be clicked and dragged to set the Cue Gain.

Click **OK** to accept changes and exit the dialog

Click **Cancel** to reject changes and exit the dialog

Changes made in the **Cue Gain** dialog are reflected in the **Cue Properties** pane.

**Note:** When a Clip is published to Ovation from Pyramix any Gain adjustments made with the Cue Gain Control are applied in addition to gain adjustments applied to the Clip in Pyramix.
TimeCode Reader Panes

TimeCode Reader panes enable the current values of any of the available TimeCode Sources and Generator Ports to be displayed. View > View TimeCode Reader opens a new TimeCode Reader pane.

When first opened a TimeCode Reader pane has no source selected and is colored white. Up to 20 panes may be open and active simultaneously. The pane(s) can be resized at will.

Right-clicking anywhere in the black area of the pane opens a context menu:

Hovering the cursor over TimeCode Sources: drops down a list of all available sources. None and Show Time are always present, other entries will depend on your specific hardware and driver configuration.
Hovering the cursor over **TimeCode Generator Ports**: drops down a list of all available outputs:

None is always present other entries will depend on your specific hardware and driver configuration.

Hovering over the third entry **Colors**: drops down a color picker:
Audio Output Slots

What is an Audio Output Slot?

Audio Output Slots are set in Cue Properties for individual Cues. An Audio Output Slot is nothing more than the audio channel count across the mixer from left to right. So, Strip one, Channel one is also Slot one. But Strip four Channel one could be one of several things depending on what type of Strips the mixer uses. In a mixer using all Mono Strips, Strip four Channel One is Slot four but in a mixer with all Stereo Strips it will be Slot eight. In a mixer using 5.1 GPS Strips Strip four Channel one will be Slot 19 and so on.

Multi-channel Cues

Multi-channel Cues are handled transparently with the channels present in the Cue mapped in ascending order from the Audio Slot Output specified in Cue Properties.

Audio Output Slots and Cue Lists

The Audio Output Slot can be set for an entire Cue list in the Audio Output Slot field in the Audio section of the Cue List Properties pane. The default is <Use Cue Slot> and in this case Cues will be played via the Audio Output Slots set in the Cue Properties pane.

Note: If a setting other than <Use Cue Slot> is used then this takes precedence over the Audio Output Settings in the Cue Properties pane.
Audio Gain Matrix

By default the Audio Gain Matrix for each Cue is Off. Under these conditions an Audio Cue will be played via the Mixer strip(s) determined by the Audio Output Slot settings. However, the Audio Gain Matrix is a very powerful tool when dealing with Cues. For example, it can correct incorrect channel order, imbalances or level discrepancies or, for example, downmix a 5.1 Cue for stereo playout.

The Audio Gain Matrix pane can be accessed by clicking in the Audio Gain Matrix field in the Audio section of the Cue Properties pane or by selecting Show > View Audio Gain Matrix.

The Audio Gain Matrix pane shows the selected Cue List and selected Cue it will affect.

Output Slot
The Output Slot drop-down list functions in exactly the same way as the field in the Cue Properties pane and any changes made here will be reflected in Cue Properties.

Cue Gain
The Cue Gain pot determines the overall gain of the Cue across all channels whether the Matrix is active or not. Any change to the value made with this control is reflected in the Audio Gain field in the Cue Properties pane.

As with the other rotary controls here and in the mixer a value can also be entered by clicking in the numeric box and typing.

Matrix Size
This value determines the number of Outputs from the Matrix and the number of vertical Output columns in the dialog. Matrix Size can be set to Off (as in the above screenshot) or to any sensible value. When the Matrix is Off the number of outputs is determined by the number of channels in the Cue. Off and 1-16 are available in the drop-down list. Type larger values manually, followed by Enter. These outputs are patched to the Ovation mixer slots in ascending order from the Slot Number set as the Output Slot.
Inputs

The number of Matrix Inputs and therefore the number of horizontal Input rows in the dialog is determined by the number of channels in the Cue.

Using both the Output Slot and the Matrix Size number enables you to focus first on an area of the mixer (Output Slot) and then determine how many strips in that area you wish to distribute the audio channels present in the Cue to.

For example, if you wish to mix a Cue into Strips 30, 31, 32, 33, 34 and 35 you would select Output Slot 30 and set the Matrix Size to 6:

By default only the same number of Output channels will be active as the number of input channels. The rotary controls set the overall Cue Gain and the individual gains for each of the channels present in the Cue.

The Output rotary controls set the overall level for each Output channel and the contribution per Output from each Input channel. Double-clicking a rotary control Mutes / deMutes.
Downmixing

Equally, the Audio Gain Matrix can be used to mix down a multi-channel Cue to Stereo or Mono:

Linking Parameters in the Audio Gain Matrix:
To make relative moves of several gains simultaneously, groups can be created.

Create a Gain Control Group
Press and hold SHIFT

- Click on individual gain controls to add them to a group.
- Click on members of a group to remove them from it.
- Click on an Output Gain knob to add the whole Matrix column to the group.
- Click on RESET to reset all the links (remove all from the group)
Independent Control of a Group Member

- Press and hold CTRL
- Manipulate a gain knob which is assigned to a group, without moving the rest of the group.

**Note:** Links are preserved when you click away from the Cue. Links are saved with the show, thus links are retained when you close and open the show.

Set Audio Gain Matrix For Multiple Cues

Audio Gain Matrix parameters can be set for multiple Cues or an entire Cue List in one operation. It only makes sense to do this if the Cues are in the same format.

- Select all the Cues in the Cue List
- Open the Audio Gain Matrix pane with **Show > View Audio Gain Matrix.**
- Make the settings required.

The new settings will be applied to all the selected Cues.
Ovation Files

File Types

Ovation files store Shows including Cue Lists and have an .ovs file extension.

Cue Lists can also be saved and loaded independently and have an .ovl file extension.

Settings are stored with a .pms file extension.

OVPlayer Sessions are stored with an .ovp file extension.

OVController Sessions are stored with an .ovc file extension.
New Show: Opens a new,Untitled Ovation Show.
Open Show: Opens the Open Windows File Browser to enable an existing Show to be loaded.
Save Show: Saves the current Show. If this is Untitled, opens the Save As file browser.
Save Show As: Opens the Save As file browser.
Save Show As Template: Saves the current Show as a Template for future shows.
Save Special: Enables Show to be saved in Ovation Version 3.x format for mixer compatibility or Ovation Version 7.0 format to enable Show to be opened in Version 7.0.
Close Show: Closes all open Cue Lists and the Show.
Recent Shows: Drops down a list of recently opened Shows.
Init Show: Initialize Show
### Ovation Menus: Cue List Page 135

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Show</strong></td>
<td>Start Show</td>
</tr>
<tr>
<td><strong>Pause Show</strong></td>
<td>Pause Show</td>
</tr>
<tr>
<td><strong>Stop Show</strong></td>
<td>Stop Show</td>
</tr>
<tr>
<td><strong>Consolidate Show</strong></td>
<td>Opens the Consolidate Show dialog. Please see: Show Consolidation and Packaging on page 120</td>
</tr>
<tr>
<td><strong>Package Show</strong></td>
<td></td>
</tr>
<tr>
<td><strong>View Show Properties...</strong></td>
<td>Opens the Show Properties Tab Pane</td>
</tr>
<tr>
<td><strong>View Show Validator...</strong></td>
<td>Opens the Show Validator Tab Pane</td>
</tr>
<tr>
<td><strong>View Show Log</strong></td>
<td>Opens the Log Tab Pane</td>
</tr>
<tr>
<td><strong>View Show Control Toolbar</strong></td>
<td>Toggles the Main Window Show Control Toolbar</td>
</tr>
<tr>
<td><strong>View Audition Toolbar</strong></td>
<td>Toggles the Main Window Audition Toolbar</td>
</tr>
<tr>
<td><strong>View Active Cue Window</strong></td>
<td>Toggles the Active Cue Window</td>
</tr>
<tr>
<td><strong>View Active Cue Window Edit Toolbar</strong></td>
<td>Toggles the Active Cue Window Toolbar (Only available when Active Cue Window is open.)</td>
</tr>
<tr>
<td><strong>View Audio Gain Matrix</strong></td>
<td>Toggles the Audio Gain Matrix Window</td>
</tr>
<tr>
<td><strong>View Audio Control Window</strong></td>
<td>Toggles the Audio Control Window</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Quits the Ovation application</td>
</tr>
</tbody>
</table>

### Cue List

#### Ovation Cue List Menu

- **New Cue List**: Drops Down the List of Cue Lists
- **Standard Cue List**: Opens a new,Untitled, **Standard** Cue List
- **Timed Cue List**: Opens a new,Untitled, **Timed** Cue List
- **Hot Keys**: Opens a new,Untitled, **Hot Keys** Cue List
**Custom Keys List** Opens a new,Untitled,**Custom Keys** Cue List

**Cue Browser** Opens a new,Untitled,**Cue Browser** Cue List

**Hot Browser** Opens a new,Untitled,**Hot Browser** Cue List

**Open Cue List** Opens the **Open** Windows File Browser to enable an existing **Cue List** to be loaded

**Save Cue List As**  Saves the currently selected **Cue List**. If this is Untitled, opens the **Save As** file browser

**Close...**  Opens the **Close Cue List** dialog

**Note:** If a Cue List is Closed without saving it separately it will be lost.

**Fire & Start** Acts on Timed Lists when selected. Fires the Selected Cue and starts the Cue List Counter running from the Go Time of the Cue. Selects and Readies next Cue for Firing.

**Start** Acts on Timed Lists when selected. Starts the Timed List from zero.

**Pause** Pauses the Timed List. List will restart from the point at which it was Paused.

**Stop/Reset** Stops the Timed List. List is reset to the beginning and made ready for Firing.

**Chase** When a Timed List is Selected engages/disengages **Chase Mode**

**Toggle/Select**

**Cue List** *(Tab)* Steps the selection through all open Cue Lists in ascending numerical order.

**Toggle Select**

**Hot Key list** *(Ctrl+Tab)* Toggles the selected Cue List between the available **Hot Key** lists. *(Note: Hot Key Display is only visible when the Show is Initialized)*

**View Cue List Properties...** Opens or selects the **Cue List Properties** pane for the currently selected Cue List

**View Fire Toolbar** Toggles the Fire Toolbar Shown / Hidden

**View Edit Toolbar** Toggles the Edit Toolbar Shown / Hidden

**Hot/Custom Keys** Only available when a Custom Keys list is selected

**Hot/Custom Keys Design Mode** When ticked the selected Hot/Custom Keys pane is shown in **Design Mode**

**Snap all Keys on Grid** Snaps all the Keys into alignment with the current Grid

**Reset all Keys Position** Resets all Keys to their original positions

**Reset all Keys Size and Position** As it says.
Cue

**Undo** (last undoable action)
- Cut: Ctrl+X
- Copy: Ctrl+C
- Paste: Ctrl+V

**Add Cue**
- Opens the **Add** sub-menu
  - **Add Short Empty Cue**: Adds a 1 second duration new empty Cue below the Cue currently highlighted. If none, then adds a new empty Cue at the bottom of the list.
  - **Add Short Empty Cue**: Adds a 24 hour new empty Cue below the Cue currently highlighted. If none, then adds a new empty Cue at the bottom of the list.
  - **Add Cue Shortcut**: Adds a new Cue having the same Name, Comment and Color as a currently selected Cue with a Rule Firing the parent Cue when the Shortcut is started.

---

Ovation Cue Menu

Ovation Menus : Cue
**Note:** Empty Cues are typically used to trigger something immediately or in conditional rules. If intermediate lengths are required this is easily accomplished by modifying the Cue Length in Cue Properties.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load MTInterchange XML</td>
<td>Opens a Browser to search for and Add Cues</td>
</tr>
<tr>
<td>Load Audio File</td>
<td>Opens the Import CD dialog. Please see: CD Tracks Import on page 47</td>
</tr>
<tr>
<td>Import CD Tracks</td>
<td>Opens the Record Audio dialog. Please see: Recording on page 59</td>
</tr>
<tr>
<td>Record Audio as New Cue</td>
<td>Opens the Record Audio dialog. Please see: Recording on page 59</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected Cue from the Cue List</td>
</tr>
<tr>
<td>Edit in Pyramix</td>
<td>Opens the Pyramix editor for editing the selected Cue</td>
</tr>
<tr>
<td>Consolidate</td>
<td>If the selected Cue does not reside in the Show Audio Files Folder or the sampling rate is different to the Show rate opens the Consolidate Cues dialog. Otherwise, shows a message: Nothing to do, all files already properly consolidated.</td>
</tr>
<tr>
<td>Record Audio</td>
<td>Opens the Record Audio dialog to record audio into a new Cue. Please see: Recording on page 59</td>
</tr>
<tr>
<td>Replace Audio Media</td>
<td>Opens a Browser to search for and replace a Cue’s existing Audio Media File.</td>
</tr>
<tr>
<td>Snapshot Automation</td>
<td>Opens the Filter Mixer Controls to Snapshot dialog.</td>
</tr>
<tr>
<td>Paste Automation</td>
<td>Pastes the Automation Snapshot from the Cue copied last to the Cue selected currently. Please see: Snapshot Automation on page 52</td>
</tr>
<tr>
<td>Change Audio Gain</td>
<td>Opens the Cue Gain fader window</td>
</tr>
<tr>
<td>Edit Rules</td>
<td>Opens the Cue Interaction Rules dialog</td>
</tr>
<tr>
<td>Add Rule &gt;</td>
<td>Drops down a list of Rules which can be applied to the Cue directly</td>
</tr>
<tr>
<td>Fire Next Cue when Ending</td>
<td></td>
</tr>
<tr>
<td>Fire Next Cue when Stopping</td>
<td></td>
</tr>
<tr>
<td>Fire All Child Cues when Starting</td>
<td></td>
</tr>
<tr>
<td>Stop Previous Cue when Starting</td>
<td></td>
</tr>
<tr>
<td>Stop All Cues in Cue List when Starting</td>
<td></td>
</tr>
<tr>
<td>Loop (Fire Itself when Ending)</td>
<td></td>
</tr>
<tr>
<td>Loop between Markers (Fire Itself between Markers)</td>
<td></td>
</tr>
<tr>
<td>Dim All Cues when Starting</td>
<td></td>
</tr>
<tr>
<td>Select Next Cue when Starting</td>
<td></td>
</tr>
<tr>
<td>Copy Rules</td>
<td>Copy the selected Cue Rules to the Clipboard</td>
</tr>
<tr>
<td>Paste And Replace Rules</td>
<td>Replaces current Rules of all selected Cues with previously copied Rules.</td>
</tr>
<tr>
<td>Paste and Add Rules</td>
<td>Appends previously copied Rules to all selected Cues current Rules.</td>
</tr>
<tr>
<td>Audition/PFL</td>
<td>Plays the selected Cue through the selected Output Slot</td>
</tr>
<tr>
<td>Audition &gt;</td>
<td>Drops down a list of available Audition commands:</td>
</tr>
<tr>
<td>Start</td>
<td></td>
</tr>
<tr>
<td>Rewind</td>
<td></td>
</tr>
<tr>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td>Play/Pause</td>
<td></td>
</tr>
<tr>
<td>Fast-Forward</td>
<td></td>
</tr>
</tbody>
</table>
End

Jump Forward 1
Jump Forward 2
Jump Forward 3
Jump Back 1
Jump Back 2
Jump Back 3

**Pin/Unpin to Active Cue Window**
Toggles the Cue selected currently Pinned or Unpinned to the Active Cue Window

**Lock in Active Cue Window**
Puts the selected Cue into the Active Cue Window when Lock mode is active. Grayed out when Lock mode is not active in Active Cue Window

**Move Down**
Down Moves the selected Cue Down one position in the Cue List

**Move Up**
Up Moves the selected Cue Up one position in the Cue List

**Nest**
Right Makes the Selected Cue a Child-Cue of the one above.

**Unnest**
Left Brings a Child-Cue Up one level (becomes a Cue if only one level deep)

**Link Offsets/StartTimes**
Links all Audio, TCGen, MMC and 9-pin (Sony P2) Offsets and Start Times in a Cue with these properties. The button toggles on/off and it’s state is not saved when a different Cue is Active. When enabled all related fields in the **Cue Properties** pane turn red for clarity.

**View Cue Properties**
Toggles the **Cue Properties** Pane Open/Closed

---

**Fire**

[Image of Ovation Fire Menu]

**Fire Sequenced Cue !**

**Enter** With the Show running Fires the currently selected Cue in the currently selected Cue List and moves the Selection to the next Cue

**Previous Scene**

**LEFT** Moves the selection to the Previous Scene (Child-Cue or Cue) in the currently selected Cue List

**Next Scene**

**RIGHT** Moves the selection to the Next Scene (Child-Cue or Cue) in the currently selected Cue List

**Previous Cue**

**UP** Moves the selection to the Previous Cue in the currently selected Cue List
**Next Cue**

**DOWN** Moves the selection to the Next Cue in the currently selected Cue List

**Fire Cue**
Plays selected Cue

**Pause Cue**
Pauses selected Cue

**Stop Cue**
Stops selected Cue

**Stop All Cues**
Stops all Playing Cues. (Typically used as Emergency Stop)

**View**

- **View Show Properties**
- **View Show Validator**
- **View Show Log**
- **View Show Control Toolbar**
- **View Cue List Properties**
- **View Cue List Fire Toolbar**
- **View Cue List Edit Toolbar**
- **View Cue Properties**

**Properties Font Size**
- Normal
- Medium
- Large

- **View TimeCode Reader**
- **View Audition Toolbar**
- **View Modifiers Toolbar**
- **View Active Cue Window**
- **View Active Cue Window Edit Toolbar**
- **View Audio Gain Matrix**
- **View Audio Control**
- **View Mixer**
- **View I/O Status**
- **View Input Check**
- **View DSP Load**

**Ovation View Menu**

**View Show Properties**
Toggle **Show Properties** show/hide

**View Show Validator**
Toggle **Show Validator** show/hide

**View Show Log**
Toggle **Show Log** show/hide

**View Show Control Toolbar**
Toggle **Show Control Toolbar** show/hide

**View Cue List Properties**
Toggle **Cue List Properties** show/hide

**View Fire Toolbar**
Toggle **Cue List Fire Toolbar** show/hide (Show Mode)

**View Edit Toolbar**
Toggle **Cue List Edit Toolbar** show/hide (Compose Mode)

**View Cue Properties**
Toggle **Cue Properties** show/hide

**Properties Font Size**
The sub-menu offers the choice of:
- Small
- Medium
**Large**

Font sizes for the Properties panes.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View TimeCode Reader</td>
<td>Opens a TimeCode Reader window. Up to 20 may be opened</td>
</tr>
<tr>
<td>View Audition Toolbar</td>
<td>Toggle Audition Toolbar show/hide (in main Ovation Window)</td>
</tr>
<tr>
<td>View Modifiers Toolbar</td>
<td>Toggle Modifiers Toolbar show/hide (in main Ovation Window)</td>
</tr>
<tr>
<td>View Active Cue Window</td>
<td>Toggle Active Cue window show/hide</td>
</tr>
<tr>
<td>View Active Cue Window Edit Toolbar</td>
<td>Toggle Active Cue Window Edit Toolbar (Only available when Active Cue Window is open)</td>
</tr>
<tr>
<td>View Audio Gain Matrix</td>
<td>Toggle Audio Gain Matrix window show/hide</td>
</tr>
<tr>
<td>View Audio Control</td>
<td>Toggle Audio Control window show/hide</td>
</tr>
<tr>
<td>View Mixer</td>
<td>Toggle Mixer show/hide</td>
</tr>
<tr>
<td>View I/O Status</td>
<td>Toggle I/O Status Window show/hide</td>
</tr>
<tr>
<td>View Input Check</td>
<td>Toggle Input Check Window show/hide</td>
</tr>
<tr>
<td>View Touch Controller</td>
<td>Toggle Touch Controller show/hide (Only available when a Touch Controller is present)</td>
</tr>
</tbody>
</table>

**Settings**

![Ovation Settings Menu]

- **Settings**: Opens the Main Ovation application Settings window.
- **Keyboard Shortcuts**: Opens the Keyboard Shortcuts dialog.

**Help**

![Ovation Help Menu]

- **User Manual**: Opens this User Guide.
- **About Ovation**: Opens the About Ovation window.
Note: When the Show is running or a Cue is Auditioning if the Settings Window is opened many Settings pages will not be shown.

Overview

Many settings are made in the Cue Properties, Cue List Properties and Show Properties panes from within the active Show. However, there are many other settings which are kept separate and are accessed from the Settings menu.

The Keyboard Shortcut Editor, is accessed directly from the Settings menu.

The main Settings dialog window is also accessed directly from the Settings menu. Folders and sub-folders are used to group settings logically. The left-hand side of the window shows all available settings. Folders can be collapsed or expanded by clicking on the folder icons. By default, all folders are open, displaying the Settings Pages they contain by name. Clicking on a Settings Page in the left-hand pane opens it in the right-hand side of the window for viewing and editing. Information about pages not described here can be found in the Pyramix User Manual.

There are two main groups of settings.

![Settings dialog](Ovation_Settings.png)

Shown here with all sub-folders collapsed.

- **Show Settings** are specific to and saved with each Show.
- **Application Settings** are global and apply to all Shows.

Note: There is one exception to this rule.

In the Application Settings > General > Audition page all the settings are global EXCEPT the Audition Cues Output Slot. This is saved with the Show so that Templates can have a PFL bus.
Settings Buttons

Apply changes to ...
Below the Settings folders tree view the first large button’s function and label changes to reflect the currently open settings page (if any). Apply changes to ... does as it says without saving the changes to a Settings file. Settings can be saved selectively or in their entirety for future use.

Load
Load opens a Browser window to enable settings Profile (*.pms) files to be located. When the required file has been located clicking on the Open button loads the file.

Save
To save all settings, Click on the: Save button to open a Save As browser window. If necessary, navigate to a suitable location for the file. Type a suitable name in the File name: box and click the Save button to save the file and close the browser window.

OK
Saves any changes made to settings and exits the Settings window.

Cancel
Cancels any changes made to settings and exits the Settings window.
Show Settings

General

Formats & Sync Masscore

Preset
This section is inactive when a MassCore audio device is in use.

Information
- **Effective Sampling Rate**: Displays the sampling rate including the effect of any pull-up or down or Vari-speed settings.
- **Effective TC Frame Rate**: Displays the TC Frame Rate including the effect of any pull-up or down or Vari-speed settings.

Warnings
Displays any caveats about the selected rates.

Frequencies
- **Sampling Rate**: The drop-down list presents a choice of all available nominal sampling rates.
- **TC Frame Rate**: The drop-down list presents a choice of all available TC Frame Rates
- **Drop**: Only available for NTSC Frame Rates i.e. 29.97fps and 30fps. When checked drop frame counting is applied.
**Formats & Sync - ASIO**

**Preset**
This section is inactive when an ASIO audio device is in use.

**Information**

**Effective Sampling Rate**
Displays the sampling rate including the effect of any pull-up or down or Vari-speed settings.

**Effective TC Frame Rate**
Displays the TC Frame Rate including the effect of any pull-up or down or Vari-speed settings.
Effective Video Frame Rate  Displays the Video Frame including the effect of any pull-up or down or Varispeed settings.

Sampling Rate  Displays the rate set when the project was created or the default Mixer preset loaded. This can be changed from the Sampling Rate drop-down list.

Note: Sampling rate can only be set when a Show is NOT running. If you have been auditioning Cues the same applies. Please Init and Stop the Show to access.

Warnings  Displays any caveats about the selected rates.

Frequencies  The drop-down list presents a choice of all available nominal sampling rates.

TC Frame Rate  The drop-down list presents a choice of all available TC Frame Rates

Drop  Only available for NTSC Frame Rates i.e. 29.97fps and 30fps. When checked drop frame counting is applied.

Audio Synchronization  In a Multi-board system choose the board which will be the sync master from the drop-down list.

Source  This determines the sample clock source for the system. The choices available will depend on the hardware interface in use.

Video/TimeCode Synchronization  The drop-down list presents all available Video Formats. (If any.)

TC Reference  The drop-down list presents all valid external TimeCode reference sources and Internal.

Varispeed  Allows either choice of either a pull-up / pull-down sampling rate or of running Pyramix in Varispeed mode by adapting the sampling rate.

Important!  Typical digital to analog or analog to digital converters do not operate beyond +/- 0.15 ‰ (150 ppm) and therefore will mute in any Varispeed mode. It is suggested that digital I/O’s are routed through external real-time sampling rate conversion circuitry or to that adequate external converters with built-in pull-up or pull-down support are used.

Note: Note: Locking to external NTSC video reference is limited to nominal and pull-down sampling rates.

Nominal  ‘Normal’ mode. Uses the nominal sampling rate as set in the Sampling Rate pull-down menu.

Pull-Down  Decreases the sampling rate by 0.1%. Most often used in audio post production for compatibility reasons between NTSC frame rates of 30 fps and 29.97 fps.

Pull-Up  Increases the sampling rate by 0.1%. Most often used in audio post production for compatibility reasons between NTSC frame rates of 30 fps and 29.97 fps.

Varispeed  The speed of audio playback can be varied within the range of -12.5% to +12.5%. Select this option, then enter the required speed change in tenths of percents into the adjacent entry field. Values entered outside of the allowed range will be limited to the extent of the allowed range. E.g. if 1500 is entered, the value will be set to 1125.

MassCore™ [dedicated mode]  Please see the Pyramix User Manual for details.
**I/O Interfaces**

The page(s) shown here depend on the options included with your individual system. Please see the Pyramix User Manual for details.

**Routing**

The page(s) shown here depend on the options included with your individual system. Please see the Pyramix User Manual for details.

**Mic/Pre Remote**

The page(s) shown here depend on the options included with your individual system. Please see the Pyramix User Manual for details.

**TimeCode**

Please see the Pyramix User Manual for details.

**Mixing Console**

**Slots Allocation**

"Please define the number of Audio Slots/Channels in the Mixing Console used for playing back Cues. Remaining Slots/Channels will be automatically switched to input Mode and can be used for Live Mixing and/or Mixing Inputs from MT ASIO Bridge.

**Number of Audio Slots for Cue Playback**

The drop-down offers the choice of:

- **All Strips**
- **2,4,6,8 or 10**

**Please type higher values manually...**

Slots are mapped incrementally to the lowest numbered Slots of the audio mixer."
This option enables vacant strips to be left in the Ovation Mixing Console to define MT ASIO Bridge (and Merging Audio Device - MassCore) or ReWire connections to patch Pyramix (or any other DAW) outputs to the mixing Console for advanced Cue editing.

Level Meter
This page determines the appearance and behavior of the level meters in the Mixer. Please see the Pyramix User Manual for the details.

DSP Power Saving

Special Modes

Player/Recorder Mode
This mode allows big configurations (such as 48 x 48 channels) to run on a single board. Player/Recorder Mode is intended for use with an external hardware console. When this mode is activated, the mixer is relegated to the role of signal router, there is no level control, no panning, no plug-ins and no inserts. This option is only available in configurations with multiple mono mix busses.

The Direct Out functionality provides an alternative, more user configurable method of achieving similar DSP savings.

Core Time Saving

Disable Punch In / Punch Out
When the box is checked, Punch-in and out recording capabilities are disabled.

Important! The software still will allow you to arm tracks and to start the recording process, but the resulting media file will contain digital nulls.

Disable Mix Down
When the box is checked, the digital mixdown function activated with the menu command: Project->Mix Down is disabled.

Important! The software still will allow you to start the mixdown process, but the resulting media file will contain digital nulls.
Mixer Settings

Virtual Room / Stereo Pan Law
The drop-down menu offers a choice between the default *Sin/Cos law, Constant Power, -3dB center* and *Square Root law, Constant Power, -3dB center*.

**Note:** Existing projects will use the previous default *Square Root law* unless this setting is changed.

Internal Buses

**Max Number of Internal Buses available:** Select the number of Buses required from the drop-down. (32 - 384)

Delay Compensation Policy

**Mode**

The drop-down menu offers a choice between:

- **Full Delay Compensation**
- **Off**
**Note:** Automatic Delay Compensation does not support more than 5 nested I/O loops.

**Automatic Delay Compensation** When ticked, turns Automatic Delay Compensation *On*

**Note:** Any changes to the delay required that occur during playback or recording will only be computed and applied when the Transport is next in **Stop**.

**Max Mixer Delay Compensation**

When required by the **Mixer error: Delay compensation** dialog the slider should be set to a value just above the delay latency value requested.

**Reset to Factory** Click the button to restore the factory computed maximum delay value.

**VST Plug-ins Settings**

![VST Plug-ins Settings](image)

The buttons offer a choice of how the VST Plug-ins are ordered and grouped in the **Plug-ins List Menu**.

**Company Name and I/O Configuration** Sorts the list will be ordered by Company Name and the plug-in’s grouped according to their I/O configuration. I.e. **1 in - 1 out**, **1 in - 2 out**, **2 in - 2 out** and so on.

**I/O Configuration** Groups the Plug-ins by I/O Configuration and within each group lists them alphabetically by name.

**VST plug-ins folders**

The box shows which folders Pyramix will scan for VST Plug-ins on launch.

By default, `\Program Files\VSTPlugins` and or `\Program Files\Steinberg\VSTPlugins` directories are scanned if...
they exist. Further directories may be added to the scan list using the Add button, which opens a File Browser window. Directories are removed from the list by selecting them in the list and clicking on the Remove button.

**Show Available plug-ins**

Clicking on the button opens the Available Plug-ins dialog:

![Available Plug-ins dialog](image)

The list shows all VST Plug-ins which have been scanned and are available to Pyramix. Blacklisted plug-ins are displayed in red.

- **Scan** Initiates a scan of any directories added to the VST Plug-ins Folders list since Pyramix was launched.
- **Force Rescan** Initiates a forced rescan of all the directories in the VST Plug-ins Folders list.
- **OK** Closes the dialog.
Remote Control

Mixing Console Remote Control

Enable
When ticked enables the mixer remote protocol(s) selected from the drop-down list and set up in their respective configuration dialogs.

Properties
Opens the configuration dialog for the mixer remote protocol selected in the drop-down list.

OASIS
EMC
RAP

OASIS

OASIS Transport Configuration dialog

Console IP address
Set the **Console IP address** and **Port**.

**Timeout Options**
- **Show reconnection message**: When ticked a message box will be displayed if connection to the console is lost and re-established.
- **Timeout [ms]**: Set the maximum time for connection to be re-established.

Click on **OK** to save the configuration and close the dialog or **Cancel** to close the dialog without saving.

**RAP (Ross Audio Protocol)**

![RAP - Ross Audio Protocol configuration dialog](image)

Ovation can be controlled by the Ross Overdrive and Vision products.
Set the **Server IP address** and **Server port** in this dialog.

Click on **OK** to save the configuration and close the dialog or **Cancel** to close the dialog without saving.

**Note**: RAP support requires the optional **OASIS first class** security key. (Included with Ovation Platinum)

**EMC**

![EMC MIDI I/O Configuration dialog](image)

Click on **OK** to save the configuration and close the dialog or **Cancel** to close the dialog without saving.
Application Settings

General

Media Manager

[Diagram of Media Manager settings window]

Application Settings > General > Media Manager
Preferred Media Folders

Click here to add a path

Click on the ... field to open the **Browse For Folder** dialog:

![Preferred Media Folders Browser](image)

This enables new Media Paths to be added to search for Media required to Run by an Ovation Show. For example, it may be desirable to use locally stored Cues rather than run them across a network connection.

**Real-time Sampling Rate Conversion**

Toggles between three options:

- **Disabled**: No Real-time SRC will take place. Clips will be played back at the original sampling rate. I.e. if sampling rate does not match Project sampling rate then the Clips will be played back at incorrect speed.

- **Medium Quality**: Clips will be played back at the correct speed. Conversion, if necessary, will be carried out at a compromise quality between speed and quality.

- **High Quality**: Clips will be played back at the correct speed. Conversion, if necessary, will be carried out at the highest quality. This obviously requires more resources.

- **Very High Quality**: Clips will be played back at the correct speed. Conversion, if necessary, will be carried out by the Merging Technologies **HeptaCon** Sample Rate Converter at the very highest quality.
Other Settings
Compressed Media Settings

Here you specify where the media should be decompressed to:

Locally (by the original). When active, File(s) will be created in the same location as the original file.

Sub-locally (by the original, in a \MTDXCache sub folder). When active, File(s) will be created in a sub-folder created by Pyramix in the same location as the original file.

Custom (files are generated to the specified location). File(s) will be created in a user specified location. When this option is selected the Browse... button is available to open a file browser window to set the user defined path.
Audition

The radio buttons offer a choice of which Player and Audio Output Slot will be used to audition Audio Cues. Default is the machine Ovation is running on. Alternative Player choices are only valid in very advanced configurations with Players on networked machines.

**Note:** For multi-channel Cues, the number set in the Audition Cues on: Audio Output Slot box defines the FIRST slot to be used for audition monitoring. So, if the Cue is six channel surround and the number in the box is 9 then the signals will be routed to Output Slots 9 through 14.

**Audition Cues through their default Player**

Audition Cues through: Any Player, on the network can be selected from the Player drop-down list.

**Audition Cues on their default Audio Output Slot**

Audition Cues on:

Audio Output Slot Any available Audio Output Slot can be typed in the field.

**Note:** This setting is saved in the Show, as opposed to all other settings in this page that are saved globally.
Active Cue Window Trim In/Out Audition Timings

Cue Out preroll (in s.) 
Click in the field to enter an alternative to the default value (5 secs)

Cue Out Looping (in s.) 
Click in the field to enter an alternative to the default value (1 sec)

IP Connections

The IP Connections page enables Ovation IP connections to be set with the following options:

**Type** 
Server or Client

**IP / Name** 
Enter the target Server IP address or name here. (Not relevant if Type is set to Server)

**Port** 
Enter the target Port number or name here.

**Status** 
This field shows the current status of the connection.

**Note:**

- Once an IP Client or Server is created, the IP object appears in both the Player Units and Controller Units sections.
- **Player Units** deal with Control Protocol Outputs
- **Controller Units** deal with Control Protocol Inputs
- Both Servers and Clients can send AND receive data. The only practical distinction between them is that a Server can be connected to multiple clients whereas a Client can only be connected to one Server.
- Servers accept multiple Clients’ connections.
- When data is sent through a Server, it is sent to all connected Clients.
- When a Server is no longer available, Clients attempt to reconnect to the Server automatically.
- When a new connection is created/destroyed, the Apply changes to IP connection button adds/removes the corresponding Player/Controller units.
IP Address / Server Name Considerations

In general, it is usually preferable to use fixed IP addresses to avoid surprises. A DHCP server should assign the same address to a given device every time until the device is offline for the amount of time set in the DHCP servers “lease time”. If you use machine names instead of IP addresses then there is no real disadvantage with a DHCP server on the network. However, some devices cannot be resolved as a name and an IP address is the only way to connect them. So, unless there is a very good reason not to use them, fixed IP addresses are the preferred option.

**Note:** It is best to avoid using the most common port numbers (under 1024). For maximum safety we would recommend the use of ports in the range 49152–65535.

UDP/IP Support

IP Communication has been extended to include User Datagram Protocol (UDP) support.

- UDP support adds two kinds of connection: **UDP Streamer, UDP Receiver**.
- UDP connections have to be set with a port number. The UDP Receiver IP address should be 0.0.0.0 and the UDP Streamer IP address should be filled with the address of the IP device targeted.

**Note:** OSC is compatible with UDP but not with the TCP protocol.

Player Units

**Player Units** are the virtual devices which enable Ovation to control other targets.

Lists available MIDI interface IP ports and COM ports for playing **MIDI, IP Commands** and **Sony P2 / RS422 Cues**

**Note:** If you attempt to assign an output to a Virtual Com Port that is already in use this dialog appears:
Clicking on an entry in the MIDI list under Player Units brings up the associated options in the right-hand pane.

**Midi**

**Enable**
Click to enable

**Virtual MIDI Port**
When enabled the drop-down list becomes active to enable a Virtual Midi Port to be selected from the list.
**IP**

- **Enable**
  - When checked, the Player will output IP commands as defined in Cue Properties.

- **Escape character**
  - When checked, an Escape character is used to define the end of a command string.
  - Choose a suitable Escape character from the drop-down list.

**OSC Options**

- **Send Cue status messages to this port**
  - When checked, OSC Cue Status messages are sent through this port.
Note: Please see the Ovation OSC Dictionary for description of Cue Status messages.

**Send Mixer status messages to this port**
When checked, OSC Mixer Status messages are sent through this port.

Note: Please see the Ovation OSC Dictionary for description of Mixer Status messages.

**Remap to**
A selection of Mixer Status messages are automatically remapped to another OSC Dictionary.

Note: The Remap feature will only work if the Send Mixer Status option is active.

**Com**

![Image of Ovation software settings for COM](image)

**COM**

**Enable**
Click to enable the COM Player

**Virtual COM Port**
When enabled the drop-down list becomes active to enable a Virtual COM Port to be selected from the list.

**Protocol**
The drop-down offers the choice of Generic or Sony P2

**COM Settings**

Note: Please see the Ovation OSC Dictionary for description of Cue Status messages.
Note: COM Settings and Protocol below are only available when Generic is selected in Protocol above.

When Generic is active the following serial port options are available. Use the drop-down lists to select the appropriate settings for your application:

- Baud rate
- Data bits
- Parity
- Stop bits
- Flow Control

Protocol

Start of message
The drop-down list offers a choice of hex character strings which will be added to the start of each outgoing message.

End of message
The drop-down list offers a choice of hex character strings which will be added to the end of each outgoing message.

Ethernet

Sony P2 over IP

Pre-requisites
1. Check that File and Printer Sharing is activated:
   - Win XP: Windows Control Panel > Network Connections > select your LAN card/adapter > Right-click and choose Properties
   - Win 7: Windows Control Panel > Network and Sharing Center > Change advanced sharing settings

2. a) Computers on a domain
   If your Computers are connected under the same domain jump directly to section 3, since the security access is managed by your domain server. Please talk to your IT Manager for further details.

b) Computers in a WorkGroup
   Working under workgroups requires some extra steps:
   - Make sure each machine is a member of the same workgroup.
• You can change your workgroup in Windows Control Panel > System > 
  [XP] Computer Name tab > Change  [Win7] Change Settings
• You must restart the computer for changes to take effect!
• On each machine, make sure that you can access the other machine(s):
  My computer > Network > Workgroup
• Remember that you have to enter a user name and its password for a user account on the machine that you require access to.
• Check the box Remember my credentials [Win7] Remember my password [XP] Otherwise you will have to enter the user name and password each time you restart the computers.
• You do not need to share any folders.

Sony over IP

Sony P2 over IP enables Ovation to control a remote VCube or Pyramix workstation by using the Sony P2 protocol over an Ethernet connection. Enable COM port.

Choose a Virtual COM Port (COM1 to COM 16). This behaves in the same way as a real COM port. Virtual COM ports are used in the Cue Properties pane under Sony P2 / RS422 and COM Command sections.

Remote Computer Name Insert an IP address or a computer name or leave blank when the target local is local. (E.g. VCube running on the same machine as the Ovation Sequencer.

Port Name Use if the target machine has multiples ports set. This could be the case for a Pyramix but not for a VCube.
In the rare case that the remote machine is a Pyramix, you must add a controller in Pyramix with the **Sony over IP** settings.

If the remote machine is a VCube, there is nothing to configure on the VCube side. But only **one** connection is permitted.

**Com**

**Enable**
- When the box is ticked Sony P2 over IP is active.

**Virtual COM Port**
- Shows the virtual COM port selected currently. The down arrow drops-down the list of ports available.

**Remote Identification**

**Remote Computer name**
- The entry here must match the remote computer

**Port Name**
- The entry here must match the Controller Port Name on the other Computer.

### GPO

**Note:** For the present the only supported GPI/O interfaces are the following models manufactured by **Sealevel**:

- SeaPORT PLC-16** 8 in 8 out
- Seal/O-410U 16 in 16 out
- Seal/O-420U* 16 in 8 out
- Seal/O-430U* 32 in 0 out
- Seal/O-440U* 0 in 32 out
- Seal/O-450U* 0 in 16 out
- Seal/O-8012e 8 in 8 out
- Seal/O-8012es 8 in 8 out
- SeaDAC P/N 8221* 16 in 16 out
- SeaDAC P/N 8222 16 in 8 out
- SeaDAC P/N 8223* 32 in 0 out
- SeaDAC P/N 8224* 0 in 32 out
- SeaDAC P/N 8225* 0 in 16 out

* Obtainable on special order.

** No longer available.

**Note:** Note: USB drivers are **NOT** included in the Pyramix Installer. Please download the driver from the supplier’s website. For more information about the specification of the GPIO hardware devices please see:

http://www.sealevel.com

A maximum of 32 units may be connected. Physically installed GPO devices will appear here. Capabilities will depend on the model.

**General Purpose Output**

**Enable**

When ticked General Purpose Outputs are enabled

**Virtual GPO Port**

The drop down list offers a choice of all available Virtual GPO Ports or **None**.

**Note:** When the Show is running or a Cue is Auditioning if the Settings Window is opened the Player pages will not be present.

**Note:** Whether the Player is the default local machine or stand alone on a Networked machine, when the Show is running or a Cue is Auditioning all Player related pages are absent from the **Settings** window.
Controller

Remote Controlled Ovations
This page enables you to define which Stations I.e. PCs running Ovation, will be controlled by an OV Controller Session.

Controller Units enable the Ovation Sequencer/Show controller to be remote controlled.

In this folder all supported Remote Control Units available in the system are listed in sub-folders. They can be:
• The Proprietary Ovation Keyboard
• The Proprietary Ovation Webserver
• IP Controller
• MIDI ports - Midi Show Control (MCS), Midi TimeCode (MTC), Midi Machine Control (MMC) and General Midi (GM).
• DMX ports (Art Net protocol available in later beta)
• GPI ports
• Sony 9-pin (P2 Protocol) remote control

Note: Appendix I and following details how the various Controller Units protocols are implemented and how they map the available Ovation Media Sequencer and Media Server Commands.

Note: For a full list of controllers supported by Ovation and Pyramix currently please visit:

https://confluence.merging.com/display/PUBLICDOC/Pyramix+Supported+Controllers

When a Controller Unit is clicked to select it in the list, a related page displays appropriate options. Please see subsequent pages in this document.
**Proprietary**

**OVKeyboard**

![OVKeyboard Settings](image)

**Ovation Keyboard**

**Enable**

When checked the **Ovation Keyboard** is active.

**Keyboard Mapping**

**Multi-purpose (Standard Mapping)**

**Big Red Button Behavior**

Drop-down offers the choice of **Fire Sequenced Cue** or **Fire Selected Cue**. Note that this setting applies ONLY to the controller in Multi Purpose (Standard Mapping) mode. It does not affect the UI.

**Hot Keys Only**

The radio buttons are mutually exclusive. Select the Mapping corresponding to your physical keyboard layout.

**Note:** For those people using Pyramix and Ovation at the same time and who have the ADR authorization key and an Ovation Keyboard then Pyramix may conflict with the Keyboard. In this case you should add a DWORD Registry Key in: HKEY_CURRENT_USER\Software\Merging Technologies\Pyramix\ADR, name it **"Disable ADR Keyboard"** and set it to 1.

If you are not confident with Registry editing then please ask your Merging Sales Partner to make this change for you.
**Web Server**

**Enable**
When ticked, Web Server control is active.

**HTTP Port:**
The default value is 888. Type in the field to change this if necessary.

**Pages Root Folder**
The default path to the Pages Root Folder is shown in the field. Clicking on the ... button opens a browser where an alternative path can be set.

**Password (optional):**
Type a Password in the field to password protect the pages.

**Tutorial**
In any browser simply type the IP address of the machine running Ovation followed by the port number as defined above, like:

```
http://127.0.0.1:888
```

The displayed Cue Lists can be limited by adding the following filter (the Cue List Index in the filter is defined as the Cue List Number minus 1):

```
http://127.0.0.1:888?Filter=CueList=0
```

The Show Control Bar on the bottom of the page can be hidden to avoid unexpected interaction by adding the following filter:

```
http://127.0.0.1:888?Filter=ShowControlBar=Hidden
```

If a Password is set in the settings, then it must be provided to access the page:

```
http://127.0.0.1:888?Filter=Password=xyz
```

Multiple filters can be provided together, separated by a &:

```
http://127.0.0.1:888?Filter=CueList=0&ShowControlBar=Hidden
```
http://128.0.0.1:888/Filter?Cuelist=0
The Show Control Bar on the bottom of the page can be hidden to avoid unexpected interaction by adding the following filter:

http://128.0.0.1:888/Filter?ShowControlBar=Hidden
Or both together, separated by an &:

http://128.0.0.1:888/Filter?Cuelist=0&ShowControlBar=Hidden
MIDI

E.g. Ethernet MIDI

**MIDI INPUTs**

*Note:* Red flashing ‘LEDs’ to the right of each MIDI section indicate that MIDI data is being received.

**Midi Port**

**Enable**

Check the button to enable **MIDI remote control**
**Note:** The rest of the options on this page will be grayed out (unavailable) until this option is selected.

**Virtual MIDI Port**

The drop down list offers the choice of any of the first 16 MIDI ports available on the machine.

**Midi Show Control (MSC)**

Enable

Check the button to enable **MIDI Show Control (MSC)**

**Device Id**

The drop-down list offers the choice of Any or Device Ids from 0 to 7E

**Command Format**

The drop-down list offers many MSC choices for filtering **Command Format** types.

**Midi TimeCode (MTC)**

Enable

Check the button to enable **MIDI TimeCode**

The Midi Port used is the one set in the first section above: **Midi Port**.

**Midi Machine Control (MMC)**

Enable

Check the button to enable **MIDI Machine Control**.

**General Midi (GM)**

If Ticked, ignore Note On/Off velocity

As it says.

Enable direct Cue mapping of MIDI messages from the selected Virtual MIDI Port

Check the button to enable **General MIDI (GM)** control of individual Cues.

**Note:** Direct MIDI messages Cue mapping is available in the Cue Properties 'REMOTE CONTROL: General MIDI Command section

Please see REMOTE CONTROL: General MIDI Command on page 111

**Enable Mapping based on command:**

Enables MIDI commands to be mapped to events not related to Cue events, such as **Show Start, Select Next Cue List**, etc… or contextually related Cue commands such as **Select Next Cue**, etc…

The drop-down list offers a choice of which type of Midi command is to be mapped from:

**Note off**

**Note on**

**Polyphonic key pressure**

**Control change**

**Program change**

**Overall keypressure aftertouch**

**Pitch bender change**

Control Change commands are General Midi commands such as **Note On**.
Clicking on **Add** in the **Midi Channel** column adds an entry to the list.

Clicking on the **0** entry in the **Midi Channel** column drops down the list of available Midi Channels (1-16)

Clicking on the entry in the **Data 1** column drops down a list with the choice of **0** to **127**.

Clicking in the **Media Sequencer** column drops down the list of mappable Ovation commands.

**Delete** on the PC keyboard removes a mapping entry.

**Enable Legacy GM (Note On/Off and Program Change old auto mapping)**

Reactivates the old ‘fixed’ style GM mapping.

**Please see also: General Midi (GM) on page 173** for a complete list of mappable commands.

**COM**

Ovation Cues can be Started - Stopped or Paused from any Sony P2 Protocol controller. An Ovation station can also control another Ovation linked via a serial connection using the native Ovation protocol.
Sony P2

Com Port

Enable

When ticked the Com Port and associated remote controller are able to control Ovation.

Protocol

The drop-down offers the choice of Sony P2 and Ovation. The settings page is modal and this setting determines what other appropriate settings are shown. Choose Sony P2 for control by a machine using this protocol.

Com Settings

Protocol

Sony Device Id

The drop-down list offers the choice of Ovation and all P2 device emulations supported by Ovation

Targeted Cue List

The drop-down list enables any Cue List in the current Ovation Show to be selected as the target.
Track Arming Cues Selection

**Note:** Only Digital presets (Track Arming) from 1-32 are allowed.

The drop down list offers the following choices:

- **No selection** track arming has no effect.
- **1-8 Selects Cue lists, 9-32 selects Cues**
- **Targeted Cue List is used, 1-32 selects Cues**

**Targeted Cue List** is determined by the choice made in the **Targeted Cue List** drop-down list.

- **Targeted Cue List is used, hours selects Cues**

**Goto Cues selection**

The drop-down list offers the following choices:

- **No Selection** goto TimeCode has no effect
- **Hours selects Cue Lists, minutes select Cues**
- **Targeted Cue list is used, hours select Cues**

**Targeted Cue List** is determined by the choice made in the **Targeted Cue List** drop-down list.

**Notes:**

**Valid Cue and Cue List Numbers**

Since 00 is not allowed as either a Cue number or Cue List number the maximum number of Cues and Cue Lists that can be addressed is limited to **23** i.e. **1-23** or **59** i.e. **1-59** in Hours and Minutes respectively.

**Limitations**

- Goto a specific timecode inside a Cue (not implemented)
- Analog A1, A2, V and TC edit preset bit (track arming) are not used. Only Digital edit preset from 1 up to 32 are used. Above Preset 32 (not implemented)
- Rew, F.Fwd, Jog, Shuttle not possible.

**Track arming Cues selection options:**

- **A) "No selection"** track arming has no effect.
- **B) "1-8 selects Cue lists, 9-32 selects Cues"**
- **C) "Targeted Cue list is used, 1-32 selects Cues"**

**Goto Cues selection options:**

- **1) "No selection"** goto timecode has no effect
- **2) "Hours select Cue lists, minutes select Cues"**
- **3) "Targeted Cue list is used, hours select Cues"** targeted Cue list is chosen by the drop down menu.

**Ovation to Controller Reporting**

Ovation reports the following information back to the Controller:

- The current timecode of the selected Cue.
- Full timecode for option 1 above;
- Seconds and Frames for option 2 above, Hours and Minutes indicating respectively the Cue list # and Cue # .
- Minutes, Seconds and Frames for option 3 above, Hours indicating the Cue #.
- Play, Stop, Pause (Still) tally, Cue Up (when Cue is ready).
- Track arming status (Edit preset sense) indicating the selected Cue. Inactive for option A.
- Default Device Id is **Ovation** which reports: Sony device ID : 0xF0B1 (NTSC), 0xF1B1 (PAL), 0xF2B1 (Film). Any other available device Id can be selected from the **Sony Device Id** drop-down list.
Ovation mode

Com Port
Enable
When ticked the Com Port and associated remote controller are able to control Ovation.

Protocol
The drop-down offers the choice of Sony P2 and Ovation. The settings page is modal and this setting determines what other appropriate settings are shown. Choose Ovation for control by another Ovation station.
COM Settings
The following parameters should be set to match the controlling Ovation.

Baud rate
Data bits
Parity
Stop bits
Flow Control
Protocol

Please see: Appendix VII on page 229 of this document for the commands detail.
**Note:** An IP entry and IP1 etc. Controllers will only be visible if they have been defined in Settings > Application > General > IP Connection. Please see: IP Connections on page 158

An **IP Controller Unit** is used to receive data.

The following data formats are accepted:

1. **Ovation Native** (http protocol format)
2. **Mapping**. Mapping data messages are defined either by
a. Message length
b. By a special end of message character (Escape character)

**Internet Protocol Options**

**Enable**
When checked, the Controller is active and the rest of the settings on this page become available.

**Ovation Native**
Mutually exclusive with **Mapping**, **Dataton Synchronization** and **OSC**. When checked, the native HTML format command strings as used by the Ovation Web Server are accepted. Please see: [Web Server Commands on page 229](#)

**Mapping (Cue direct mapping)**
Mutually exclusive with **Native**, **Dataton** and **OSC Synchronization**.

- **Escape Character**
  When checked an Escape character is used to define the end of a command string. Choose a suitable Escape character from the drop-down list.

- **Message Length of**
  When checked the Message length (in bytes) is used to define the break points between command strings.

- **Send status feedback via Player section of this connection**
  (Player section will be unavailable for other purposes).

3. **Dataton Synchronization**
Check this when using a remote Dataton player. Mutually exclusive with Native and Mapping.

4. **OSC**
Dispatch messages of the following types will be received on this port. This enables selection of the OSC remote control messages received on this port that will be processed.

- **/Server messages** are related to global Ovation functionalities (Show state, Cues and Cue lists,...)
- **/Mixer messages** allows remote controlling the Ovation Mixing Console.
- **/CueMapping messages** are related to Cue specific control, as set on the Cue Properties - Remote Control - IP / OSC Command.
- **Flux :: SpatRevolution messages** : Fader, Solo, Mute and Panner messages from Flux::Spat Revolution are automatically are remapped to Ovation OSC Dictionary scheme.

**Note:** Please refer to Ovation OSC dictionary for details.

**GPI**

**All Available GPI Units Listed**
Click on each entry in the list to configure the GPI Device

**Note:** For the present the only supported GPI/O interfaces are the following models manufactured by **Sealevel**:

- SeaPORT PLC-16** 8 in 8 out
- Seal/O-410U 16 in 16 out
- Seal/O-420U* 16 in 8 out
- Seal/O-430U* 32 in 0 out
- Seal/O-440U* 0 in 32 out
- Seal/O-450U* 0 in 16 out
- Seal/O-8012e 8 in 8 out
- Seal/O-8012es 8 in 8 out
- SeaDAC P/N 8221* 16 in 16 out
- SeaDAC P/N 8222 16 in 8 out
- SeaDAC P/N 8223* 32 in 0 out
- SeaDAC P/N 8224* 0 in 32 out
• SeaDAC P/N 8225* 0 in 16 out

*Obtainable on special order.

**No longer available.

**Note:** A maximum of 32 units may be connected.

General Purpose Input (GPI)

Enable

Check the button to enable General Purpose Input (GPI) control.

Cue # corresponds to the Cue ID

When the button is checked the The Cue is identified with up to 3 nested levels using Cue#, Child#1, Child#2 and Child#3. This is the greyed number present in the Cue property page or the Number next to the Cue name in a Cue button. The number represents the separation between the Cue# of Child#1 etc.

This mode is useful when a Cue needs to be added anywhere in the Cue List using the nesting mechanism without changing the # of the Cue below the inserted Cue.

Cue # corresponds to the Cue Index

The Cue # is the Cue index in its Cue List. This is the greyed number present in the Cue Properties page or the Number next to the Cue name in a Cue button IF any of the Cues are nested. Useful when the nested mechanism is not useful for the mapping.
Example:

<table>
<thead>
<tr>
<th>Cue Number</th>
<th>Cue Id</th>
<th>Sub1 Cue Id</th>
<th>Sub2 Cue Id</th>
<th>Cue Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>3.1</td>
<td>3</td>
<td>1</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>3.2</td>
<td>3</td>
<td>2</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>4.1</td>
<td>4</td>
<td>1</td>
<td>0</td>
<td>7</td>
</tr>
<tr>
<td>4.1.1</td>
<td>4</td>
<td>1</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td>4.2</td>
<td>4</td>
<td>2</td>
<td>0</td>
<td>9</td>
</tr>
<tr>
<td>4.2.1</td>
<td>4</td>
<td>2</td>
<td>1</td>
<td>10</td>
</tr>
<tr>
<td>4.2.2</td>
<td>4</td>
<td>2</td>
<td>2</td>
<td>11</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>12</td>
</tr>
</tbody>
</table>

Trigger Options

The 8 radio buttons set the trigger parameters:

1. Trigger when High level signal is detected
2. Trigger when Low level signal is detected
3. Trigger when Rising level is detected
4. Trigger when Falling level is detected
5. Trigger when the first High level pulse is detected
6. Trigger when the second High level pulse is detected
7. Trigger when the first Low level pulse is detected
8. Trigger when the second Low level pulse is detected

Note: 3-4, 5-6 and 7-8 will often be used in pairs:

Example 1: You wish to Fire a Cue when a button is pressed and released and to Stop the Cue when the button is pressed and released for the second time. In this case use 5-6 or 7-8.

Example 2: You wish to Fire a Cue when a button is pressed and Stop the Cue when the button is released. In this case use 3-4.

Note: High/Low and Rising/Falling inputs trigger the mapped command in the same circumstances. The only difference is that Rising is executed before High and Falling is executed before Low. This can be useful if two commands need to be executed consecutively.

Media Server Commands Mapping

In the commands Table the P columns correspond to Parameters. For the majority of Media Server commands, P.1 = Cue List #, P.2 = Cue #, P.3 Cue Child1 #, P.4 = Cue Child2 #. Please see also Appendix V on page 226 and especially the notes.
Ovation Webserver

Overview
Ovation delivers an amazing amount of control over any system. However, until now, accessing that control has been, like most other sequencer and control software, limited to proprietary interfaces on local machines.

Now, with the WebServer option for Ovation, the entire picture has changed. Through standard HTTP interfaces on any web enabled platform (desktops, laptops, Smart Phones, iPad etc) it is now possible to have complete control over your Ovation show from multiple locations.

Use Merging's own interface design, or, if you know basic web page design, you can do it yourself and create bespoke custom interfaces. Whatever your choice, and whatever the project, using WebServer for your next Ovation show or installation will unlock unprecedented control possibilities.

Applications
- Multiple zone access for non-technical users (Museum exhibits with multiple rooms etc.)
- Stage side access for firing manual Cues and sequences
- Multiple control stations, for example, for game shows. The gallery, the sound supervisor and presenter can all have appropriate controls for their needs.
- Show information and timing views for Conductors in "the Pit"
- Bespoke, branded interfaces for hotel lobbies and bar installs
- And many, many more……

Using Ovation Webserver

Activating
To enable the Ovation WebServer go to Settings > Application > Controller Units > Proprietary > Web Server and check the Enable button.

If necessary, the HTTP Port number can be changed in this page. The default Port is 888.

The Pages Root Folder can be changed to provide custom pages different to those provided by Merging as standard. The default implements an interface similar to the Ovation User Interface.

Note: The files OvationShow.html and js/OvationProcess.js are the property of Merging Technologies, but can be used freely as a reference to aid in the creation of custom pages.
Quickstart
In any browser simply type the IP address of the machine running Ovation followed by the port number, for example:

http://192.168.2.13:888

The Cue Lists displayed can be limited by adding the following filter (the Cue List Index in the filter is defined as the Cue List number minus 1):

http://192.168.2.13:888/Filter?Cuelist=0

The Show Control Bar on the bottom of the page can be hidden to avoid unexpected interaction by adding the following filter:

Or both together, separated by an &:


Which looks like this:

![Ovation Webserver interface](image)

**Settings**

Clicking on the Ovation logo on the top right-hand corner of the page displays a menu with a choice of viewing style, Tabbed or All-In-One-View and the page Refresh Interval:

![Settings menu](image)

In **All-in-One View** Cue Lists are shown one after another down the page. In **Tabbed View** a single Cue List is shown with the rest available on tabs at the top of the page.
If the network is slow or artefacts are noticed the refresh rate can be reduced to advantage.

**HTTP Control**

HTTP Commands can be sent directly to the Ovation WebServer by any client application (or simply by typing commands in a web browser URL field).

These commands are described in the Ovation Controller Commands documents which can be found here: [Appendix VII on page 229 Web Server Commands](#).

Typically, commands such as these will be sent:

- `192.168.1.33:888/Action?Command=Show_Init`
- `192.168.1.33:888/Action?Command=Show_Start`
- `192.168.1.33:888/Action?Command=Cue_Fire&CueList=0&Cue=4.-2`
- `192.168.1.33:888/Action?Command=CueList_Select&CueList=0`
- `192.168.1.33:888/Action?Command=Cue_Select&CueList=-1&Cue=1.-2`
- `192.168.1.33:888/Action?Command=Cue_Fire&CueList=-1&Cue=-1`
- `192.168.1.33:888/Action?Command=Cue_Fire`
- `192.168.1.33:888/Action?Command=Cue_Stop`
- `192.168.1.33:888/Request?Show`

**Connection Feedback**

If the client network connection is lost (wifi) or if for whatever reason the Ovation server goes offline, the Time-Code counter background turns red. The Web UI reconnects automatically when the connection is restored.
**GPI Command Mapping**

**Media Server Commands Mapping**
In the **Commands** table the P columns correspond to **Parameters** for the majority of Media Server Commands.

- **P.1** = Cue List #
- **P.2** = Cue #
- **P.3** = Cue Child1 #
- **P.4** = Cue Child2 #

**Note:** Unused Parameters MUST be set to -1 (minus one)

For example:

To fire **Cue#2** of **Cuelist#5**:
**Cuefire P.1=5, P.2 = 2, P.3 = -1, P.4 = -1**

Please see also: Appendix V on page 226
Rules

It is important to appreciate the differences between specifying **Ending** and **Stopping**.

**Ending** is when a Cue finishes playing normally.

**Stopping** is when a Cue is terminated prematurely either manually or by a rule.

It is equally important to appreciate the difference between **When** and **After**. This setting affects the point at which the rule is applied. If **When** is selected then the rule is applied at the point the fade out or the fade in begins. If **After** is selected then the rule’s action is applied after the Cue Starts or after the Cue Ends or Stops with a delay set in the **ms** box.

**Note:** A rule’s action always occurs at either the start of a Cue or at the beginning of the Fade Out unless a delay is applied using **After**.

If **When** is chosen this is an easy method of producing cross-fades.

If a crossfade is **NOT** required then you can use the **Offset** parameter to compensate.

**Fade Modifier**

Pressing the **Shift** key invokes the User defined fade duration. (**Fade Modifier** key on the dedicated keyboard or the **Shift** key of the standard keyboard.)

<Default>

Where **<default>** is an option in Ovation the hierarchy works like this:

- **Cue** settings override **Cue List** settings override **Show** settings.

**Player**

If no specific network **OVPlayer** is assigned in **Cue Properties** I.e. the field is set to blank or **<default>** then Ovation looks at the assignment in the **Cue List Properties Default Output Player** field. If this is also set to blank or **<Default>** then Ovation looks at the **Default Output Player** field in **Show Properties**. If this too is set to blank or **<Default>** then the local Ovation player is used.

**Stop Fade Out**

Similarly if **Stop Fade Out** is set to **<Default>** in **Cue Properties** then Ovation looks at the setting in the **Cue List Properties Default Stop Fade Out** field. If this is also set to **<Default>** then Ovation looks at the **Default Stop Fade Out** field in **Show Properties**. If this too is set to **<Default>** then the value in the **Fade Out** field in **Cue Properties** is used.

**Drag & Drop**

Media Files can be “Dragged & Dropped” into Cue Lists from outside Ovation. E.g. Explorer browser or iTunes. A new Cue is created automatically when Media Files are added in this way unless the **Alt** key is held down while Drag & Dropping onto an existing Cue, in which case, for Audio only Cues, the underlying Media File is replaced.

Cues can be dragged and dropped between Cue Lists using the **Shift** modifier. If the **Alt** modifier is used the underlying audio Media File is replaced with the source. Simple drag and drop is used to reorder Cue Lists.
Changing Properties for Multiple Cues

When multiple Cues are selected, parameters changed in **Cue Properties** are updated for all selected Cues. The only exception being **Cue Number**. This applies even when the Cues are selected in several different lists.

(Selecting Multiple Cues follows the Windows browser conventions. I.e. With one Cue selected, **Shift + Click** selects a contiguous range of Cues to the second Cue clicked and **Ctrl+Click** toggles Cues selected/unselected.)

Starting a Show With Sysex

In Ovation 7.x, MIDI SysEx inputs are not mappable to a specific Ovation command. The only MIDI inputs mappable are: General Midi (GM) - Control Change commands (2-3 byte length message). I.e. hexa = B0 00 00 or B1 10 00 or ...

However, if the controlling device is capable of sending any SysEx message, the two Midi Show Control specific SysEx messages below can be used.

**Show Init:**
Hexa = F0 7F <Device id> 02 <Sound (General) = 10> 07 01 F7 Show Start:

Hexa = F0 7F <Device id> 02 <Sound (General) = 10> 07 02 F7

<Device id> : specified in Settings > Controller Units > MIDI > Midi port (Midi Show Control section).

<Sound (General)> : as well.

For details of MIDI Show Control macro commands available in Ovation Please see MIDI and Midi Show Control on page 217 onwards.
System Requirements For Ovation

Computer

Wintel platforms tend to increase in number of cores, speed and performance at a tremendous rate. New and faster processors are released almost on a monthly basis. Therefore we have not included suggested Motherboard or Processor specifications here.

We maintain a list of up to date PC configurations in the Support Section of our website at:

http://www.merging.com/pages/pccfg

Other Components

• Graphics Card: As of Pyramix 11, Ovation 7 and VCube 7, Merging strongly recommends using a dedicated graphic card rather than onboard graphics. Most particularly when the following are required
  • Multiple display outputs,
  • OpenGL UI plugins (Flux, Izotope, ....)
  • Working with video, or when your workflow places high demands on graphics.

Please refer to the Pyramix v11 PC Specifications for all details:

http://www.merging.com/pages/pccfg

• Sufficient HD space and speed for your audio media files. The speed and amount of disk space required depends on sample rate, wordlength, number of tracks and length of program material.

• A typical 7200 RPM SATA drive is sufficient for 48 tracks at 48 kHz. Higher track-counts and/or higher sampling rates will require an SSD drive and/or multiple drives configured in Raid 0, 1, 10 or 5

• We recommend disks should be formatted as NTFS volumes with 64kB block sectors.

• BD/DVD/CD-ROM combo drive or better

• SXGA 17" monitor or better. Multiple 19" monitors highly recommended.
  Minimum resolution 1280x1024

• 3 button mouse

Ovation MassCore Systems

Certified Operating Systems
OS: We recommend and certify Ovation Version 10.x and later under Windows 10 Professional 64-bit

Note: MassCore - RAVENNA is certified under Windows 10 Professional 64-bit, but currently not compatible with Windows 11 Professional 64-bit.

Ovation Native

Certified Operating Systems
OS: We recommend and certify Ovation Version 10.x and later under Windows 10 Professional 64-bit and Windows 11 Professional 64-bit.

Windows 10

Ovation 10 Native & MassCore is supported under the Windows 10 updates

• November 2021 update 21H2 supported since Ovation 10.0 & RTX64 3.7.4

• May 2021 update 21H1 supported since Ovation 9 HotFix3 & RTX64 3.7.4
October 2020 update 20H2 supported since Ovation 9 HotFix3 & RTX64 3.7.4
May 2020 Update 2004 supported since Ovation 9 HotFix 3 & RTX64 3.7.4
Nov 2019 Update (1909) supported since Ovation 9 & RTX64 3.7
May update (1903) supported since Ovation v8.0.5 HotFix
October update (1809)

If you run a previous Windows 10 version, Merging recommends you update it. Please refer to the Ovation 10 Installation Guide for details.

Windows 11
Ovation 10 Native is supported under the Windows 10 updates
• 21H2 supported since Ovation 10.0.3 Hotfix 2.
MassCore is currently not compatible with Windows 11.

Hard Disk Space Requirements
A complete software installation will require around 100MB of disk space for the Ovation software.

In addition, you will need hard disk storage for media files. For audio media as a rule of thumb, one Gigabyte of disk storage equals:
• 185 track minutes at 44.1 kHz 16 bits
• 125 track minutes at 44.1 kHz 24 bits
• 170 track minutes at 48 kHz 16 bits
• 115 track minutes at 48 kHz 24 bits
• 55 track minutes at 96 kHz 24 bits

For multi-track applications, divide total available mono track time by the number of tracks you will be using.

Please note that these are very rough estimates, and should be used only as a general indication of storage requirements.

Power Management
N.B. As with all real-time applications, we recommend setting the PC to an Always On Power management scheme. (Start > Control Panel double-click Power Options. Choose Always On from the Power Schemes combo box.) This allows the monitor to be turned off by the system but disables hard-disk turn off and Standby.

Other Applications
Like all real-time applications, Ovation works best when there are no other unnecessary applications or services running.

MIDI Connections
To use Ovation MIDI functionality with external equipment, you will require a MIDI interface. Many current motherboards include an on-board MIDI interface. If yours does not, it is a simple matter to add one. This can be either an internal PCI card or an external unit connected via a USB port or an RS232 serial COM port.

Video Hardware
Merging supports Blackmagic design Video Cards thru the DeckLink SDK. This covers: DeckLink, UltraStudio and Intensity product lines. Decklink Studio 4K, Decklink 4K Extreme and Decklink 4K Pro have been validated. The DeckLink Studio monitor is known to be working but has no Video reference to ensure genlock. The recommended Blackmagic Design installer version is 10.3.7 and above, the latest version certified is 10.8. Please download and install from:

https://www.blackmagicdesign.com/support
Installing Ovation Software

Installation Overview:

**Note:** If you have purchased hardware options such as the NET-MSC-GBEX1 PCIe Ethernet card, the Sync Board and or a Black Magic or AJA video card, please install these following the instructions in the accompanying documentation. The drivers for all of these except BlackMagic cards are installed automatically with the Ovation software.

**Note:** Where applicable BlackMagic video card drivers have to be downloaded from the BlackMagic website and installed separately.

https://www.blackmagicdesign.com/support

**Installer**

The Ovation software uses an automated installer wizard which will install all necessary prerequisites. We use a unified installer package containing the current versions of Pyramix, VCube and Ovation. The initial installer screen offers the choice of Pyramix, VCube and Ovation. Choosing Ovation will also install Pyramix.

You may exclude the installation of any of the individual components in the wizard, if the device in question is not present on your machine or if you do not intend to use an item, by un-ticking the tick boxes next to the items listed in the wizard.

**Note:** The security dongle must be in place and the security keys entered before attempting to launch the software

**Driver Signing**

Windows throws up a warning dialog when drivers are installed. To avoid the necessity of clicking on **OK** several times you may wish to check the **Always Trust Software from Merging Technologies** box.

**Flux VS3/V3 plug-ins**

Download the Flux Center application in order to install the Flux VS3 plugins:

https://www.fluxhome.com/download

More details here:

https://confluence.merging.com/display/PUBLICDOC/Flux+Download+Center

Ensure you have valid Merging Flux v3 Keys in order to run these Flux VS3 plug-ins.

**VB VS3 plug-ins**

The VB Plugins (VS3) are no longer installed along Pyramix as of the 25th Anniversary version they come with a standalone installer. Download and run the VB Plugin – VS3 installer after having installed Pyramix.

https://confluence.merging.com/display/PUBLICDOC/VB+Plugins+%28VS3%29+standalone+installer
Running the Installer

**Note:** Note: You must have full Administrator Access to install Ovation. If you have a **SafeNet** dongle please remove this before installing Pyramix and replace it after installation is complete.

**Note:** The **HASP** dongle is not supported on 64-bit systems. If you have a **HASP** dongle please contact your Merging Technologies Sales Partner to purchase a **SafeNet** dongle and transfer your keys.

Once the NET-MSC-GBEX1 Ethernet card has been properly installed, you can now install the Ovation 6.x software.

To install the Ovation 6.x software insert the USB memory stick. The installation program will auto-start on a PC where auto-start is configured on. Otherwise, double-click on the USB memory stick icon.

Please follow the automatic installation procedure accepting the option to install unsigned drivers and re-boot your PC once setup is complete.

**Note:** if the installation appears to freeze for a long period please check that the **Driver Signing** warning dialogue is not hidden behind another Window. Installation will not continue until you click OK in this dialog.

**WARNING:** Certain computers do not properly shut down despite the reboot command issued by the installer but only perform a log off. In this case, please activate a full shut down manually.

**Enabling Ovation with your Software Key**

The **Ovation** software and its various software options are protected by an authorization key mechanism which uses a unique registration key number generated by Merging Technologies. Based on purchased software components, this key is unique to your Sentinel or HASP USB dongle serial number, your Company Name and your User name. Once you have registered your software you will be provided with this Key or Keys (depending on the options chosen).

When you receive your Ovation Package you should also receive either an email from your Merging Technologies Sales Partner or a printed copy of the email containing your security setting details. If you did not receive this key, have lost it or would like to change the user and/or company name, please contact your Merging Sales Partner with your Sentinel or HASP USB dongle, your User Name, your Company Name and the list of purchased software components. Usually, a key can be issued within one business day, after the verification of your personal data has been completed.

**Entering your Key(s)**

After the installation process you will be prompted to enter your **Authorization Key**. If you click Yes the **MT Security Settings** dialog will be launched automatically, allowing the Key or Keys to be entered immediately. If you choose not to enter your Key at this point you can do so later by choosing one of the following procedures:

1. Double-click the file **YourPersonalKeyXXXXX.mtk**. This is attached to the email containing your Key(s).
2. Open the **MT Security Settings Control Panel** (Windows Task Bar Start > Control Panel > MT Security Settings), click the **Import Key** button and browse for your Key file called **YourPersonalKeyXXXXX.mtk**
3. Open the **MT Security Settings Control Panel** (as above), in the **Registration** section select the board number corresponding to the serial number for your Keys or HASP Key for a dongle, click the **Enter Key** button and type your **User Name**, **Company Name** and **Key** then click **OK**. Repeat this step for each Keys listed in the email.

**Changing or re-entering a Key**

Should you need to subsequently change or re-enter a **Key**, follow the appropriate option above.
Starting Ovation

By default the Installer will put Ovation into the Programs folder. It also places a shortcut icon on the Windows desktop.

Double-click on the Ovation desktop icon to launch Ovation.

Alternately, choose Start > All Programs > Ovation > Ovation.

This Ovation Guide is available from within Ovation and may be accessed via the Help menu or by pressing F1, or online at merging.com

Security Keys
The first time Ovation is launched, you will need to enter in your special Key to enable the program properly (Please see: Enabling Ovation with your Software Key on page 193).

The Pyramix Settings dialog window brings together all Pyramix settings. You will find detailed information about individual pages in the Pyramix User Manual.

The left-hand side of the window shows all available settings grouped in folders. Folders can be collapsed or expanded by clicking on the folder icons. By default, all folders are open, displaying the Settings pages they contain by name. Clicking on a settings page opens it in the right-hand side of the window for viewing and editing.
Compressed Audio File Formats

Ovation supports many compressed file formats, including MP3 and AAC, directly. Other compressed formats are supported via Windows DirectShow technology.

Merging recommends you convert such compressed audio files, as there might be performance issues when playing back several compressed audio files at the same time.

![Consolidate Cues dialog box]

Codecs

**MP3 and AAC**
Ovation supports MP3 and AAC directly. (Requires the optional Advanced Audio Codec Support key.) No separate codec installation is required and no decompressed file is generated.

**FLAC**
FLAC encoding and decoding is supported directly. No separate codec installation or key is required and no decompressed file is generated.

**Ogg-Vorbis**
Ogg-Vorbis encoding and decoding is supported natively. No separate codec installation or key is required and no decompressed file is generated.

**Dolby Atmos ADM Master file**

**Dolby Atmos ADM Master file (.wav)**
Since Ovation 10, Dolby Atmos ADM Master files can be played (including Metadatas) as Cues. The Dolby Atmos ADM Master file has to be imported in Pyramix, then transmitted to Ovation, using the "Publish to Ovation" feature. Currently, the Mixer configuration has to be manually adapted to the Dolby Atmos ADM Master file. Tip: The Pyramix mixer can be saved in the Mixer - Organize tab (Save to file), and then imported in Ovation Mixer - Organize tab (Load from file).

The Pyramix Premium key is required for Dolby Atmos Master Import/Export/Editing.
Note: The Fire Command now acts like Double-Click when in Show Edit Mode and is mapped by default to the Space key. So:

- § In Edit Mode, Space toggles Audition / Stop.
- § In Show Mode, Space always Fires the Cue.
- § In Show Mode, Enter calls Fire Sequenced Cue! (Fire and select Next).

Default Keyboard Shortcuts

**Show**
- New Show: CTRL + N
- Open Show: CTRL + O
- Save Show: CTRL + S
- Save Show As: CTRL + A

**Init Show**: F1
**Start Show**: F2
**Pause Show**: F3
**Stop Show**: F4

**Consolidate Show**
- View Show Properties: SHIFT + P
- View Show Validator
- View Show Log

**View Show Control Toolbar**
- View Audition Toolbar
- View Active Cue Window
- View Audio Control

**Exit**: CTRL + Q

**Cue List**
- New Standard Cue List: CTRL + SHIFT + N
- New Timed Cue List
- New Hot Keys
- New Custom Keys
- New Browser: CTRL + SHIFT + B
- New Hot Browser

**Open Cue List**: CTRL + SHIFT + O
**Save Cue List As**: CTRL + SHIFT + A
<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Cue List</td>
<td>CTRL + SHIFT + C</td>
</tr>
<tr>
<td>Fire &amp; Start</td>
<td>F5</td>
</tr>
<tr>
<td>Start</td>
<td>F6</td>
</tr>
<tr>
<td>Pause</td>
<td>Shift + F7, F7</td>
</tr>
<tr>
<td>Stop</td>
<td>Shift + F8, F8</td>
</tr>
<tr>
<td>Chase</td>
<td></td>
</tr>
<tr>
<td>Toggle/Select Cue List</td>
<td>TAB</td>
</tr>
<tr>
<td>Toggle/Select Hot Key list</td>
<td></td>
</tr>
<tr>
<td>Select Specific Cue List</td>
<td>CTRL + Corresponding Hot Key (01 - 48) (Either on PC keyboard or Hardware Remote)</td>
</tr>
<tr>
<td>View Cue List Properties</td>
<td>CTRL + SHIFT + P</td>
</tr>
<tr>
<td>View Fire Toolbar</td>
<td></td>
</tr>
<tr>
<td>View Edit Toolbar</td>
<td></td>
</tr>
<tr>
<td>Custom Keys Design Mode</td>
<td>Ctrl + Shift + E</td>
</tr>
<tr>
<td>Snap all Keys on Grid</td>
<td></td>
</tr>
<tr>
<td>Reset all Keys Position</td>
<td></td>
</tr>
<tr>
<td>Reset all Keys Size and Position</td>
<td></td>
</tr>
<tr>
<td>Cue</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
</tr>
<tr>
<td>Cut</td>
<td>CTRL + X</td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL + C</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL + V</td>
</tr>
<tr>
<td>Add Empty Cue</td>
<td>Insert</td>
</tr>
<tr>
<td>Load MTInterChange XML</td>
<td></td>
</tr>
<tr>
<td>Load Audio File</td>
<td></td>
</tr>
<tr>
<td>Remove</td>
<td>Delete</td>
</tr>
<tr>
<td>Edit</td>
<td>Ctrl + E</td>
</tr>
<tr>
<td>Replace Audio Media</td>
<td></td>
</tr>
<tr>
<td>Audition</td>
<td>Ctrl + Space, Ctrl + D</td>
</tr>
<tr>
<td>Audition Start</td>
<td></td>
</tr>
<tr>
<td>Audition Rewind</td>
<td></td>
</tr>
<tr>
<td>Audition Stop</td>
<td>Ctrl + Shift + F11, Ctrl + F11</td>
</tr>
<tr>
<td>Audition Play/Pause</td>
<td>Ctrl + F9, Ctrl + Shift + F9</td>
</tr>
<tr>
<td>Audition Fast-Forward</td>
<td></td>
</tr>
<tr>
<td>Audition End</td>
<td></td>
</tr>
<tr>
<td>Audition Review Start</td>
<td></td>
</tr>
</tbody>
</table>
**Audition Review End**
**Audition Jump Forward 1** Ctrl + Right
**Audition Jump Forward 2** Ctrl + Shift + Right
**Audition Jump Forward 3** Ctrl + Shift + Alt + Right
**Audition Jump Back 1** Ctrl + Left
**Audition Jump Back 2** Ctrl + Shift + Left
**Audition Jump Back 3** Ctrl + Shift + Alt + Left

**Move Down** Ctrl + Down
**Move Up** Ctrl + Up
**Nest** Ctrl + Alt + Right
**Unnest** Ctrl + Alt + Left

**Edit Cue Rules** Ctrl + R
**Edit Audio Gain** Ctrl + G
**View Cue Properties** Ctrl + P

**Fire**
**Fire Sequenced Cue !** Enter

**Previous Scene** Left
**Next Scene** Right
**Previous Cue** Up
**Next Cue** Down

**Fire Cue** Space, Shift + F9, F9
**Pause Cue** Shift + F10, F10
**Stop Cue** Shift + F11, F11

**Stop All Cues**

Hot Key 01 (Down) 1
Hot Key 02 (Down) 2
Hot Key 03 (Down) 3
Hot Key 04 (Down) 4
Hot Key 05 (Down) 5
Hot Key 06 (Down) 6
Hot Key 07 (Down) 7
Hot Key 08 (Down) 8
Hot Key 09 (Down) 9
Hot Key 10 (Down) 0
Hot Key 11 (Down)

Continues to:-
Hot Key 48 (Down)
<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Shortcut Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>(Up) 1</td>
</tr>
<tr>
<td>02</td>
<td>(Up) 2</td>
</tr>
<tr>
<td>03</td>
<td>(Up) 3</td>
</tr>
<tr>
<td>04</td>
<td>(Up) 4</td>
</tr>
<tr>
<td>05</td>
<td>(Up) 5</td>
</tr>
<tr>
<td>06</td>
<td>(Up) 6</td>
</tr>
<tr>
<td>07</td>
<td>(Up) 7</td>
</tr>
<tr>
<td>08</td>
<td>(Up) 8</td>
</tr>
<tr>
<td>09</td>
<td>(Up) 9</td>
</tr>
<tr>
<td>10</td>
<td>(Up) 0</td>
</tr>
<tr>
<td>11</td>
<td>(Up)</td>
</tr>
<tr>
<td>12</td>
<td>(Up)</td>
</tr>
<tr>
<td>13</td>
<td>(Up)</td>
</tr>
<tr>
<td>14</td>
<td>(Up)</td>
</tr>
<tr>
<td>15</td>
<td>(Up)</td>
</tr>
<tr>
<td>16</td>
<td>(Up)</td>
</tr>
<tr>
<td>17</td>
<td>(Up)</td>
</tr>
<tr>
<td>18</td>
<td>(Up)</td>
</tr>
<tr>
<td>19</td>
<td>(Up)</td>
</tr>
<tr>
<td>20</td>
<td>(Up)</td>
</tr>
<tr>
<td>21</td>
<td>(Up)</td>
</tr>
<tr>
<td>22</td>
<td>(Up)</td>
</tr>
<tr>
<td>23</td>
<td>(Up)</td>
</tr>
<tr>
<td>24</td>
<td>(Up)</td>
</tr>
<tr>
<td>25</td>
<td>(Up)</td>
</tr>
<tr>
<td>26</td>
<td>(Up)</td>
</tr>
<tr>
<td>27</td>
<td>(Up)</td>
</tr>
<tr>
<td>28</td>
<td>(Up)</td>
</tr>
<tr>
<td>29</td>
<td>(Up)</td>
</tr>
<tr>
<td>30</td>
<td>(Up)</td>
</tr>
<tr>
<td>31</td>
<td>(Up)</td>
</tr>
<tr>
<td>32</td>
<td>(Up)</td>
</tr>
<tr>
<td>33</td>
<td>(Up)</td>
</tr>
<tr>
<td>34</td>
<td>(Up)</td>
</tr>
<tr>
<td>35</td>
<td>(Up)</td>
</tr>
<tr>
<td>36</td>
<td>(Up)</td>
</tr>
<tr>
<td>37</td>
<td>(Up)</td>
</tr>
<tr>
<td>38</td>
<td>(Up)</td>
</tr>
<tr>
<td>39</td>
<td>(Up)</td>
</tr>
<tr>
<td>40</td>
<td>(Up)</td>
</tr>
<tr>
<td>41</td>
<td>(Up)</td>
</tr>
<tr>
<td>42</td>
<td>(Up)</td>
</tr>
<tr>
<td>43</td>
<td>(Up)</td>
</tr>
<tr>
<td>44</td>
<td>(Up)</td>
</tr>
<tr>
<td>45</td>
<td>(Up)</td>
</tr>
<tr>
<td>46</td>
<td>(Up)</td>
</tr>
<tr>
<td>47</td>
<td>(Up)</td>
</tr>
<tr>
<td>48</td>
<td>(Up)</td>
</tr>
</tbody>
</table>

Trimmer
Nudge Cue In Less
Nudge Cue In More
Nudge Cue Out Less
Nudge Cue Out More

Nudge Fade In Less
Nudge Fade In More
Nudge Fade Out Less
Nudge Fade Out More

Nudge Cursor Less
Nudge Cursor More

Snap In To Cursor
Nudge Out To Cursor

Audition Review Start
Audition Review End

View
View Show Properties  Shift + P
View Show Validator
View Show Log
View Show Control Toolbar

View Cue List Properties  Ctrl + Shift + P
View Cue List Fire Toolbar
View Cue List Edit Toolbar

View Cue Properties  Ctrl + P
Custom Keyboard Shortcuts

We strongly encourage you to learn the default Ovation keyboard shortcuts. However, if you wish to create your own Keyboard Shortcuts for Ovation functions this is how to do it.

To define your own Keyboard Shortcuts:

1. Choose Settings > Keyboard Shortcuts. This opens the Keyboard Shortcuts window.
2. All menu **Commands** are grouped together into **Tabs** within this window. Select the **Tab** with whichever group of **Command** Functions you wish to add or change key assignments for.

3. Click on the appropriate **Command** so that it is highlighted.

4. Click in the **Press new shortcut key** box. The cursor will become a blinking bar.

5. Now press the desired **Key** or combination of **Key** and modifier (e.g. the **Ctrl**, **Shift**, **Alt**, etc.). These will appear in the **Press new shortcut key** box. Note that Pyramix will warn you if the chosen **Key** or combination is already assigned to another function.

6. Click the **Assign** button.

7. Continue assigning **Keys** to **Commands** until you are satisfied.

8. Any set of user defined **Keyboard Shortcuts** can be saved as a **Preset**. To do so, click the **Save Preset** button, then name the **Preset**. Similarly, to recall a previously saved **Preset**, click in the **Presets** box and select it from the pop-up list. Note that several common **Presets** are shipped with **Ovation**. The Table will be saved in the system for the user currently logged in and will not affect any other user.

9. A table can be Saved or Loaded to a file so it can be taken to another system. Just Click on the Save Table or Load Table button.

10. A table can be exported as a Text File along with some comments about commands. This is very useful since it enables you to print it as a command reference guide with your own keyboard shortcuts.
**Multiple Ovation Sequencers for Redundancy**

**Mirror All Commands to Remote Ovation Sequencers**

The **Mirror All Commands to Remote Ovation Sequencers** setting can be found in **Settings > Application Settings > Controller > Remote Controlled Ovations**. When enabled (ticked) this option ensures that all commands issued by the local Ovation Sequencer with the mouse, keyboard shortcuts or touch screen (i.e. **NOT** with a hardware controller) are also sent to all the Remote Ovation Sequencers defined in the Controller Settings. This enables total redundancy to be achieved with another Ovation Sequencer running the same show on another machine on the network. If two machines on the network enable this option and both define the other one in their own **Controller Settings > Remote Ovation Sequencers** list, then either or both user interfaces can be operated during the Show and each Sequencer will be a mirror of the other. Multiple mirrors can be defined.

**Remote Players and Controllers**

**Ovation Players**

Apart from the main Ovation application a smaller application, the **OVPlayer** is also included in the package.

In most circumstances Ovation will either operate stand-alone or networked with other machines running further full iterations of Ovation. However, it is possible to have one master Ovation sequencer with one or more Ovation Players running on remote, networked machines. In this case one Ovation sequencer is the master and controls the others.

**Ovation Controllers**

Similar to the OVPlayer, OV Controllers can be run on remote machines. OV Controllers enable Ovation to be controlled by commands from external devices.

**OV Player**

The **OV Player** module is the mechanism for interpreting **Ovation Sequencer** instructions and playing back the correct Media files and outputting control protocols at the right time from local or network storage.

In **Show Mode** an **OV Player** on a networked PC or indeed several PCs running OV Player can be controlled by a single **Ovation** module. This powerful feature enables highly complex scenarios to be developed.

Each **Cue List** and indeed each individual **Cue** can have different **Default Output Players** defined which then override the **Show** defaults.

Only one **OV Player** can be running on any one machine at one time. The OV Player on the machine running the Ovation Show is part of the Ovation Sequencer. The separate **OV Player** application is provided for use on slave Player Machines.

**OV Player Files**

OV Player files store player set-ups including audio mixer settings and have a **.ovp** file extension.
OV Player User Interface

Main Screen

When an OV Player is launched its Main window opens together with the audio Mixer window used most recently.

Note: The OV Player can be set to start minimized in the View menu.

OV Player Buttons and Toolbars

OV Logo button. Clicking on this drops down the Main window control menu:

Controls are standard Windows items. At top right the three circular buttons are, from Left to Right:

Minimize Minimizes Main OV Player Window and the Mixer window (If open) to the Taskbar.

Maximize / Restore Toggles between Maximizing the Main OV Player Window and Restoring it to the size and position it occupied prior to being minimized / maximized.
**Close** Opens the Exit OV Player dialog

![Exit OV Player dialog]

Click on **OK** to close the **OV Player** or **Cancel** to exit the dialog without closing **OV Player**.

**Toolbars**

All toolbars including the **Menu** toolbar can be made floating by clicking to the left of the first entry until the cursor changes to Move and dragging to a new location. If a floating Toolbar is dragged close to the edge of the Main Window it will snap to a docked configuration.

![OV Player Toolbar]

- **Opens a new, Untitled OV Player Session**
- **Opens the Open Windows File Browser to enable an existing Session to be loaded**
- **Saves** the current Session. If this is Untitled, opens the **Save As** file browser
- **Toggles the Mixer window open / closed**
- **Opens the OV Player Settings Window**
- **Opens the About OV Player window (Will later also open this Guide)**

**OV Player Menus**

![OV Player Session Menu]

Clicking on **Session**, **View** or **Help** drops down the respective menu

**Session**

- **New**
- **Open...**
- **Save**
- **Save As...**
- **Recent Sessions**
- **1 Second**
- **2 First One**
- **Exit**

**New** **Ctrl+N**Opens a new, Untitled OV Player Session
**Open**

Ctrl+O Opens the *Open* Windows File Browser to enable an existing *Session* to be loaded.

**Save**

Ctrl+S Saves the current *Session*. If this is Untitled, opens the *Save As* file browser.

**Save As...**

Opens the *Save As* file browser.

**Recent Sessions**

Drops down a list of recently opened *Sessions*.

**Exit**

Quits the *OV Player* application.

**View**

- *Run Minimized*:
  When ticked *OV Player* will subsequently open minimized in the Task Bar.
- *Mixer*:
  Toggles the *Mixer* window open / closed.
- *View Player I/O Status*:
  Toggle *OV Player I/O Status* window show/hide.
- *Settings*:
  Opens the *OV Player Settings* window.

*Note:* This is a restricted version of the *Settings* window accessible from the Ovation Sequencer Settings menu.

**Help**

- *About OV Player*:
  Opens the *About OV Player* window.

**OV Controller**

This application module handles Ovation MIDI and GPI remote control inputs. I.e. control *OF* the Ovation sequencer(s) by external devices.

Exactly like the OVPlayer application it can be run on a remote computer.

Only one *OV Controller* can be running on an any one machine at one time.

*Note: OVControllers control Ovation Sequencers which in turn can control remote OVPlayers.*

**OV Controller Files**

OV Controller files store controller set-ups and have a `.ovc` file extension.
OV Controller User Interface

Main Screen

When an OV Controller is launched its Main window opens:

![OV Controller main Window](image)

**Note:** The OV Controller can be set to start minimized in the Controller **View** menu.

OV Controller Buttons and Toolbars

- **OV Logo button.** Clicking on this drops down the Main window control menu:

  ![OV Controller Window Control Menu](image)

  Controls are standard Windows items. At top right the three circular buttons are, from Left to Right:

  **Minimize** Minimizes Main OV Controller Window to the Taskbar.

  **Maximize / Restore** Toggles between Maximizing the Main OV Controller Window and Restoring it to the size and position it occupied prior to being minimized / maximized.
Close Opens the Exit OV Controller dialog

Exit OV Controller dialog

Click on OK to close the OV Controller or Cancel to exit the dialog without closing OV Controller.

Toolbars

All toolbars including the Menu toolbar can be made floating by clicking to the left of the first entry until the cursor changes to Move and dragging to a new location. If a floating Toolbar is dragged close to the edge of the Main Window it will snap to a docked configuration.

OV Controller Toolbar

- Opens a new, Untitled OV Controller Session
- Opens the Open Windows File Browser to enable an existing Session to be loaded
- Saves the current Session. If this is Untitled, opens the Save As file browser
- Opens the Touch Controller window
- Opens the OV Controller Settings Window
- Opens the About OV Controller window

OV Controller Menus

Clicking on Session, View or Help drops down the respective menu

Session

New Ctrl+N Opens a new, Untitled OV Controller Session
**Open**

**Ctrl+O** Opens the **Open** Windows File Browser to enable an existing **Session** to be loaded.

**Save**

**Ctrl+S** Saves the current **Session**. If this is Untitled, opens the **Save As** file browser.

**Save As...**

Opens the **Save As** file browser.

**Recent Sessions**

Drops down a list of recently opened **Sessions**.

**Exit**

Quits the **OV Player** application.

**View**

**View Menu**

- **Run Minimized**
  - When ticked OV Controller will subsequently open minimized in the Task Bar.

- **Touch Controller**
  - Toggles the **Touch Controller** window open / closed.

- **Settings**
  - Opens the **OV Controller Settings** Window.

  **Note:** This is a restricted version of the **Settings** window accessible from the Ovation Sequencer Settings menu.

**Help**

**Help Menu**

- **About OV Controller...**
  - Opens the **About OV Controller** window.
OVController Commands

- Ovation can be remote controlled in two ways:
  - As a Media Sequencer: All features available in the user interface are remote controllable the same manner they are operated manually with the mouse from within the application. It’s equivalent as remote controlling each buttons of the user interface.
  - As a Media Server: All Cues and Cue Lists can be remote controlled independently given their Cue List Number and/or Cue Number or Index. It’s equivalent as remote controlling a pool of media independently of the Ovation user interface.
- Both modes can be used at the same time. A remote controller can send some Media Sequencer commands and some Media Server commands anytime and transparently.
- The charts in following pages show all available commands in both modes.
- **Appendix II on page 214** gives details on the Ovation Keyboard Commands mapping
- **Appendix III on page 217** gives details on MIDI / Midi Show Control Commands mapping
- **Appendix IV on page 225** gives details on DMX Commands mapping
- **Appendix V on page 226** gives details on GPI Commands mapping
**Media Sequencer Mode available Commands:**

*Note: If the tables are difficult to read please zoom in.*

<table>
<thead>
<tr>
<th>Ovation Media Sequencer Commands</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Parameter 3</th>
<th>Parameter 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueFire</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueFireSequenced</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CuePause</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueStop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueStopAll</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueHotPress</td>
<td>Down = 1 / Up = 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAudition</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionRewind</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionPlayPause</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionEnd</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueBrowse</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelect</td>
<td>Cue List # *</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td>Cue List # *</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListFireStart</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStart</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListPause</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChase</td>
<td>On = 1 / Off = 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStart</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowPause</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowReset</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendModifierKey</td>
<td>Modifier Key Code *** Down = 1 / Up = 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td>Virtual Key Code **** Down = 1 / Up = 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td>Gain</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td>Mute = 1 / Unmute = 0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Parameters details:

* CueList #  
  Cue List Number as displayed in the Ovation Sequencer

** Cue #  
  If Cue Sub#1 equals OVCUEINDEX (-2) then Cue # is the Cue index in its Cue List
  Otherwise the Cue is identified with up to 3 nested levels using:
  Cue#, Sub#1, Sub#2 and Sub#3.
  Example: 1.1.2 or 3.4.2.5
  Note: 1.2.0.0 = 1.2.-1.-1 = 1.2

*** Modifier Key:  
  OVCCMK_CONTROL 1
  OVCCMK_SHIFT  2
  OVCCMK_ALT    3
  OVCCMK_FADE   2 (= OVCCMK_SHIFT)
  OVCCMK_RESET_P 4
  OVCCMK_PLAY_STO 5
  OVCCMK_PLAY_PA 6
  OVCCMK_PLAY_DEF 7
  OVCCMK_PLAY_DEF 8

**** Virtual Keys:  
  Any valid Windows Virtual Key Code
### Media Server Mode available Commands:

<table>
<thead>
<tr>
<th>Ovation Media Server Commands</th>
<th>CueList / Cue Identification Parameters</th>
<th>Command Timing Parameters</th>
<th>Generic Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CueList #</td>
<td>Cue #</td>
<td>CueSub #1</td>
</tr>
<tr>
<td>CueAddAudio</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueAddVideo</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueLoad</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueUnload</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueMakeReady</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueFire</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueFireSequenced</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CuePause</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueStop</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueStopAll</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueDim</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueUnDim</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueHotPress</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueAudition</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueAuditionRewind</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueAuditionPlayPause</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueAuditionEnd</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueBrowse</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueSelect</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueSelectNext</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrevScene</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelect</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListFireStart</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CueListStart</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListPause</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSetTime</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChase</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowPause</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendModifierKey</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Parameters Explanation:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CueList #</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If CueList # equals OVSELECTED (-1) then the currently selected CueList in the Sequencer is used for the command</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Otherwise the Cue List Number as displayed in the Ovation Sequencer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cue #</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If Cue # equals OVSELECTED (-1) then the currently selected Cue in the Sequencer is used for the command</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If Cue Sub#1 equals OVCUEINDEX (-2) then Cue # is the Cue index in its Cue List</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Otherwise the Cue is identified with up to 3 nested levels using Cue#, Sub#1, Sub#2 and Sub#3.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Example: 1.1.2 or 3.4.2.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: 1.2.0.0 = 1.2.-1.-1 = 1.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Absolute Time when the Command will be executed.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>This Time relates to the Show Time. (OV_INVALID_TIME means as soon as possible)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TimeOffset</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relative Time when the Command will be executed counting from when the command is issued</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(OV_INVALID_TIME means no offset)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fade</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fade Time (OV_INVALID_TIME means the Fade Time defined in the Sequencer is used)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ProgressOffset</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time from the beginning of the Cue to start playing the Cue when Fired</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(OV_INVALID_TIME means the Cue starts from its beginning)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Modifier Key Code:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVCCMK_CONTROL 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVCCMK_SHIFT 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVCCMK_ALT 3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVCCMK_FADE 2 (= OVCCMK_SHIFT)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVCCMK_RESET_PLAY 4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVCCMK_PLAY_STOP 5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVCCMK_PLAY_PAUSE 6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVCCMK_PLAY_DEPRESS_ST 7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVCCMK_PLAY_DEPRESS_PA 8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Virtual Key Code:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Any valid Windows Virtual Key Code</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Ovation Keyboard Controller Commands Map

Keyboard Layout

Standard - General Purpose Mapping

Big Red Button

In **Standard - General Purpose Mapping** mode there are two options for **Big Red Button** behavior. This is set in the **All Settings > Application Settings > Controller Units > Proprietary > OV Keyboard** page.

- **Fire Sequenced Cue**  Fire the selected Cue and automatically select next Cue.
- **Fire Selected Cue**  Fire the selected Cue only.

**Note:** This option only applies to the Ovation Keyboard in Multi-purpose (standard) mapping, and not to the Hot Keys mapping or to the Fire Button in Ovation UI.
### Hot Keys Only Mapping

- **Note:** The Ovation Keyboard does not map any Media Server Mode specific Commands.

- **Note:** The keyboard keys can be changed easily with the key caps removal tool provided with the keyboard. All the key caps required for both keyboard layouts are supplied with the keyboard.

## Changing Keyboard Mapping

To change the keyboard mapping between General Purpose and Hotkeys go to:

**Settings > Application > Controller Units > Proprietary > OVKeyboard**

Make sure that the *Enable* checkbox is ticked and choose the appropriate mapping with the radio buttons.
## Ovation Keyboard Commands mapping

<table>
<thead>
<tr>
<th>Ovation Media Sequentor Commands</th>
<th>Mapped on Standard Keyboard</th>
<th>Mapped on Hot Keys Keyboard</th>
<th>Buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueFire</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CueFireSequenced</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CuePause</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CueStop</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CueStopAll</td>
<td>No</td>
<td>Yes</td>
<td>Stop All</td>
</tr>
<tr>
<td>CueHotPress</td>
<td>1 to 48</td>
<td>1 to 48</td>
<td>1-48</td>
</tr>
<tr>
<td>CueAudition</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CueAuditionRewind</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CueAuditionPlayPause</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CueAuditionEnd</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CueBrowse</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CueSelect</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CueSelectNext</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CueListSelectScene</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrevScene</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td>Yes</td>
<td>Yes</td>
<td>Select Cue List</td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td>Yes</td>
<td>Yes</td>
<td>Select Hot Key</td>
</tr>
<tr>
<td>CueListFireStart</td>
<td>Yes</td>
<td>No</td>
<td>Fire Cue List</td>
</tr>
<tr>
<td>CueListStart</td>
<td>Yes</td>
<td>No</td>
<td>Start Cue List</td>
</tr>
<tr>
<td>CueListPause</td>
<td>Yes</td>
<td>Yes</td>
<td>Pause Cue List</td>
</tr>
<tr>
<td>CueListStop</td>
<td>Yes</td>
<td>Yes</td>
<td>Stop Cue List</td>
</tr>
<tr>
<td>CueListChase</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td>Yes</td>
<td>No</td>
<td>Ready Show</td>
</tr>
<tr>
<td>ShowStart</td>
<td>Yes</td>
<td>No</td>
<td>Start Show</td>
</tr>
<tr>
<td>ShowPause</td>
<td>Yes</td>
<td>No</td>
<td>Pause Show</td>
</tr>
<tr>
<td>ShowStop</td>
<td>Yes</td>
<td>No</td>
<td>Stop Show</td>
</tr>
<tr>
<td>ShowReset</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td>Yes</td>
<td>Yes</td>
<td>Off</td>
</tr>
<tr>
<td>Cancel</td>
<td>Yes</td>
<td>Yes</td>
<td>Cancel</td>
</tr>
<tr>
<td>SendModifierKey</td>
<td>Yes</td>
<td>Yes</td>
<td>Play Reset</td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>Yes</td>
<td>No</td>
<td>Cut</td>
</tr>
<tr>
<td>Copy</td>
<td>Yes</td>
<td>No</td>
<td>Copy</td>
</tr>
<tr>
<td>Paste</td>
<td>Yes</td>
<td>No</td>
<td>Paste</td>
</tr>
<tr>
<td>Save</td>
<td>Yes</td>
<td>No</td>
<td>Save</td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
# MIDI and Midi Show Control

## Midi Show Control Media Sequencer Mode Commands Mapping

<table>
<thead>
<tr>
<th>Ovation Media Sequencer Commands</th>
<th>MCS Command</th>
<th>Cmd Param (Dec)</th>
<th>Cmd Param (Hex)</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueFire</td>
<td>Fire</td>
<td>8</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>CueFireSequenced</td>
<td>Fire</td>
<td>9</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CuePause</td>
<td>Fire</td>
<td>10</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>CueStop</td>
<td>Fire</td>
<td>11</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>CueStopAll</td>
<td>Fire</td>
<td>12</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>CueHotPress</td>
<td>Fire</td>
<td>48-95</td>
<td>30-5F</td>
<td>Even : Down - Odd : Up</td>
</tr>
<tr>
<td>CueAudition</td>
<td>Fire</td>
<td>32</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td>Fire</td>
<td>33</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>CueAuditionRewind</td>
<td>Fire</td>
<td>34</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td>Fire</td>
<td>35</td>
<td>23</td>
<td></td>
</tr>
<tr>
<td>CueAuditionPlayPause</td>
<td>Fire</td>
<td>36</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td>Fire</td>
<td>37</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>CueAuditionEnd</td>
<td>Fire</td>
<td>38</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td>Fire</td>
<td>39</td>
<td>27</td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td>Fire</td>
<td>40</td>
<td>28</td>
<td></td>
</tr>
<tr>
<td>CueBrowse</td>
<td>Fire</td>
<td>41</td>
<td>29</td>
<td></td>
</tr>
<tr>
<td>CueSelect</td>
<td>Fire</td>
<td>42</td>
<td>2A</td>
<td></td>
</tr>
<tr>
<td>CueSelectNext</td>
<td>Fire</td>
<td>43</td>
<td>2B</td>
<td></td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td>Fire</td>
<td>44</td>
<td>2C</td>
<td></td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td>Fire</td>
<td>45</td>
<td>2E</td>
<td></td>
</tr>
<tr>
<td>CueListSelect</td>
<td>Fire</td>
<td>17</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td>Fire</td>
<td>18</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td>Fire</td>
<td>19</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td>Fire</td>
<td>22</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td>Fire</td>
<td>23</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td>Fire</td>
<td>24</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>CueListFireStart</td>
<td>Fire</td>
<td>26</td>
<td>1A</td>
<td></td>
</tr>
<tr>
<td>CueListStart</td>
<td>Fire</td>
<td>27</td>
<td>1B</td>
<td></td>
</tr>
<tr>
<td>CueListPause</td>
<td>Fire</td>
<td>28</td>
<td>1C</td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td>Fire</td>
<td>29</td>
<td>1D</td>
<td></td>
</tr>
<tr>
<td>CueListChase</td>
<td>Fire</td>
<td>30</td>
<td>1E</td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td>Fire</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>ShowStart</td>
<td>Fire</td>
<td>2</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>ShowPause</td>
<td>Fire</td>
<td>3</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td>Fire</td>
<td>4</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>ShowReset</td>
<td>Fire</td>
<td>5</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td>Fire</td>
<td>112</td>
<td>70</td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td>Fire</td>
<td>113</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>SendModifierKey</td>
<td>Fire</td>
<td>96-111</td>
<td>60-6F</td>
<td>Even : Down - Odd : Up</td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td>Fire</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>Fire</td>
<td>114</td>
<td>72</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>Fire</td>
<td>115</td>
<td>73</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Fire</td>
<td>116</td>
<td>74</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Fire</td>
<td>117</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Fire</td>
<td>118</td>
<td>76</td>
<td></td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td>Fire</td>
<td>119-120</td>
<td>7A-7B</td>
<td>Mute - Unmute</td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td>Fire</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Midi Show Control Media Server Mode Commands mapping:

<table>
<thead>
<tr>
<th>Ovation Media Server Commands</th>
<th>MSC Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueAddAudio</td>
<td></td>
</tr>
<tr>
<td>CueAddVideo</td>
<td></td>
</tr>
<tr>
<td>CueLoad</td>
<td></td>
</tr>
<tr>
<td>CueUnload</td>
<td></td>
</tr>
<tr>
<td>CueMakeReady Load</td>
<td>Load</td>
</tr>
<tr>
<td>CueFire Go / Timed Go / Resume</td>
<td></td>
</tr>
<tr>
<td>CuePause</td>
<td>Stop</td>
</tr>
<tr>
<td>CueStop</td>
<td>Go Off</td>
</tr>
<tr>
<td>CueStopAll</td>
<td></td>
</tr>
<tr>
<td>CueDim</td>
<td></td>
</tr>
<tr>
<td>CueUnDim</td>
<td></td>
</tr>
<tr>
<td>CueHotPress</td>
<td></td>
</tr>
<tr>
<td>CueAudition</td>
<td></td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td></td>
</tr>
<tr>
<td>CueAuditionRewind</td>
<td></td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td></td>
</tr>
<tr>
<td>CueAuditionPlayPause</td>
<td></td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td></td>
</tr>
<tr>
<td>CueAuditionEnd</td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td></td>
</tr>
<tr>
<td>CueBrowse</td>
<td></td>
</tr>
<tr>
<td>CueSelect</td>
<td>Standby +</td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td>Standby -</td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td>Sequence +</td>
</tr>
<tr>
<td>CueSelectPrevScene</td>
<td>Sequence -</td>
</tr>
<tr>
<td>CueListSelect</td>
<td>Open Cue List</td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td></td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td></td>
</tr>
<tr>
<td>Hot Cue List Select</td>
<td></td>
</tr>
<tr>
<td>Hot Cue List Select Next</td>
<td></td>
</tr>
<tr>
<td>Hot Cue List Select Prev</td>
<td></td>
</tr>
<tr>
<td>Hot Cue List Select Toggle</td>
<td></td>
</tr>
<tr>
<td>CueListFireStart</td>
<td>Go / Jam Clock</td>
</tr>
<tr>
<td>CueListStart</td>
<td>Start Clock</td>
</tr>
<tr>
<td>CueListPause</td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td>Stop Clock</td>
</tr>
<tr>
<td>CueListSetTime</td>
<td>Zero Clock / Set Clock</td>
</tr>
<tr>
<td>CueListChase</td>
<td>MTC Chase On / Off</td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td></td>
</tr>
<tr>
<td>ShowStart</td>
<td></td>
</tr>
<tr>
<td>ShowPause</td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td>Reset</td>
</tr>
</tbody>
</table>

Continued on next page
**Note:** Ovation is compatible with the MSC data specification with the following limitations:

Sub-Cue (Child-Cue) level id is limited to 4  
I.e. if 10.4.1.2.8.14 cue data is sent, Ovation will use the 10.4.1.2 cue identifier and Sub Cue id 8.14 will be ignored

Sub-Cue list level id is limited to 1 all Sub-Cue list id will be ignored  
I.e. If 1.2 cue list data is sent, Ovation will use the first cue list identifier. In that case 1 Cue list 0 is not supported

Cue path data is ignored

<table>
<thead>
<tr>
<th>Ovation Media Server Commands</th>
<th>MSC Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td></td>
</tr>
<tr>
<td>SendModifierKey</td>
<td></td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td></td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td>All Off / Restore</td>
</tr>
</tbody>
</table>
General MIDI Media Sequencer Mode Commands Mapping

**Note:** If the tables are difficult to read please zoom in.

<table>
<thead>
<tr>
<th>Ovation Media Sequencer Commands</th>
<th>Command</th>
<th>Data 1</th>
<th>Data 2</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueFire</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueFireSequenced</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CuePause</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueStop</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueStopAll</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueHotPress</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>0 = down otherwise up</td>
</tr>
<tr>
<td>CueAudition</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueBrowse</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelect</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>the Cue #</td>
</tr>
<tr>
<td>CueSelectNext</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrevScene</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelect</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>the Cue List #</td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>the Cue List #</td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListFireStart</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStart</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListPause</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChase</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>0 = Chase On otherwise Chase Off</td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStart</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowPause</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowReset</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendModifierKey</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>The master gain fader position 0 = Mute 0 = Unmute otherwise Mute</td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Data 1 is a range of values from 0 to 63
### General MIDI Media Server Mode Commands Mapping

<table>
<thead>
<tr>
<th>Ovation Media Server Commands</th>
<th>GM Command</th>
<th>Data 1</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueAddAudio</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAddVideo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueLoad</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueUnload</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueMakeReady</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueFire</td>
<td>Note On</td>
<td>the Cue #</td>
<td>depends on the Note On option</td>
</tr>
<tr>
<td>CueFireSequenced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CuePause</td>
<td>Note Off</td>
<td>the Cue #</td>
<td>depends on the Note Off and Note On option</td>
</tr>
<tr>
<td>CueStop</td>
<td>Note Off</td>
<td>the Cue #</td>
<td>depends on the Note Off and Note On option</td>
</tr>
<tr>
<td>CueStopAll</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueDim</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueUnDim</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueHotPress</td>
<td>Note On / Note Off</td>
<td>the Cue #</td>
<td>depends on the Note On option</td>
</tr>
<tr>
<td>CueAudition</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionRewind</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionPlayPause</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionEnd</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueBrowse</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelect</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNext</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrevScene</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelect</td>
<td>Program Change</td>
<td>the CueList #</td>
<td></td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListFireStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListPause</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSetTime</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChase</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowPause</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowReset</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendModifierKey</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The MIDI channel is the Cue list Id or is ignored and the Selected Cue List is targeted. An option is available.
### MMC Media Sequencer Commands Mapping

<table>
<thead>
<tr>
<th>Ovation Media Sequencer Commands</th>
<th>MMC Command</th>
<th>Cmd (Dec)</th>
<th>Cmd (Hex)</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueFire</td>
<td>Play / Deferred Play</td>
<td>2, 3</td>
<td>2, 3</td>
<td></td>
</tr>
<tr>
<td>CueFireSequenced</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CuePause</td>
<td>Pause</td>
<td>9</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CueStop</td>
<td>Stop</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CueStopAll</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueHotPress</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAudition</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionRewind</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionPlayPause</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionEnd</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueBrowse</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelect</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNext</td>
<td>Fast Forward</td>
<td>4</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td></td>
<td>5</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrevScene</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelect</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td>Variable Play</td>
<td>69</td>
<td>45</td>
<td>positive value</td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td>Variable Play</td>
<td>69</td>
<td>45</td>
<td>negative value</td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td>Eject</td>
<td>10</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListFireStart</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStart</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListPause</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChase</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStart</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowPause</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowReset</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendModifierKey</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## GM Media Sequencer Commands Mapping

<table>
<thead>
<tr>
<th>Ovation Media Sequencer Commands</th>
<th>Command</th>
<th>Data 1</th>
<th>Data 2</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueFire</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueFireSequenced</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CuePause</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueStop</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueStopAll</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueHotPress</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>0 = down otherwise up</td>
</tr>
<tr>
<td>CueAudition</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionRewind</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionPlayPause</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionEnd</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueBrowse</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelect</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>the Cue #</td>
</tr>
<tr>
<td>CueSelectNext</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrevScene</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelect</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>the Cue List #</td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>the Cue List #</td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListFireStart</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStart</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListPause</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChase</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>0 = Chase On otherwise Chase Off</td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStart</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowPause</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowReset</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendModifierKey</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>The master gain fader position 0 = Mute</td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td>Control Change</td>
<td>mappable</td>
<td></td>
<td>0 = Unmute otherwise Mute</td>
</tr>
</tbody>
</table>

**Note:** Data 1 is a range of values from 0 to 63
## Ovation Media Server Commands

<table>
<thead>
<tr>
<th>Ovation Media Server Commands</th>
<th>GM Command</th>
<th>Data 1</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueAddAudio</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAddVideo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueLoad</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueUnload</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueMakeReady</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueFire</td>
<td>Note On</td>
<td>the Cue #</td>
<td>depends on the Note On option</td>
</tr>
<tr>
<td>CueFireSequenced</td>
<td>Note Off</td>
<td>the Cue #</td>
<td>depends on the Note Off and Note On option</td>
</tr>
<tr>
<td>CuePause</td>
<td>Note Off</td>
<td>the Cue #</td>
<td>depends on the Note Off and Note On option</td>
</tr>
<tr>
<td>CueStopAll</td>
<td>Note Off</td>
<td>the Cue #</td>
<td>depends on the Note Off and Note On option</td>
</tr>
<tr>
<td>CueDim</td>
<td>Note Off</td>
<td>the Cue #</td>
<td>depends on the Note Off and Note On option</td>
</tr>
<tr>
<td>CueHotPress</td>
<td>Note On / Note Off</td>
<td>the Cue #</td>
<td>depends on the Note On option</td>
</tr>
<tr>
<td>CueAudition</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionRewind</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionPlayPause</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionEnd</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueBrowser</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelect</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNext</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrevScene</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelect</td>
<td>Program Change</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListFireStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListPause</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSetTime</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChase</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowPause</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowReset</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendModifierKey</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The MIDI channel is the **Cue list Id** or is ignored and the Selected Cue List is targeted. An option is available.
DMX Commands

Under Construction
## Appendix V

### GPI Commands

<table>
<thead>
<tr>
<th>Ovation Media Server Commands</th>
<th>GPI Media Server Mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueAddAudio</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueAddVideo</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueLoad</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueUnload</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueMakeReady</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueFire</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueFireSequenced</td>
<td>CueList #</td>
</tr>
<tr>
<td>CuePause</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueStop</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueStopAll</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueUnDim</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueHotPress</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueAudition</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueAuditionRewind</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueAuditionPlayPause</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueAuditionFastForward</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueAuditionEnd</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueBrowse</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueSelect</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueSelectNext</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueSelectPrevScene</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListSelect</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td>CueList #</td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td>CueList #</td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td>CueList #</td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td>CueList #</td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListFireStart</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListStart</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListPause</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListStop</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListSet Time</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListChase</td>
<td>CueList #</td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td>CueList #</td>
</tr>
<tr>
<td>ShowWait</td>
<td>CueList #</td>
</tr>
<tr>
<td>ShowStart</td>
<td>CueList #</td>
</tr>
<tr>
<td>ShowPause</td>
<td>CueList #</td>
</tr>
<tr>
<td>ShowStop</td>
<td>CueList #</td>
</tr>
<tr>
<td>ShowReset</td>
<td>CueList #</td>
</tr>
<tr>
<td>OK</td>
<td>CueList #</td>
</tr>
<tr>
<td>Cancel</td>
<td>CueList #</td>
</tr>
<tr>
<td>SendModifierKey</td>
<td>Modifer Key Code</td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td>Virtual Key Code</td>
</tr>
<tr>
<td>Undo</td>
<td>CueList #</td>
</tr>
<tr>
<td>Cut</td>
<td>CueList #</td>
</tr>
<tr>
<td>Copy</td>
<td>CueList #</td>
</tr>
<tr>
<td>Paste</td>
<td>CueList #</td>
</tr>
<tr>
<td>Save</td>
<td>CueList #</td>
</tr>
<tr>
<td>SetMasterOutputGain</td>
<td>Gain [DB]</td>
</tr>
<tr>
<td>MuteMasterOutput</td>
<td>Mute = 0 otherwise Mute</td>
</tr>
</tbody>
</table>
### Parameters Explanation:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CueList #</strong></td>
<td>If CueList # equals OVSELECTED (-1) then the currently selected CueList in the Sequencer is used for the command. Otherwise the Cue List Number as displayed in the Ovation Sequencer.</td>
</tr>
<tr>
<td><strong>Cue #</strong></td>
<td>If Cue # equals OVSELECTED (-1) then the currently selected Cue in the Sequencer is used for the command.</td>
</tr>
</tbody>
</table>

### Modifier Key Code:

- OVCCMK_CONTROL: 1
- OVCCMK_SHIFT: 2
- OVCCMK_ALT: 3
- OVCCMK_FADE: 2 (= OVCCMK_SHIFT)
- OVCCMK_RESET_PLAY: 4
- OVCCMK_PLAY_STOP: 5
- OVCCMK_PLAY_PAUSE: 6
- OVCCMK_PLAY_DEPRESS_STOP: 7
- OVCCMK_PLAY_DEPRESS_PAUSE: 8

### Virtual Key Code:

- Any valid Windows Virtual Key Code
Mouse Modifier Keys

This table shows the valid modifier keys which can be used in conjunction with some mouse operations

Show Control
Under construction

Hot Key Mode

Click on a Cue Fire Button
- Fire Cue following Cue Properties Hot Key Mode None
- Fire Cue following inverse of Cue Properties Hot Key Mode Ctrl
  (for example Toggle Play / Stop becomes Press Play / Release Stop)
- Force Stop Alt
- Add default Fade In and Out Shift
Please zoom in to view comfortably.

**Web Server Commands**

**HTTP Media Sequencer Map**

**Definition of Commands and Parameters for controlling Ovation as a Media Sequencer through HTTP Commands**

<table>
<thead>
<tr>
<th>Ovation Media Sequencer Commands</th>
<th>Command</th>
<th>Parameter 2</th>
<th>Parameter 3</th>
<th>Parameter 4</th>
<th>Parameter 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueFire</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueFireSequence</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CuePause</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueStop</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueHotPress</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Pressed=1 or 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAudit</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelect</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNext</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrevScene</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelect</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStart</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStartNext</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChase</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;ChaseOn=1 or 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;ChaseOn=1 or 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSetTime</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Init</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MasterOutputGain</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Gain=&lt;n [dB]&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MasterMute</td>
<td>&amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Mute=1 or 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Parameter details:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>()</td>
<td>Optional parameter</td>
</tr>
<tr>
<td>&lt;IP&gt;</td>
<td>IP Address of the machine running the Ovation Sequencer</td>
</tr>
<tr>
<td>&lt;Port&gt;</td>
<td>Port number as set in the Ovation All Settings &gt; Controller Units &gt; Proprietary &gt; Web Server Page &gt; HTTP Port</td>
</tr>
<tr>
<td>&lt;CueList&gt;</td>
<td>The Cue List Index (0 based, i.e. Cue List Number - 1)</td>
</tr>
<tr>
<td>&lt;Cue&gt;</td>
<td>The Cue Number, for example Cue=1, 1.2 or Cue=1.2.3.4.5.6</td>
</tr>
<tr>
<td>Time</td>
<td>Absolute Time in [ms] when the Command will be executed. This Time relates to the Show Time.</td>
</tr>
<tr>
<td>TimeOffset</td>
<td>Relative Time in [ms] when the Command will be executed counting from when the command is issued</td>
</tr>
<tr>
<td>Fade</td>
<td>Fade Time in [ms]</td>
</tr>
<tr>
<td>ProgressOffsetTime</td>
<td>Time in [ms] from the beginning of the Cue to start playing the Cue when Fired</td>
</tr>
</tbody>
</table>
### HTTP Media Server Map

**Definition of Commands and Parameters for controlling Ovation as a Media Server through HTTP Commands**

<table>
<thead>
<tr>
<th>Ovation Media Sequencer Commands</th>
<th>Command</th>
<th>Parameter 2</th>
<th>Parameter 3</th>
<th>Parameter 4</th>
<th>Parameter 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>CueAddAudio</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Fire &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAddVideo</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Fire &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueLoad</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Fire &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueUnload</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Fire &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueFire</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Fire &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueFireSeq</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Fire &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CuePause</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Pause &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueStop</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Stop &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueStopAll</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_StopAll &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueUnDim</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_UnDim &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Time=&lt;n [ms]&gt; (<em>) &amp;TimeOffset=&lt;n [ms]&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueHotPress</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_HotPress &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;Elapsed=1 or 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAudition</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Audition &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStart</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Audition &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionStop</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Audition &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewStart</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Audition &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueAuditionReviewEnd</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Audition &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueBrowse</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Browse &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelect</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNext</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrev</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectNextScene</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueSelectPrevScene</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Cue_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelect</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectNext</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectPrev</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSelectToggle</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelect</td>
<td>[IP]:&lt;Port&gt;/Action?Command=HotCueList_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectNext</td>
<td>[IP]:&lt;Port&gt;/Action?Command=HotCueList_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectPrev</td>
<td>[IP]:&lt;Port&gt;/Action?Command=HotCueList_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HotCueListSelectToggle</td>
<td>[IP]:&lt;Port&gt;/Action?Command=HotCueList_Select &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListFireStart</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_FireStart &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListFireSeq</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_FireSeq &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListPause</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_Pause &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStop</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_Stop &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListStopAll</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_StopAll &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChase</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_Chase &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;ChaseOn=1 or 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListChaseToggle</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_Chase &amp;CueList=&lt;CueList&gt; (<em>) &amp;Cue=&lt;Cue&gt; (</em>) &amp;ChaseOn=1 or 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CueListSetTime</td>
<td>[IP]:&lt;Port&gt;/Action?Command=CueList_SetTime &amp;CueList=&lt;CueList&gt; (*) &amp;Time=&lt;n [ms]&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowInit</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Show_Init</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowStop</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Show_Stop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowPause</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Show_Pause</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ShowReset</td>
<td>[IP]:&lt;Port&gt;/Action?Command=Show_Reset</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OK</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendModifierKey</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SendVirtualKey</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Parameters details:**

(*) Optional parameter

- `<IP>` IP Address of the machine running the Ovation Sequencer
- `<Port>` Port number as set in the Ovation All Settings > Controller Units > Proprietar > Web Server Page > HTTP Port
- `<CueList>` The Cue List Index (0 based, i.e. Cue List Number - 1)
  - `-1` indicates the currently selected Cue List (Default if the `<CueList>` parameter is not set)
- `<Cue>` The Cue Number, for example Cue=1.1.2 or Cue=3.4.2.5
  - `-1` indicates the currently selected Cue, for example Cue=-1 (Default if the `<Cue>` parameter is not set)
- `<Time>` Absolute Time in [ms] when the Command will be executed. This Time relates to the Show Time.
- `<TimeOffset>` Relative Time in [ms] when the Command will be executed counting from when the command is issued
- `<Fade, Fadelin, FadeOut>` Fade Time in [ms]
- `<ProgressOffsetTime>` Time in [ms] from the beginning of the Cue to start playing the Cue when Fired
- `<PathName>` URLs or PathNames can optionally be converted with escaped characters (for example White Spaces = %20)
Show Request Command:

<IP>:<Port>/Request?Show

JSON Response:

Comments

| Host : "192.168.1.34:888", |
| Show : |
| Title : "Test.ots", |
| PathName : "D:\Projects\Ovation\Test.ots", |
| StartTimeCueFireButtons : 0, |
| State : "Running", |
| StartTime : "00:00:02", |
| TimeCodes : |
|   |
| Name : "LTC 1", |
| Type : "Generator", |
| TimeCode : "00:01:09:00" |
|   |
| Name : "MTC 1", |
| Type : "Source", |
| TimeCode : "00:00:00:00" |
|   |
| CueLists : |
|   |
| Index : 0, |
| Name : "Standard Cue List", |
| Number : "1", |
| Mode : 0, |
| HotKeysColumns : -1, |
| Selected : 1, |
| HotSelected : 0, |
| TitleColor : "60e6b4", |
| Cues : |
|   |
| Index : 0, |
| Name : "11 Don't Kill It Carol", |
| Number : "1", |
| GoTime : "Invalid", |
| Selected : 1, |
| Length : "00:06:14", |
| State : "Ready", |
| StateBackgroundColor : "a495b2", |
| StateBorderColor : "a495b2", |
| Progress : 0, Percent ProgressCounters : "" |
|   |
|   |
| Index : 1, |
| Name : "Timed Cue List", |
| Number : "2", |
| Mode : 1, |
| HotKeysColumns : -1, |
| Selected : 0, |
| HotSelected : 0, |
| CueListTime : "00:00:00", |
| Chasing : 0, |
| Running : 0, |
| Paused : 0, |
| TitleColor : "000000", |
| Cues : |
|   |
| Index : 0, |
| Name : "Million Miles From Home", |
| Number : "1", |
| GoTime : "00:01:00:00", |
| Selected : 1, |
| Length : "00:03:58", |
| State : "Asleep", |
| StateBackgroundColor : "9f9b93", |
| StateBorderColor : "9f9b93", |
| Progress : 0, Percent ProgressCounters : "" |
Index : 2,
Name : "Hot Keys",
Number : "3",
Mode : 2,
HotKeysColumns : -1,
Selected : 0,
HotSelected : 1,
TitleColor : "000000",
Cues :

[ ]

Index : 0,
Name : "Trust_Antisocial",
Number : "1",
GoTime : "Invalid",
HotKeyNumber : 1,
HotRectLeft : 8,
HotRectRight : 207,
HotRectTop : 8,
HotRectBottom : 207,
Selected : 1,
Length : "00:04:32",
State : "Ready",
StateBackgroundColor : "b26f43",
StateBorderColor : "b26f43",
Progress : 0,
Percent
ProgressCounters : ""

Index : 3,
Name : "Custom Cue List",
Number : "4",
Mode : 3,
HotKeysColumns : -1,
Selected : 0,
HotSelected : 0,
TitleColor : "000000",
Cues :

[ ]

Index : 0,
Name : "19 Banquet",
Number : "3.2",
GoTime : "Invalid",
CustomRectLeft : 60,
CustomRectRight : 360,
CustomRectTop : 40,
CustomRectBottom : 140,
CustomColor : "00cc99",
CustomFont : "",
CustomFontColor : "000000",
Selected : 1,
Length : "00:05:15",
State : "Ready",
StateBackgroundColor : "008e6b",
StateBorderColor : "008e6b",
Progress : 0,
Percent
ProgressCounters : ""

ShowDirty : 1

Show has changed
meaning that a Show Request
is required when received in a
Cues_Status response
**Cues Status Request Command:**

```xml
<IP>:<Port>/Request?Cues_Status
```

**JSON Response:**

```json
{
    "Host" : "192.168.1.34:888",
    "Show" : {
        "State" : "Running",
        "ShowTime" : "00:01:44",
        "TimeCodes" : {
            "LTC 1" : {
                "Type" : "Generator",
                "TimeCode" : "00:01:09:00"
            },
            "MTC 1" : {
                "Type" : "Source",
                "TimeCode" : "00:00:00:00"
            }
        },
        "CueLists" : [{
            "Index" : 0,
            "Name" : "Standard Cue List",
            "Number" : "1",
            "Mode" : 0,
            "Selected" : 1,
            "HotSelected" : 0,
            "TitleColor" : "60e6b4",
            "Cues" : [{
                "Index" : 0,
                "Selected" : 1,
                "Length" : "00:06:14",
                "State" : "Playing",
                "StateBackgroundColor" : "45b259",
                "StateBorderColor" : "45b259",
                "Progress" : 6,
                "ProgressCounters" : "00:00:23 - 00:05:50"
            }]
        },
        {
            "Index" : 1,
            "Name" : "Timed Cue List",
            "Number" : "2",
            "Mode" : 1,
            "Selected" : 0,
            "HotSelected" : 0,
            "CueListTime" : "00:00:00",
            "Chasing" : 0,
            "Running" : 0,
            "Paused" : 0,
            "TitleColor" : "000000",
            "Cues" : [{
                "Index" : 0,
                "Selected" : 1,
                "Length" : "00:06:14",
                "State" : "Playing",
                "StateBackgroundColor" : "45b259",
                "StateBorderColor" : "45b259",
                "Progress" : 6,
                "ProgressCounters" : "00:00:23 - 00:05:50"
            }]
        },
        {
            "Index" : 2,
            "Name" : "Hot Keys",
            "Number" : "3",
            "Mode" : 2,
            "Selected" : 0,
            "HotSelected" : 1,
            "TitleColor" : "000000",
            "Cues" : [{
                "Index" : 0,
                "Selected" : 1,
                "Length" : "00:06:14",
                "State" : "Playing",
                "StateBackgroundColor" : "45b259",
                "StateBorderColor" : "45b259",
                "Progress" : 6,
                "ProgressCounters" : "00:00:23 - 00:05:50"
            }]
        },
        {
            "Index" : 3,
            "Name" : "Custom Cue List",
            "Number" : "4",
            "Mode" : 3,
            "Selected" : 0,
            "HotSelected" : 0,
            "TitleColor" : "000000",
            "Cues" : [{
                "Index" : 0,
                "Selected" : 1,
                "Length" : "00:06:14",
                "State" : "Playing",
                "StateBackgroundColor" : "45b259",
                "StateBorderColor" : "45b259",
                "Progress" : 6,
                "ProgressCounters" : "00:00:23 - 00:05:50"
            }]
        }]
    }
}
```

**Comments**

- Host: "192.168.1.34:888"
- Show: "Running"
- ShowTime: "00:01:44"
- TimeCodes:
  - LTC 1: Type "Generator", TimeCode: "00:01:09:00"
  - MTC 1: Type "Source", TimeCode: "00:00:00:00"
- CueLists:
  - Standard Cue List: Index 0, Number 1, Mode 0, Selected 1, TitleColor "60e6b4".
  - Timed Cue List: Index 1, Number 2, Mode 1, Selected 0, TitleColor "000000".
  - Hot Keys: Index 2, Number 3, Mode 2, Selected 0, TitleColor "000000".
  - Custom Cue List: Index 3, Number 4, Mode 3, Selected 0, TitleColor "000000".
- ShowDirty: 0
Appendix IIX OSC (Open Sound Control)

OSC (Open Sound Control) Support

For full details please refer to the OSC Guide available here:

https://confluence.merging.com/pages/viewpage.action?pageId=63635610

Configuring OSC

Define UDP Ports

- To send OSC commands a UDP Streamer IP Port must be defined in Settings > Application Settings > General > IP Connections and referred to in other settings such as Player Units and Cue Properties.
- To receive OSC commands an UDP Receiver IP Port must be defined in Settings > Application Settings > General > IP Connections and referred to in other settings such as Controller Units and Cue Properties.
Player Unit Settings

**IP**

**Enable**

When checked the Player will output IP commands as defined in Cue Properties.

**Escape character**

When checked an Escape character is used to define the end of a command string. Choose a suitable Escape character from the drop-down list.

**OSC Options**

**Send Cue status messages to this port**

When checked, OSC Cue Status messages are sent through this port. Check this option if you wish Cue Status related messages to be sent to this Player Unit port, such as: **Cue Fire**, **Cue Stop**, **Cue progress**, etc.
**Note:** Please see the Ovation OSC Dictionary included in the Ovation Installer package for description of Cue Status messages.

**Send Mixer Status messages to this port**  When checked, OSC Mixer Status messages are sent through this port. Check this option if you wish to send the current position of most Mixing Console controls, in real-time to the port.

**Note:** Please see the Ovation OSC Dictionary included in the Ovation Installer package for description of Mixer Status messages.

**Remap to**  A selection of Mixer Status messages are automatically remapped to another OSC Dictionary. The Remap to Combo box offers a choice of remap schemes so a selection of Mixer Status messages are remapped to another OSC Dictionary.

- If the selection is **None**, all Mixer Status messages are sent as described in the Ovation OSC Dictionary.
- If the selection is **Flux::SpatRevolution**, the Fader, Solo, Mute and Panner messages are remapped to the Flux::Spat Revolution OSC Dictionary scheme. All other messages are sent following the Ovation OSC Dictionary.

**Note:** This enables offline working on 3D panning automation in Ovation and mapping the automation to some external spatializers later on when available.

**Note:** The Remap feature will only work if the **Send Mixer Status** option is active.
Controller Unit Settings

When OSC is checked:

**OSC Dispatch** messages of the following types will be received on this port. This enables selection of the OSC remote control messages received on this port that will be processed.

- **/Server messages** are related to global Ovation functionalities (Show state, Cues and Cue lists,..)
- **/Mixer messages** allows remote controlling the Ovation Mixing Console.
- **/CueMapping messages** are related to Cue specific control, as set on the Cue Properties - Remote Control - IP / OSC Command.
- **Flux :: SpatRevolution messages**: Fader, Solo, Mute and Panner messages from Flux::Spat Revolution are automatically remapped to Ovation OSC Dictionary scheme.

**Note**: Please refer to Ovation OSC dictionary for details.

These messages enable remote control of the whole Ovation application as with any of the other supported remote control protocols such as MIDI, HTTP, GPI/O, etc. Please refer to the relevant Appendices for details of remote control commands. Please check the Ovation OSC Dictionary for details on the /Server messages.

**OSC Information**

**Markers**
Markers can send IP or OSC Commands.

Type an IP or OSC command line in the field named **Marker IP/OSC Command** in the Cue Properties Markers section for the Selected Marker. It will be sent to the Command IP Output Port defined in **Cue Properties > IP/OSC Command** section of the Cue containing the Marker.

**Receiving OSC Commands**
In the Cue Properties > REMOTE CONTROL: IP / OSC Command section select an **IP Command Input Port** that is configured as **UDP Receiver** (see Configuring OSC above). Make sure the IP Port is configured to Dispatch **/CueMapping** messages in the **Controller Units Settings** (see **Controller Unit Settings** above)

- In the **Command Format** row select **OSC**.
- In the **Fire, Pause or Stop Command** row simply type any OSC Command, such as **/rock/is/a/drug**. External devices sending a message to Ovation to trigger this cue will have to send the following OSC message: **/CueMapping/rock/is/a/drug**

**OSC Automation**
There is an OSC Automation section in **Cue Properties**:

- Select an **OSC Automation Output Port** that is configured as **UDP Streamer** (see **Define UDP Ports** above). This port will be used to send any recorded OSC Automation
- Right-click on the Cue and select **Start Recording OSC Automation**. A blinking red dot with the OSC Automation logo will appear on the Cue.
- **Fire** or **Audition** the Cue. Any OSC messages entering on any port configured as a UDP Receiver will be recorded in that Cue while the Cue is playing.
- Multiple OSC automation record passes can be performed on the same Cue, one after another. Just stop the Cue and Fire or Audition it again. The last OSC Automation pass recorded can be undone at any time using the **Cue > Undo** command.
- When satisfied, right-click on the Cue and select **Stop Recording OSC Automation**.
- Whenever the Cue is now **Fired** or **Auditioned** any recorded OSC messages are sent to the IP port selected in the **OSC Automation Output Port** row.
- The **Timing Mode** row gives access to options: (Not implemented yet, currently set to **Absolute**)
  - **Absolute** Any recorded OSC Automation is played back with the same timing it was recorded.
  - **Relative to Cue Length** Any recorded OSC Automation is played back relative to the Cue Length. In other words the OSC automation can be stretched or squeezed in time by changing the Cue length.

**Cue Display**
- Cues containing OSC Commands display the IP Command logo
• Cues containing OSC Automation display the IP Command logo and a gray version of the Mixer Automation logo.

Cue Menu
The following options are available in the Cue menu and right-click context menu:
• Add Cue > Record OSC Automation as New Cue. This function adds a new cue ready for recording OSC automation.
A

AAC 195
Active Cue
  Show Mode 82
Active Cue Window 77
  83
    Audition Cursor/Trimmer Scale Ruler 80
    Compose Mode 77
    Cue Trimmer 80
    Edit Toolbar 77
    Locked Mode 79
    Pinned Mode 77
    Rehearsal Preset Points 85
    Review while trimming 81
    Show Mode 82
    Time Counter 82
    Trim In/Out Audition Timings 158
    Trim with the Mouse 81
Advanced Features 202
Ambisonics 12
Aneman 12
Appendix 1 209
Appendix I
  OVController Commands 209
Appendix II
  Keyboard Controller Commands Map 214
Appendix II The Ovation Keyboard OVController Commands Map 214
Appendix III
  MIDI and Midi Show Control Commands Mapping 217
Appendix III MIDI and Midi Show Control OVController Commands Map 217
Appendix IV
  DMX Commands 225
Appendix IV DMX Commands 225
Appendix V
  GPI Commands 226
Appendix V GPI Commands 226
Appendix VI
  Mouse Modifier Key 228
Application Delay Launch 94
Application Settings 154
  General 154
Archive 123
Audio 29
Audio Bridge 57
Audio Control 124
Audio Control Pane 124
Audio File Support 195
Audio Formats Supported 12
Audio Gain Matrix 129
Audio Network Manager 12
Audio Output Slots 128
Audio Syncronization 146
Audition 32
  Player Settings 157
  Selected Cue 32
Audition Drop-down 69
Audition Jump 33, 68
Audition Toolbar 68
Auto Start Show 94
Automatic Cue Numbering 98
Automation 29, 52
  Apply Snapshot 54
Copy and Paste Snapshot 54
Dynamic 54
Erase a Snapshot 54
Glide 54
Store a Snapshot 52

B
Backup/Archive 123
Blackmagic Design 191
BlackMagic video card drivers 192

C
CD Import
  Online database of track names 49
CD Tracks
  Import 44
CD Tracks Import 47
  Changing Keyboard Mapping 215
  Changing or re-entering a Key 193
  Chase Timed List 27
  Codecs 195
Column to Audio Slot Mapping 99
Combined Panes 66
Commands 29
Compose Mode 31
Compound Cues 51
Compressed Audio File Formats 195
Compressed Media 156
Conditional Rules 118
Consolidate
  Cue 46
    Show 120
Consolidation
  Recursive 123
    Show 120
Consolidation Process 120
Context Menu
  Cue / Cue List 44
Context Menus 62
Control Surfaces 62
Controlled Stations Settings 167
Controller 205
  Buttons and Toolbars 206
    Menus 207
Controller Settings 167
Controller Units
  GPI 180
    Proprietary 169
      Settings 167
Core Power Saving 148
Core Time Saving 148
Create Cue List Toolbar 74
cross-fade 117
Cue
  Audio Gain Matrix 129
    Red Border 35
  Cue / Cue List Context Menu 44
  Cue # corresponds to the Cue I 181
  Cue # corresponds to the Cue Inde 181
  Cue Audition Settings 157
  Cue Browser Cue List 42
Cue Capabilities 50
Cue Fire Buttons 35, 95
Cue Gain 125
Cue List
  Detail 37
  Pane 33
  Properties 97
  Selecting 37
  Types 36
Cue List Menu 135
Cue List Properties 97
  Audio Section 100
  Cue List Section 97
  Custom Keys Section 99
  Hot Keys Section 99
  TimeCode Generator Section 98
  Timed Cue List Section 98
Cue List Toolbar 73
Cue Lists 32
  Hidden 98
  Multiple 32
Cue Menu 137
Cue Properties 101
  Audio Section 106
  COM Command Section 109
  Cue Section 103
  Custom Key Section 105
  GPO Section 110
  Hot Key Section 105
  IP Command Section 109
  Markers Section 104
  Microphone Switch Section 106
  MIDI Command Section 107
  Mixer Automation Section 111
  MMC Section 107
  Shell Command / Script / Batch Section 110
  Sony P2 / RS422 Section 109
  TimeCode Generator Section 107
  Timed Cue Section 104
Cue Toolbar 74
Cue Trimmer 80
Cuelist
  Fire Toolbar 36
Cues 43
  Changing Properties for Multiple Cues 189
  Compound 51
  Copying 44
  Empty 51
  GPI 51
  Microphone Switch 51
  MIDI 51
  Mixer Automation 51
  Multiple, Changing Properties 189
  Selecting 44
Custom Keyboard Shortcuts 200
Custom Keys
  Color and Font 40
  Design Mode 40
  Grid Size 40
  Justification 41
Custom Keys Cue List 40

D
Dataton Synchronization 51, 114, 180
Default 188
  Stop Fade Out 188
Default Keyboard Shortcuts 196
Default Player 188
Delay Compensation Policy 149
Delay Launch 29, 94
Disable Mix Down 148
Disable Punch in/out 148
DMX 512 / CMX Lighting Control 29
DMX Commands 225
Documentation 13
Drag & Drop 188
drag and drop 44
Driver Signing 192
Dynamic Automation 54

E
Edit Toolbar 33
Editing with Pyramix 57
Effective Sampling Rate 144, 145
Effective TC Frame Rate 144, 145
Effective Video Frame Rate 146
EMC Mixer remote control configuration 153
Emergency - Show Menus and Toolbars 76
Empty Cue
  Long 34
  Short 34
Empty Cues 51
Enabling Ovation 193
Entering Keys 193
Ethernet 163
Evaluation Mode 12
External Applications 56

F
Fade Modifier 188
Files
  Ovation 133
  Fire 139
  Fire Buttons, Cue 35
  Fire Command 62
  Fire Toolbar 75
  Fire/Start Timed List 28
  flac 195
  FLAC Decoding 195
  Flashing Mode 95
  Flux VS3/V3 plug-ins 192
  Focused Cue Flashing Mode 95
  Formats & Sync
    Presets 144, 145
    Formats & Sync - ASIO 145
    Formats & Sync - MassCore 144
  Frequencies 144, 146

G
Gain Matrix 129
General MIDI Command 51, 111
General MIDI Media Sequencer Mode Commands Mapping 220
General MIDI Media Server Mode Commands Mapping 221
General Settings 144
GM Media Sequencer Commands Mapping 223
GM Media Server Commands Mapping 224
GPI Command Mapping 187
GPI Commands 226
GPI Trigger Options 182
GPI/O Interfaces 165
GPO Cue Properties 110
GPO output 29

H
Hard Disk Space Requirements 191
Help 13, 141
HeptaCon Sample Rate Converter 155
Hot Browser Cue List 43
Hot Cues - Stopping 38
Hot Keys
  Column to Audio Slot Mapping 39
Hot Keys Column to Audio Slot Mapping 99
Hot Keys Cue List 38
  Columns 39
  Design Mode 38
Hot Keys Mode 23
HTTP Media Sequencer Map 229
HTTP Media Server Map 230
HTTP Request Response 231

I
I/O Interfaces 147
Icons
  Rules 118
Import CD Tracks 44
Import Key 193
Installer 193
Installing Ovation 192
Interaction Rules 115
Internal Buses 149
Internet Protocol Options 180
Introduction 10
IP
  Controller Unit Settings 179
  Player Unit settings 161
  port numbers 159
  TC/IP Connection Settings 158
IP / OSC Command 112
IP Address / Server Name Considerations 159
IP Command 51
IP Commands 29
iTunes 188

K
Keyboard Shortcuts 62, 196
  Custom 200
  Default 196

L
Latency 12
Launching Ovation 29
Level Meter 148
Link Offsets/Start Times 83
Link Offsets/StartTimes 139
Lock in Active Cue Window 79
Lock Mixer 94
Logging 95
Long Empty Cue 34
Looping 89
Loops 117

M
Main Window 63, 64
Marker Button 80
Markers 87
  in Cue Properties 88
  Interaction Rules 89
  Menu 87
MassCore Systems 190
Master Sync 146
Media 29
Media Management 30
Media Manager Settings 154
Media Sequencer Mode available Commands 210
Media Server Commands Mapping 187
Media Server Mode available Commands 212
Menu
  Cue 137
  Cue List 135
  Fire 139
  Help 141
  View 140
Menus 134
Mic/Pre Remote Settings 147
Microphone Switch Cues 51
MIDI and Midi Show Control OVController Commands Map 217
MIDI Command 111
MIDI Connections 191
MIDI output 29
Midi Player Settings 160
MIDI Settings Player Units 160
Midi Show Control Media Sequencer Mode Commands Mapping 217
Midi Show Control Media Server Mode Commands mapping 218
Minimize Player 205, 208
Mirror all Commands to Remote Ovation Sequencers 202
Mixer 52
  Automation 111
  Configuration 17
  Dynamic Automation 54
  Frozen 94
  Lock 94
  Record 61
  Settings 149
  Snapshot Automation 52
Mixer Automation Cues 51
Mixing Console
  Remote Control 152
  Settings 147
MMC Media Sequencer Commands Mapping 222
Modes 31
Modifiers Toolbar 69
Mouse Modifier Keys 62, 228
Moving and Copying Cues 44
MP3 195
MT ASIO Bridge 57
MT Security Settings 193
Multiple Cue Lists 32
Multi-Sequencer Synchronization 30, 51, 96, 113

N
Nested and Combined Panes 64
Nested Panes 64
Network manager 12
New Show 15
New Users 14
Numeric Fields 92

O
OASIS Mixer remote configuration 152
Ogg Vorbis 195
OSC
  Automation 238
  Configuring 234
  Controller Unit Settings 237
  Define UDP Ports 234
  Information 238
  Options 161, 235
  Player Unit Settings 235
  Support 234
Other Applications 191
Output Routing 18
Output Slots 128
OV Controller 205
  Files 205
  User Interface 206
OV Player
  Buttons and Toolbars 203
  Files 202
  Main Screen 203
  Media Paths 155
  Menus 204
  Session menu 204
  Toolbars 204
  User Interface 203
OV Players 202
Ovation
  Files 133
  Menus 134
Ovation Keyboard
  Settings 169
Ovation Keyboard Media Sequencer Mode Commands mapping 216
Ovation Keyboard OVController Commands Map 214
Ovation Webserver 183
OVController
  Buttons and Toolbars 206
  Files 205
  Help menu 208
  Main Screen 206
  Menus 207
  User Interface 206
  View menu 208
OVController Commands 209
Overview 12
OVKeyboard Settings 169
OVPlayer
  Help menu 205
  Session menu 207
  View menu 205
P

Packaging
  Show 120
Packaging Process 121
Panes 64
Panning 18
Parent Button 43
Parent button 42
Password 94
Pause Timed List 28
Pin in Active Cue Window 77
Player
  Buttons and Toolbars 203
  Default 188
  Files 202
  Menus 204
  User Interface 203
Player Units 159
  COM 162
  GPO 165
  Settings 159
Player/Recorder Mode 148
Playing Cues Window 91
Plug-ins 12
Plug-ins Settings 150
Power Management 191
Precedence 92
Properties Fields 92
Properties Panes 92
Pull-Down 146
Pull-Up 146
Pyramix
  Clip Gain 58
  Editing Cues in 57
  Envelope 58

Q

Query Database 49
QUICKSTART 14

R

RAP (Ross Audio Protocol) 153
Real-time Sampling Rate Conversion 155
Record Audio 59
Record Mixer 61
Recording 59
Recursive Consolidation 123
Redundant Control 202
Refresh button 42
Refresh Button 43
Rehearsal Preset Points 85
REMOTE CONTROL
  Dataton Synchronization 51, 114
  General MIDI Command 51, 111
  IP Command 51, 112
  Multi-Sequencer Synchronization 51, 113
Remote Control 30
  Mixing Console 152
Remote Controlled Ovations 167
replace audio 188
Review while trimming 81
Ross Audio Protocol 153
Routing Settings 147
Rule
Adding 116
Change Order 116
Removing 116
Updating 116
Rules 188
at Marker 117
Conditional 118
Form 116
Loops 117
Shorthand 118

S
SafeNet dongle 193
Sample and TC Rate Warnings 144, 146
Sample Rate Converter 155
Sampling Rate 146
Sampling Rate Conversion 46, 120, 155
Save Show As Template 134
Save Special 134
Scenes 51
Scope 12
Search Cues Function 42
Security Keys 194
Selecting Cues 44
Settings 141, 142
Application 154
Compressed Media 156
Controller 167
Remote Controlled Ovations 167
Controller Units 167
COM 174
COM (RS422) 174
GPI 180
IP 179
MIDI 172
OVKeyboard 169
Proprietary 169
Web Server 170
Controller units
Proprietary 169
General 154
Audition 157
IP Connections 158
Media Manager 154
Player Units 159
Ethernet 163
GPO 165
IP 161
MIDI 160
Player units
COM 162
Ethernet
Sony P2 over IP 164
Buttons 143
Overview 142  
Show 144  
General 144  
   Formats & Sync - ASIO 145  
   Formats & Sync - MassCore 144  
   I/O Interfaces 147  
   Mic/Pre Remote 147  
   Routing 147  
Mixer  
   Plug-ins Settings 150  
Mixing Console 147  
   Allocation 147  
   Core Power Saving 148  
   Level Meter 148  
   Mixer Settings 149  
   Remote Control 152  
TimeCode 147  
Toolbar 76  
Settings hierarchy 188  
Shell Commands/Scripts/Batch files output 29  
Short Empty Cue 34  
Show 32  
   Auto Start 94  
   Consolidate 120  
   Consolidation 120  
   Controls 70  
   Package 121  
   Validation Tool 119  
Show Logging 56, 95  
Show Menu 134  
Show Menus and Toolbars in Emergency 76  
Show Mode 31  
Show Password 94  
Show Properties 93  
   Multi-Sequencer Synchronization Section 96  
   Show Section 94  
   Show Start Time 94  
   Show Time Mode Section 94  
   Show Time Options 94  
   TimeCode Generator Section 95  
Show Toolbar 72  
Sibling 117  
Simple Rules 115  
Simple Show 14  
Slots Allocation 147  
Snapshot Automation 52  
Software Key 193  
Sony P2 / RS422 output 29  
Sony P2 over IP  
   Prerequisites 163  
   Settings 164  
Sony P2 Protocol controller 174  
Special Modes 148  
Standard Cue List 37  
Start Show 31  
Start Timed List 28  
Starting a Show With Sysex 189  
Starting Pyramix 194  
Stereo Pan Law 149  
Stop Timed List 28
Stopping Hot Cues 38
Strip Meters
  Characteristics 148
Support 13
Suppress
  Popups Confirmations 95
  Saving Confirmations 95
  Show Mode Confirmations 95
System Requirements 190

T
TimeCode Reader 126
TimeCode Settings 147
Timed Cue List 25, 38
Timed List
  Chase 27
  Chase Modes 98
  Fire/Start 28
  Pause 28
  Start 28
  Stop 28
Tips and Tricks 188
Toolbar 82
  Create Cue List 74
  Cue 74
  Fire 75
  Settings 76
Toolbar Context Menu 67
Toolbars 67
TooTips 13
Triggering Hot Keys 40
Trim with the Mouse 81

U
UDP/IP Support 159
User Interface 62
User Interface Options 62

V
Varispeed 146
VB VS3 plug-ins 192
Video Hardware 191
Video/TimeCode Synchronization 146
View Menu 140
Virtual COM Port selection conflict 159
Virtual Room Pan Law 149
VS3 Control Panel 57
VS3 Plug-ins 12
VST & VST3 Plug-ins 12
VST Plug-ins Settings 150

W
Web Server
  Settings 170
Web Server Commands 229
Webserver 183
Windows 10 190, 191

Y
YourPersonalKey 193